
 



Universal Design in Education: Principles and 
Applications

While courses, technology, and student services 
are typically designed for the narrow range of 
characteristics of the average student, the practice 
of universal design in education (UDE) considers 
people with a wide range of characteristics in the 
design of all educational products and environ-
ments. UDE goes beyond accessible design for 
people with disabilities to make all aspects of the 
educational experience more inclusive for stu-
dents, parents, staff, instructors, administrators, 
and visitors with a great variety of characteristics. 
These characteristics include those related to gen-
der, race and ethnicity, age, stature, disability, and 
learning style.

Originally applied in the field of architecture and 
later to commercial products and information 
technology, UDE applications are relatively new. 
UDE provides a philosophical framework for the 
design of a broad range of educational products 
and environments. These include

• computer and science labs, 
• curriculum, 
• educational software, 
• instruction, 
• libraries,
• professional organizations,
• registration options, 
• student housing and residential life, 
• websites, and
• other student services.

Definition and Principles of UD
The term universal design (UD) was coined by 
the architect Ronald Mace, who challenged the 
conventional approach of designing for the aver-
age user and provided a design foundation for 
more accessible and usable products and environ-
ments. Mace and other visionaries developed the 
definition of UD used by the Center for Universal 
Design (CUD) at North Carolina State University: 

“the design of products and environments to be 
usable to the greatest extent possible by people 
of all ages and abilities” (Story, Mueller, & Mace, 
1998). Universal design puts high value on both 
diversity and inclusiveness.

A group of architects, product designers, engi-
neers, and environmental design researchers at 
the CUD established seven principles for the 
universal design of products and environments 
(The Center for Universal Design, 1997). These 
principles of UD are listed below. Each is followed 
by an example of its application.

1. Equitable use. The design is useful and market-
able to people with diverse abilities. Career 
services example: Job postings in formats 
accessible to people with a broad range of 
abilities, disabilities, ages, racial, and ethnic 
backgrounds. 

2. Flexibility in use. The design accommodates 
a wide range of individual preferences and 
abilities. Campus museum example: A design 
that allows a visitor to choose to read or listen 
to the description of the contents of display 
cases.

3. Simple and intuitive use. Use of the design is 
easy to understand, regardless of the user’s 
experience, knowledge, language skills, or cur-
rent concentration level. Assessment example: 
Testing in a predictable, straightforward 
manner.

4. Perceptible information. The design communi-
cates necessary information effectively to the 
user, regardless of ambient conditions or the 
user’s sensory abilities. Dormitory example: 
An emergency alarm system with visual, au-
ral, and kinesthetic characteristics. 

5. Tolerance for error. The design minimizes 
hazards and the adverse consequences of ac-
cidental or unintended actions. Instructional 
software example: A program that provides 
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guidance when the student makes an inappro-
priate selection.

6. Low physical effort. The design can be used ef-
ficiently and comfortably and with a minimum 
of fatigue. Curriculum example: Software 
with on-screen control buttons that are large 
enough for students with limited fine motor 
skills to select easily.

7. Size and space for approach and use. Appropriate 
size and space is provided for approach, reach, 
manipulation, and use regardless of the user’s 
body size, posture, or mobility. Science lab 
example: An adjustable table and work area 
that is usable by students who are right- or 
left-handed and have a wide range of physical 
characteristics and abilities.

Universal Design in Education
UD has been applied to many educational prod-
ucts (computers, websites, software, textbooks, 
and lab equipment) and environments (dor-
mitories, classrooms, student union buildings, 
libraries, and distance learning courses). Unlike an 
accommodation for a specific person with a dis-
ability, the practice of UDE benefits all students, 
including those who are not receiving disability-
related accommodations from the school. The 
following sections show examples of universal de-
sign applications in educational settings: physical 
spaces, information technology (IT), instruction, 
and student services. 

UD of Physical Spaces
UD can be applied to physical spaces to ensure 
that they are welcoming, comfortable, accessible, 
attractive, and functional. Specific considerations 
should be made for climate, entrances and routes 
of travel, furniture and fixtures, information re-
sources and technology, and safety.

When UD is applied, individuals with and with-
out disabilities can use the same entrances and of 
travel routes. The climate is welcoming and acces-
sible for everyone.

For example, in a universally designed class-
room furniture is adjustable in height and can be 
easily arranged for different learning activities 
and groupings. A universally designed facility 
includes clear directional signs in large, high-
contrast print. 

Another example of UD of physical spaces is 
doors with sensors that automatically open for 
individuals carrying packages, those using wheel-
chairs, the elderly who experience weakness, 
parents pushing baby strollers, and workers using 
rolling carts to deliver products.

UD guidelines can be tailored to specific envi-
ronments. For example, Universal Smart Home 
Design is “the process of designing products and 
housing environments that can be used to the 
greatest extent possible for people of all ages, 
abilities, and physical disabilities” (Schwab, 2004, 
p. 24).

For specific suggestions for creating welcom-
ing, accessible, and usable spaces consult the 
publication Equal Access: Universal Design of 
Physical Spaces (Burgstahler, 2007b). Additional 
information is located in the ADA Checklist for 
Readily Achievable Barrier Removal (Adaptive 
Environments Center, 1995), Accessible 
Environments: Toward Universal Design (Mace, 
Hardie, & Place, 1996), and The Accessible School: 
Universal Design for Educational Settings (Bar & 
Galluzzo, 1999).

UD of Information Technology
IT has the potential to level the playing field or 
widen the gaps in educational and career attain-
ment between individuals who have disabilities 
(or are from other minority groups) and members 
of the majority. Design guidelines to assist com-
puter manufacturers and software developers in 
creating products that are usable by a broad audi-
ence were developed by a group of professionals 
representing different stakeholder groups. Each 
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guideline, listed below, is phrased as an objective 
followed by examples of how the objective might 
be achieved.

1. Output and Displays. Includes all means of 
presenting information to the user. The design 
should maximize the number of people who 
can
• hear auditory output clearly enough.
• not miss important information if they 

can’t hear.
• have a line of sight to visual output and 

reach printed output.
• see visual output clearly enough.
• not miss important information if they 

can’t see.
• understand the output (visual, auditory, 

other).
• view the output display without triggering 

a seizure.
2. Input and Controls. Includes keyboards and all 

other means of communicating to the device. 
The design should maximize the number of 
people who can
• reach the controls.
• find the individual controls or keys if they 

can’t see them.
• read the labels on the controls or keys.
• determine the status or setting of the con-

trols if they can’t see them.
• physically operate controls and other input 

mechanisms.
• understand how to operate controls and 

other input mechanisms.
• connect special alternative input devices.

3. Manipulations. Includes all actions that must 
be directly performed by a person in concert 
with the product or for routine maintenance 
(e.g., inserting disk, loading tape, changing ink 
cartridge). The design should maximize the 
number of people who can
• physically insert and remove objects as 

required to operate a device.
• physically handle and open the product.

• remove, replace, or reposition often-used 
detachable parts.

• understand how to carry out the manipu-
lations necessary to use the product.

4. Documentation. Focuses on operating in-
structions. The design should maximize the 
number of people who can
• access the documentation.
• understand the documentation.

5. Safety. Includes alarms and other protections 
from harm. The design should maximize the 
number of people who can
• perceive hazard warnings.
• use the product without injury due 

to unperceived hazards or the user’s 
lack of motor control. (Vanderheiden & 
Vanderheiden, 1992) 

Applications of these guidelines to IT have dem-
onstrated that it is possible to create products 
that are simultaneously accessible to people with 
a wide range of abilities, disabilities, and other 
characteristics.

The World Wide Web Consortium (W3C), which 
develops and maintains protocols used on the 
web to ensure interoperability, is committed 
to universal design. As expressed by its direc-
tor, “The power of the Web is in its universality. 
Access by everyone regardless of disability is an 
essential aspect” (Web Accessibility Initiative, 
n.d.). W3C’s Web Accessibility Initiative (WAI) 
has developed guidelines and checkpoints for the 
accessible design of websites. In 2001, the U.S. 
Access Board adopted much of the earlier work 
of the WAI when it developed minimum acces-
sibility standards for IT designed, procured, and 
used by federal agencies as mandated by the 1998 
amendments to Section 508 of the Rehabilitation 
Act of 1973. The Section 508 standards are used as 
guidelines by many states, educational institu-
tions, and other organizations not directly covered 
by the legislation. 
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Many IT companies do not take the full spectrum 
of user diversity into account when they develop 
products, unintentionally erecting barriers to 
their use by people with disabilities and others. 
Nevertheless, during their procurement process, 
institutions can express the desire to purchase 
accessible IT and inquire about the accessibility 
features of specific products. Once purchased, 
staff can place computers for students in acces-
sible locations and provide some adjustable tables 
and commonly used assistive technology.

UD of Instruction
The Center for Applied Special Technology 
(CAST) focuses its efforts on universal design 
for learning (UDL), especially as it applies to 
technology-based curriculum. It defines UDL as 
“a research-based set of principles that together 
form a practical framework for using technology 
to maximize learning opportunities for every stu-
dent” (Rose & Meyer, 2002, Preface). When UDL 
is applied, curriculum designers create products 
to meet the needs of students with a wide range 
of abilities, learning styles, and preferences. The 
UDL curriculum “reflects an awareness of the 
unique nature of each learner and the need to ad-
dress differences” by offering:

• Multiple means of representation, to give learners 
various ways of acquiring information and 
knowledge;

• Multiple means of action and expression, to pro-
vide learners alternatives for demonstrating 
what they know; and

• Multiple means of action and engagement, to tap 
into learners’ interests, offer appropriate chal-
lenges, and increase motivation. (CAST) 

In 1997, a meeting of researchers and product 
developers on universal design was convened by 
ERIC/OSEP Special Project funded by the U.S. 
Department of Education. Participants stated, 
“Publishers should prepare and teachers should 
select instructional materials that are supportive 
and inclusive of students who have wide dispari-
ties in their abilities to see, hear, speak, read, etc.” 

(Orkwis & Mclane, 1998, p. 13). The group recom-
mended the following first steps for curriculum 
developers and teachers:

1. Provide all text in digital format.
2. Provide captions for all audio.
3. Provide educationally relevant descriptions 

for images and graphical layouts.
4. Provide captions and educationally relevant 

descriptions for video.
5. Provide cognitive supports for content and 

activities:
• Summarize big ideas.
• Provide scaffolding for learning and 

generalization.
• Build fluency through practice.
• Provide assessments for background 

knowledge.
• Include explicit strategies to make clear the 

goals and methods of instruction. 
(Orkwis & McLane, 1998, pp. 14-15) 

Unfortunately, most instructional software 
available today does not apply these recommen-
dations. Instead of including flexible features that 
provide access to students with disabilities, they 
continue to unintentionally erect barriers to the 
curriculum. 

Universal design can be applied to all aspects 
of instruction—teaching techniques, curricula, 
assessment—as indicated in the following guide-
lines. (For details, see the publication and video 
Equal Access: Universal Design of Instruction at 
www.uw.edu/doit/Video/ea_udi.html.)

• Class Climate. Adopt practices that reflect high 
values with respect to both diversity and 
inclusiveness.  

• Interaction. Encourage regular and effective in-
teractions between students and the instructor 
and ensure that communication methods are 
accessible to all participants. 

• Physical Environments and Products. Ensure that 
facilities, activities, materials, and equipment 
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are physically accessible to and usable by all 
students and that all potential student charac-
teristics are addressed in safety considerations. 

• Delivery Methods. Use multiple, accessible 
instructional methods that are accessible to all 
learners. 

• Information Resources and Technology. Ensure 
that course materials, notes, and other infor-
mation resources are engaging, flexible, and 
accessible for all students. 

• Feedback. Provide specific feedback on a regu-
lar basis. 

• Assessment. Regularly assess student progress 
using multiple, accessible methods and tools 
and adjust instruction accordingly. 

• Accommodation. Plan for accommodations for 
students whose needs are not met by the in-
structional design. (Burgstahler, 2007a) 

UD of Student Services
UD can be applied to student services to make 
them accessible to and usable by all students. 
These services include computer labs, libraries, 
admissions, registration, financial aid, advising, 
career services, housing, tutoring and learning 
centers, and student organizations. When uni-
versal design is applied, everyone feels welcome, 
is able to get to the facility and maneuver within 
it, access materials and electronic resources, and 
participate in events and other activities. Efforts 
should be made in the following areas. (For de-
tails, see Equal Access: Universal Design of Student 
Services at www.uw.edu/doit/Brochures/Academics/
equal_access_ss.html.)

• Planning, Policies, and Evaluation. Consider 
diversity issues as you plan and evaluate 
services.

• Physical Environments and Products. Ensure 
physical access, comfort, and safety within an 
environment that is welcoming to visitors with 
a variety of abilities, racial and ethnic back-
grounds, genders, and ages.

• Staff. Make sure staff are prepared to work 
with all students.

• Information Resources and Technology. Ensure 
that publications and websites welcome a 
diverse group and content is accessible to 
everyone.

• Events. Ensure that everyone can participate 
in events sponsored by the organization. 
(Burgstahler, 2007c) 

Further Information About UDE
For more information about applications of 
universal design consult www.uw.edu/doit/
Resources/udesign.html or The Center for Universal 
Design in Education at www.uw.edu/doit/CUDE/. 
The book Universal Design in Higher Education: 
From Principles to Practice published by Harvard 
Education Press shares perspectives of UD lead-
ers nationwide. To receive a 20% discount visit 
the DO-IT website. 
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Universal Design of Instruction (UDI): Definition,  
Principles, Guidelines, and Examples

Precollege and college students come from a 
variety of ethnic and racial backgrounds. For 
some, English is not their first language. Also 
represented in most classes are students with a 
diversity of ages and learning styles, including 
visual and auditory. In addition, increasing 
numbers of students with disabilities are included 
in regular precollege and postsecondary courses. 
Their disabilities include blindness, low vision, 
hearing impairments, mobility impairments, 
learning disabilities, and health impairments.

Students are in school to learn and instructors 
share this goal. How can educators design 
instruction to maximize the learning of all 
students? The field of universal design (UD) 
can provide a starting point for developing a 
framework for instruction. You can apply this 
body of knowledge to create courses that ensure 
lectures, discussions, visual aids, videos, printed 
materials, labs, and fieldwork are accessible to all 
students. 

Universal Design
Designing any product or environment involves 
the consideration of many factors, including 
aesthetics, engineering options, environmental 
issues, industry standards, safety concerns, and 
cost. Often, products and environments are 
designed for the average user. In contrast, UD 
is “the design of products and environments to 
be usable by all people, to the greatest extent 
possible, without the need for adaptation or 
specialized design” (www.ncsu.edu/project/
design-projects/udi/center-for-universal-design/
the-principles-of-universal-design). For example, 
a standard door is not accessible to everyone. 
If a large switch is installed, the door becomes 
accessible to more people, including some 
wheelchair users. Applying UD principles could 
lead to the installation of sensors that signal the 
door to open when anyone approaches, making 
the building accessible to everyone—a small child, 
a man carrying a large box, an elderly woman, a 
person using a walker or wheelchair. 

When designers apply UD principles, their 
products and environments meet the needs of 
potential users with a variety of characteristics. 
Disability is just one of many characteristics that 
an individual might possess. For example, one 
person could be five feet four inches tall, female, 
forty years old, a poor reader, and deaf. All of 
these characteristics, including her deafness, 
should be considered when developing a product 
or environment she and others might use. 

Making a product or environment accessible to 
people with disabilities often benefits others. 
For example, sidewalk curb cuts, designed to 
make sidewalks and streets accessible to those 
using wheelchairs, are today often used by kids 
on skateboards, parents with baby strollers, and 
delivery staff with rolling carts. When television 
displays in noisy areas of airports and restaurants 
are captioned, they are more accessible to people 
who are deaf and everyone else.

UDI Goal
The goal of UDI is to maximise the learning of 
students with a wide range of characteristics 
by applying UD principles to all aspects of 
instruction (e.g., delivery methods, physical 
spaces, information resources, technology, 
personal interactions, assessments).

UD Principles
At the Center for Universal Design (CUD) at 
North Carolina State University, a group of 
architects, product designers, engineers, and 
environmental design researchers established 
seven principles of UD to provide guidance in the 
design of products and environments (Connell, 
et al., 1997). The CUD’s principles of UD are 
listed below. They are followed by an example of 
application in instruction.

1. Equitable use. The design is useful and 
marketable to people with diverse abilities. 
Example: A professor’s website is designed 
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so that it is accessible to everyone, including 
students who are blind and using text-to-
speech software.

2. Flexibility in use. The design accommodates 
a wide range of individual preferences and 
abilities. Example: A museum, visited as a field 
trip for a course, allows each student to choose 
to read or listen to a description of the contents 
of display cases.

3. Simple and intuitive use. Use of the design is 
easy to understand, regardless of the user’s 
experience, knowledge, language skills, or 
current concentration level. Example: Control 
buttons on science equipment are labeled with 
text and symbols that are simple and intuitive 
to understand.

4. Perceptible information. The design 
communicates necessary information 
effectively to the user, regardless of ambient 
conditions or the user’s sensory abilities. 
Example: A video presentation projected in a 
course includes captions.

5. Tolerance for error. The design minimizes 
hazards and the adverse consequences of 
accidental or unintended actions. Example: 
Educational software provides guidance and 
background information when the student 
makes an inappropriate response.

6. Low physical effort. The design can be used 
efficiently, comfortably, and with a minimum 
of fatigue. Example: Doors to a lecture hall 
open automatically for people with a wide 
variety of physical characteristics.

7. Size and space for approach and use. Appropriate 
size and space is provided for approach, reach, 
manipulation, and use regardless of the user’s 
body size, posture, or mobility. Example: A 
flexible science lab work area has adequate 
workspace for students who are left- or right-
handed and for those who need to work from 
a standing or seated position.

UDI Definition, Guidelines and Examples
Universal design principles can be applied to 
many products and environments. Using the 
CUD format, UDI can be defined as the design of 
instruction of products and environments to be us-
able by all students, to the greatest extent possible, 
without the need for adaptation or specialized 
design. 

Universal design principles can be applied to the 
overall design of instruction as well as to specific 
instructional materials, facilities, and strategies 
(such as lectures, classroom discussions, group 
work, web-based instruction, labs, field work, and 
demonstrations). Universally designed curriculum 
provides students with a wide range of abilities, 
disabilities, ethnic backgrounds, language 
skills, and learning styles multiple means of 
representation, action and expression, and 
engagement (called Universal Design for Learning 
by the Center for Applied Special Technology 
(CAST), www.cast.org/). Listed below are examples 
of instruction that employ principles of UD. They 
are organized under eight performance indicator 
categories, with a general guideline for each 
(Burgstahler, 2007).

1. Class climate. Adopt practices that reflect 
high values with respect to both diversity 
and inclusiveness. Example: Put a statement 
on your syllabus inviting students to meet 
with you to discuss disability-related 
accommodations and other special learning 
needs.

2. Interaction. Encourage regular and effective 
interactions between students and the 
instructor and ensure that communication 
methods are accessible to all participants. 
Example: Assign group work for which 
learners must support each other and that 
places a high value on different skills and 
roles.

3. Physical environments and products. Ensure 
that facilities, activities, materials, and 
equipment are physically accessible to and 
usable by all students, and that all potential 
student characteristics are addressed in safety 
considerations. Example: Develop safety 
procedures for all students, including those 
who are blind, deaf, or wheelchair users. 

4. Delivery methods. Use multiple, accessible 
instructional methods that are accessible to 
all learners. Example: Use multiple modes to 
deliver content; when possible allow students 
to choose from multiple options for learning; 
and motivate and engage students—consider 
lectures, collaborative learning options, hands-

http://www.cast.org/
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on activities, Internet-based communications, 
educational software, field work, and so forth.

5. Information resources and technology. Ensure that 
course materials, notes, and other information 
resources are engaging, flexible, and accessible 
for all students. Example: Choose printed 
materials and prepare a syllabus early to 
allow students the option of beginning to read 
materials and work on assignments before the 
course begins. Allow adequate time to arrange 
for alternate formats, such as books in audio 
format.

6. Feedback. Provide specific feedback on a 
regular basis. Example: Allow students to turn 
in parts of large projects for feedback before 
the final project is due.

7. Assessment. Regularly assess student progress 
using multiple accessible methods and tools, 
and adjust instruction accordingly. Example: 
Assess group and cooperative performance, as 
well as individual achievement.

8. Accommodation. Plan for accommodations 
for students whose needs are not met by the 
instructional design. Example: Know campus 
protocols for getting materials in alternate 
formats, rescheduling classroom locations, 
and arranging for other accommodations for 
students with disabilities.

CAST has focused specifically on the application 
of UD to curriculum. Specifically, CAST defines 
Universal Design for Learning (UDL) as “a 
framework for designing curricula that enable 
all individuals to gain knowledge, skills, and 
enthusiasm for learning. UDL provides rich 
supports for learning and reduces barriers to the 
curriculum while maintaining high achievement 
standards for all.” UDL calls for the integration 
of multiple means of representation, action 
and expression, and engagement into course 
curriculum.

Employing UD principles does not eliminate the 
need for specific accommodations for students 
with disabilities. For example, you may need to 
provide a sign language interpreter for a student 
who is deaf. However, applying universal design 
concepts in course planning ensures full access to 

the content for most students and minimizes the 
need for special accommodations. For example, 
designing web resources in accessible formats as 
they are developed means that no redevelopment 
is necessary if a blind student enrolls in the class. 

UD benefits students with disabilities but also 
benefits others. For example, captioning course 
videos, which provides access to deaf students, 
is also a benefit to students for whom English 
is a second language, to some students with 
learning disabilities, and to those watching the 
tape in a noisy environment. Delivering content 
in redundant ways can improve instruction for 
students with a variety of learning styles and 
cultural backgrounds. Letting all students have 
access to your class notes and assignments on a 
website benefits students with disabilities and 
everyone else. Planning ahead saves time in the 
long run.  

Employing UD principles in everything we do 
makes a more accessible world for all of us. It 
minimizes the need to alter it for anyone. For a 
complete UDI application checklist, consult Equal 
Access: Universal Design of Instruction at www.
uw.edu/doit/equal-access-universal-design-instruction.

Resources
Consult the following resources for further 
information on UDI.

Applications of Universal Design 
www.uw.edu/doit/resources/
popular-resource-collections/
applications-universal-design

Bar, L., Galluzzo, J., & Sinfit, S.D. (1999). The 
accessible school: Universal design for educational 
settings. Berkeley, CA: MIG Communications. 

Burgstahler, S. (2012). Equal access: Universal 
design of instruction. Seattle: DO-IT, 
University of Washington. www.uw.edu/doit/
equal-access-universal-design-instruction

Burgstahler, S. , & Coy, R. (Eds.). (2008). Universal 
Design in Higher Education: From Principles to 
Practice. Boston: Harvard Education Press. 

http://www.uw.edu/doit/equal-access-universal-design-instruction
http://www.uw.edu/doit/equal-access-universal-design-instruction
http://www.uw.edu/doit/resources/popular-resource-collections/applications-universal-design
http://www.uw.edu/doit/resources/popular-resource-collections/applications-universal-design
http://www.uw.edu/doit/resources/popular-resource-collections/applications-universal-design
http://www.uw.edu/doit/equal-access-universal-design-instruction
http://www.uw.edu/doit/equal-access-universal-design-instruction
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Center for Applied Special Technology (CAST)  
www.cast.org/our-work/about-udl.html

The Center for Universal Design 
 www.ncsu.edu/ncsu/design/cud/

The Center for Universal Design in Education 
 www.uw.edu/doit/programs/
center-universal-design-education/overview

Connell, B. R., Jones, M., Mace, R., Mueller, J., 
Mullick, A., Ostroff, E., et al. (1997). The principles 
of universal design. www.ncsu.edu/ncsu/design/cud/
about_ud/udprinciplestext.htm

Edyburn, D., & Higgins, K. (Eds.). (2005). 
Handbook of special education technology research and 
practice. Whitefish Bay, WI: Knowledge by Design.

National Center for Accessible Media (NCAM) 
ncam.wgbh.org

Orkwis, R., & McLane, K. (1998). A curriculum 
every student can use: Design principles for student 
access. eric.ed.gov/?id=ED423654

Pisha, B., & Coyne, P. (2001). Smart from the start: 
The promise of universal design for learning. 
Remedial and Special Education, 22(4), 197-203.

Pliner, S., & Johnson, J. (2004). Historical, 
theoretical, and foundational principles of 
universal design in higher education. Equity of 
Excellence in Education, 37, 105-113.

Scott, S., McGuire, J., & Shaw, S. (2003). Universal 
design for instruction: A new paradigm for adult 
instruction in postsecondary education. Remedial 
and Special Education, 24(6), 369-379.

Silver, P., Bourke, A., & Strehorn, K. C. (1998). 
Universal instructional design in higher 
education: An approach for inclusion. Equity & 
Excellence in Education, 31(2), 47-51.
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About DO-IT
DO-IT (Disabilities, Opportunities, 
Internetworking, and Technology) serves to 
increase the successful participation of individuals 
with disabilities in challenging academic 
programs and careers, such as those in science, 
engineering, mathematics, and technology.. 
Primary funding for DO-IT is provided by 
the National Science Foundation, the State 
of Washington, and the U.S. Department of 
Education. 

For further information, to be placed on the DO-
IT mailing list, request materials in an alternate 
format, or to make comments or suggestions 
about DO-IT publications or web pages, contact:

DO-IT 
Box 354842 
University of Washington 
Seattle, WA 98195-4842 
doit@uw.edu 
www.uw.edu/doit/ 
206-685-DOIT (3648) (voice/TTY)  
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As greater numbers of individuals with disabilities take advantage of the opportunities 
open to them in business, industry and travel, it becomes increasingly important to 
promote an environment that is positive for persons with disabilities. One of the best 
and easiest ways to show respect is through appropriate language use. The 
recommended manner is known as “person first” language. This means that the person 
is emphasized first, the disability second.  The disability is only part of the whole 
person. 

 

Positive Phrases 
• person with a disability 
• person without a  disability 
• individual who is unable to 

speak 
• woman who is blind or has a 

visual disability 
• person who uses a 

wheelchair 
• person who is deaf; person 

who is hard of  hearing 
• man with paraplegia 
• individual with epilepsy 
• person who has a learning 

disability 
• person with a mental or 

cognitive disability 
• person with a developmental 

disability 
• person with a congenital 

disability 
• person who has muscular 

dystrophy 

Negative Phrases 
• disabled, handicapped 
• normal person 
• mute, dumb 

 
• blind woman or “the  blind” 

 
• confined or restricted to a 

wheelchair 
• suffers a hearing loss, the 

deaf 
• paraplegic 
• epileptic 
• slow learner, retarded, 

learning disabled 
• crazy, demented, insane, 

nuts 
• mentally retarded 

 
• has a birth defect 

 
• stricken by MD, physically 

disabled, crippled, lame, 
deformed 

Karen A. Myers, PhD 
Saint Louis University 5-1-13 

 
 

The Language of Disabilities 
“Person-First” 
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Synopsis

Language Basics

1. Person First Language is recommended when referring to a person with a disability. Example:

Do say, “a person with a disability” and do NOT say, “a disabled person.”

2. Euphemism or Patronizing language is overly politically correct or nice language and should

be avoided. Example: Do NOT say, “differently abled” or “he/she is challenged.”

3. Open dialogue is a discourse between two people and the first step to effectively

communicating needs between those two people.

4. Public dialogue is an informal or formal group dialogue with the goal of resolving issues, and

developing empathy and understanding.

5. Group Internal use of Stigmatized Terms refers to the idea of “reclaiming” terms with which

were previously considered negative. (e.g. a support group for women with disabilities called

Gimp Girl, founded by a woman with a disabilities). You should NOT use such language

unless you are a member of that community or are invited to.

Assisting a person with a disability

Home Accommodations Blockers Courses Websites Multimedia

Testing/Triage Software Training

Sites at Penn State Log in

http://www.gimpgirl.com/
http://accessibility.psu.edu/
http://accessibility.psu.edu/accommodations/
http://accessibility.psu.edu/blockers/
http://accessibility.psu.edu/courses/
http://accessibility.psu.edu/webpagetools/
http://accessibility.psu.edu/multimedia/
http://accessibility.psu.edu/testing/
http://accessibility.psu.edu/software/
http://accessibility.psu.edu/training/
http://accessibility.psu.edu/
http://accessibility.psu.edu/feed/
http://sites.psu.edu/
http://sites.psu.edu/accessibility/wp-login.php?redirect_to=http%3A%2F%2Fsites.psu.edu%2Faccessibility%2Faccommodations%2Faudience%2Fetiquette%2F
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1. Questions to ask before helping someone with a disability? Consider the accessibility of an

environment or helping someone without physical contact and accessible materials for those

with various disabilities.

2. Tips to helping some with a disability can be specific to the person with disability. Check out

the tips below and put yourself in their shoes.

In the Classroom/Hybrid/Online

1. Teachers communicating with students with disabilities can be difficult depending on the

specific kind of disability. Starting an “open dialogue” and reviewing the tips below are a

great start.

2. Persons with disability communicating with their teachers should begin on the first day of

class and contacting the Office of Disability Services will allow for class content to be

universally design for all the students’ needs. All students can benefit from this.

Top of Page

Language Basics

Person First language

In order to provide focus on the person versus his or her disability, it is recommended that

 “person-first” language be used to refer to someone who may have a particular disability. Thus,

 the expression “a person with a disability” is preferred to “disabled person.” Similarly, the

 expression “person who uses a wheelchair” is generally preferred to “wheelchair bound”. The

 use of “person first” language has become a practice of etiquette and more importantly respect

 for people with disabilities.

NEVER use a disability as an adjective. Calling a person “disabled,” “handicapped,” or identifying

 them solely by their disability, such as “the deaf guy” or “a blind person” associates them with

 ONLY their disability and not as a person. Another example, wheelchair bound or confined to a

 wheelchair is a negative verbalization of a wheelchair. The wheelchair enables them to be mobile

 and gives a person access to the environment, so the person is a person that uses a wheelchair

 and not a wheelchair user.

Euphemism or Patronizing language

A euphemism is patronizing or overly politically correct language, such as saying, “He/she is

 challenged.” The use of the word “challenged” is the euphemism. This is sometimes referred to

 as “Nice” language. Other examples of this are saying someone is “differently abled.” When

 using patronizing language, there is emphasis placed on the disability with a connotation of

http://equity.psu.edu/ods/dcl


Accessibility at Penn State | Accessibility Etiquette

 inferiority as person. Every person is capable of achieving a goal and uses various tools to do so.

 People with disabilities use tools to achieve those goals, such tools as wheel chairs, canes,

 various technologies and other assistive devices or technologies.

Open dialogue

Open dialogue is an open discourse between two people to meet a consensual and mutual

 understanding between each other. This discourse should allow for freedom to ask questions,

 bring forth requests freely, and be mutually receptive and non-judgmental about the topic of the

 dialogue.

Initiating “open dialogue” with students, friends, coworkers or anyone for that matter is the first

 step to building communication. This allows for needs and concessions to be arranged for

 everyone to follow.

Students should approach teachers and clarify if the teacher understands any needs or

 concessions. A student should understand the perspective of the teacher. The teacher has a

 large number of students to attend to. So, the student needs to make a teacher aware of their

 needs.

Also, teachers should take the initiative and check with their students, especially if a student is

 identified with a disabilities. Each student has a differing set of abilities and differing

 concessions are necessary based on those abilities. Exploring these concessions should be done

 privately between the teacher and student and both should feel free to initiate discourse to

 achieve a mutual goal.

Public dialogue

Initiating “open dialogue” and engaging in “public dialogue” are very different. Public dialogue

 usually takes place in a formal or informal setting discussing the topic in a group or social

 group. The goal here is to gain understanding and develop solutions to communicating and

 understanding each other’s needs. Understanding each other’s perspectives on the subject of

 disabilities can be hard for those with a disability and without. No one wants to be mean, make

 someone feel bad for not understanding how to respect each other’s feelings and needs. So,

 those persons with a disability and those interacting with persons with disabilities should be

 careful not to have judgmental behavior. A “public dialogue” can be an opportunity to learn from

 each other and gain empathy for each other’s feelings and perspectives and develop solutions to

 help everyone feel comfortable.

Group Internal Use of Stigmatized Terms
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You may find people with disabilities using or “reclaiming” terms which were previously

 considered negative. For example, there is a support group for women with disabilities called

 Gimp Girl (http://www.gimpgirl.com/). Another example is the use of Deaf with a capital D to

 describe the community of sign language speakers.

In many cases though, a person NOT belonging to that community may want to be cautious

 about using the term until advised to by a member that community.

Top of Page

Assisting a person with a disability

Questions you should ask yourself before helping those with disabilities:

Is the environment accessible? Assessing the surroundings from a perspective of the person

 with the disability is difficult. You are not he or she and may never understand their

 perspective completely. But, there are tips to help offer some foresight to the situation.

Are you able to give help without physically touching the person or entering their space or

 comfort zone?

Are classroom materials accessible for the students’ needs?

Assessing the needs is done both by the person with the disability and the faculty or staff

 providing the concessions. This leads to being sensitive about the environment, physical contact

 or how content is provided.

Here are some tips:

Do not pat someone on the head or touch a cane, wheelchair or other tools that they use. As

 in the previous example, having a table in the classroom available for the student and not

 desks with attached chairs may be an issue.

If you are going to offer assistance, ask them how they would like that assistance to be given.

Also, be mindful about moving furniture and providing a pathway. Keep in mind clearance and

 consistency of furniture placement. This allows access for those with who need mobility

 access due to the use of a wheelchair or a person with vision impairment.

Think before speaking and use “Person-First” language as explained in the Language Basics.

Do not grab someone’s arm or touch someone at all without permission, this may startle

 them. Is this normally done to you? If you would like to gain someone’s attention, tap on a

 surface near them or make your presence known verbally and without touching their

 persons. Remember, for those who are vision impaired/blind verbally identifying yourself is

 the best practice.

http://www.gimpgirl.com/
http://accessibility.psu.edu/deaf#deafcult
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Offer and only push a wheelchair when requested. If possible, try to sit at eye level with a

 person in a wheelchair. This removes any perception of speaking down to a person in a

 wheelchair and this action reduces the kink in the neck of a person who uses a wheelchair.

Top of Page

In the Classroom/Hybrid/Online

Teachers communicating with students with disabilities

Behave naturally as if you would with any other person.

Always talk to a person directly even if an assistant or interpreter is present.

Speaking at their physical level, if in a wheel chair sit and hold a conversation at eye level.

Avoid making assumptions to students’ needs or abilities. This goes for all students. There

 are students with hidden disabilities.

Respond to the requests when made in a reasonable amount of time.

For further information, please visit the Office of Disability Services web site:

 http://equity.psu.edu/ods/dcl

In the classroom the environment and the class activities play a big role. For example, the

 user of a wheelchair may need the classroom arranged to sit and participate with other

 students. This may be an issue if the classroom is full of desks with tables attached to the

 chairs. A student who is blind/vision impaired/deaf may need to sit near the front or be

 guided to a seat. Furthermore, breaking out into a group project and shifting chairs may

 cause unforeseen issues for some. If there are any doubts initiate an “open dialogue” with

 your student.

Persons with disability communicating with teachers

Students with disabilities should start an “open dialogue” with teachers at the beginning of the

 course. Not to seek special attention, but to allow the teacher to make the curriculum universally

 accessible for all students and allow teachers to actively engage in best practices for online,

 hybrid or in class teaching. These alternative resources may benefit the other students in the

 class, also.

Students are also advised to contact the Office of Disability Services at their local campus. The

 Office of Disability Services has been established to help students who need accommodations,

 particularly extended times for assignments or exams, receive them in the most efficient and

 timely manner possible.

http://equity.psu.edu/ods/dcl
http://equity.psu.edu/ods/dcl


 
 

Tips for Effective Communication 
  

 

Karen A. Myers, PhD  

Saint Louis University 
 

When you meet a person with a 
VISUAL disability 

When you meet a person with a 
HEARING disability 

 
• It is always appropriate to offer your 

help; just do not be surprised if the 
individual would “rather do it myself.” 

• If you are helping and not sure what 
to do, ask the person. 

• A gentle touch on the elbow will 
indicate to a person with a visual 
disability that you are speaking to 
him/her. 

• If you are walking with a person who 
is blind, do not take that person’s 
arm; rather let that person take your 
arm. 

• Do not shout. “Blind” does not 
mean hard of hearing. 

• If you have a question for the person 
with a visual disability, ask him/her, 
not his/her companion. “Blind” does 
not mean one cannot speak. 

• Never pet a guide dog, except when 
the dog is “off-duty”. Even then you 
should ask the dog’s master first. 

• Do not worry about substituting 
words for “see”, “look”, or even 
“blind”. Do not avoid them where 
these words fit. You can talk about 
blindness itself, when you both feel 
comfortable about it. 

• When you meet a person you know 
with a visual disability, mention your 
name. It is difficult to recognize 
voices unless you happen to have a 
very distinctive one. 

• Speak clearly and distinctly, but do 
not exaggerate. Use normal speed 
unless asked to slow down. 

• Provide a clear view of your mouth. 
Waving your hands or holding 
something in front of your lips, thus 
hiding them, makes lip reading 
impossible.  Do not chew gum. 

• Use a normal tone unless you are 
asked to raise your voice. 
Shouting will be of no help. 

• Speak directly to the person, rather 
than from the side or back of the 
person. 

• Speak expressively. Because 
persons who are deaf cannot hear 
subtle changes in tone, which may 
indicate sarcasm or seriousness, 
many will rely on your facial 
expressions, gestures and body 
language to understand you. 

• If you are having trouble 
understanding the speech of a 
person who is deaf, feel free to ask 
him/her to repeat. If that does not 
work, then use a paper and pen. 

• If a person who is deaf is with an 
interpreter, speak directly to the 
person who is deaf – not to the 
interpreter. 
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When you meet a person with a 
MOBILITY disability 

When you meet a person with a 
COGNITIVE disability 

 
• Offer help, but wait until it is 

accepted before giving it. Giving 
help before it is accepted is rude 
and sometimes can be unsafe. 

• Accept the fact that a disability 
exists. Not acknowledging a 
disability is similar to ignoring 
someone’s gender or height. But 
to ask personal questions 
regarding the disability would be 
inappropriate until a closer 
relationship develops in which 
personal questions are more 
naturally asked. 

• Talk directly to a person with a 
disability. Because an individual 
has a functional limitation, it does 
not mean the individual cannot 
communicate for himself/herself. 

• Do not park your car in a parking 
place that is specially designed 
for use by a person with a 
disability.  These are reserved 
out of necessity, not 
convenience. 

• Treat a person with a disability as 
a healthy person. Because an 
individual has a functional 
limitation, it does not mean the 
individual is sick. 

• Keep in mind that persons with 
disabilities have the same 
activities of daily living as you do. 

• Use very clear, specific language. 
 

• Condense lengthy directions into 
steps. 

 
• Use short, concise instructions. 

 
• Present verbal information at a 

relatively slow pace, with 
appropriate pauses for 
processing time and with 
repetition if necessary. 

 
• Provide cues to help with 

transitions: “In five minutes we’ll 
be going to lunch.” 

 
• Reinforce information with 

pictures or other visual images. 
 

• Use modeling, rehearsing, and 
role-playing. 

 
• Use concrete rather than abstract 

language. 
 

• Limit the use of sarcasm or subtle 
humor. 

 
• If you are not sure what to do or 

say, just ask the person what 
he/she needs. 
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Bes Practice: Formatting Accessible
 Documents

About Accessible Documents
Content that is created in Blackboard using the content editor is
 automatically formatted in HTML following accessibility sandards. You
can link to or pull in content from other sources using the content editor

 or other Learn tools. Content that you add as an attachment or a linked
 fle is not formatted automatically. Make sure all your sudents can
 read and interact with your attachments and linked fles by making them accessible. When your document is
 formatted using syles and tags, it will be accessible to your users who rely on assisive technology such as
 screen reading applications (screen readers).

Accessible documents have a sructure that is based on syling elements or tags. This sructure provides a
 hierarchy of information. The mos important information is identifed as the top-level in the document, and
 supporting information is identifed as lower levels. Illusrations, graphs, and tables that appear in a document
 have specifc tags based on what type of information they convey.

Screen readers use tags to convey an information hierarchy of a document to users so that they can undersand
 the organization of the material. Tags are also used to provide other information to users such as descriptions of
 visual content and the organization of data arranged in tables.

Adding a sructure to documents using syles and tags during the writing process is the fases, more reliable way
 to create accessible documents. In almos every case, syles and tags added in an application such as
 Microsoft  Word transfer when you save the document to another format such as Adobe PDF or HTML.

Using Documents in Learn

©

Related content

Accessibility Features

Quick Links

Back to top

 Help   English (US)

 Accessibility Home 

https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility/000_Accessibility_Features
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility/010_Quick_Links
https://en-us.help.blackboard.com/
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Many areas in Learn allow you to add documents, including content pages, assignments, and tess. Format any
 fles that you disribute in your class using syles and tags. This will ensure that all of your sudents can
 participate fully no matter what technology they use to read documents.

Encourage your sudents to format documents that they exchange in groups and for group assignments and
 group presentations using syles and tags. Promoting accessibility among your sudents raises awareness and
 increases sudent achievement, retention, and satisfaction.

How to Make Microsoft  Word Documents Accessible

Use Headings
Create a consisent heading sructure in Word using
 syles. This is diferent from jus changing the font
 size or making the font bold. Set up your document
 syles or use one of the templates that Microsoft
 includes with Word. In Word 2007 and 2010, to
 change a block of text, select it and then click on
 the appropriate syle from the tool bar. Diferent
 versions of Word have slightly diferent ways of
 accessing and setting syles, so use the help in
 your version for specifc insructions.

As a general rule, use no more than one Heading 1
 <H1> on a page. The <H1> tag identifes the
 highes level of information in the document
 sructure. Heading 1 is used for chapter titles, main
 section headings, and other divisions that
 represent the top level of information. Use Heading
 2 <H2> and lower number headings to identify the
 sub-levels of information in your document.

When adding heading tags, be consisent and include each level in the hierarchy where appropriate to refect the
 organization of the document. Be sure that H1 is followed by H2, then H3, and H4. Don't go from H1 to H4  jus
 for formatting purposes. Insead, change your syles for each heading to change the way it looks.

Alternative Text for Images
Screen readers use alternative text (alt text) to provide users with information about images. In mos versions of
 Word, right-click an image and select Format Picture... In the dialog box, select the option for Alt Text , and then
 type in your alt text. Be specifc and succinct so that users will quickly undersand what is being described.
 Diferent versions of Word have slightly diferent ways of entering alt text, so use the help in your version for
 specifc insructions.

©
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Data Tables
In accessible documents, tables are never used for formatting layout on a page because it is difcult for screen 
 readers to undersand the information architecture and what is being presented. Tables are only used to present 
 data. For screen readers to interpret data in a table so that users can undersand how the data is organized, the 
 screen reader needs to be able to identify which cells are part of the header row and which cells contain data. 
 You can indicate that a row repeats on the top of each page in the Table Properties menu in Word. When 
 saved as a PDF, the frs row is detected as a table header. If the Word fle is saved as HTML, the table headers 
 are not maintained. Insead, the cells are tagged as <thead>. Data cells are tagged as <tbody>.

When you convert to HTML from Word, you can edit your HTML document using a text editor or other application 
 such as Adobe Dreamweaver to add specifc table tags. Use <th> to tag table headers, <tr> to identify the 
 beginning of each new row, and <td> to tag cells that contain data. See the following example. Unfortunately, 
 there is no way to tag these individual elements in Word.

 

Links
It is easy to create links in Word by pasing the full URL into a page. When you press space or Enter, Word
 automatically creates a link. Change the link text to something descriptive because the URL that is automatically
 created may not make sense to a screen reader. If you are creating a Word document that may be printed as
 well as read electronically, consider including both the URL and the descriptive link in the text. For example:
Getting Started with Creating Accessible Course Content

Word 2010 has two felds for text, Title and Description. Type your alt text in the Description box so that
 when you convert Word documents to PDF or HTML the alt text is converted to the new format. Titles are
 not converted to other formats, so you would have to enter them again in the new format.



http://ondemand.blackboard.com/r91/documents/getting_started_with_accessible_content.pdf
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Windows Word 2010 Accessibility Checker
If you are using Windows, Word 2010 has a built-in Accessibility Checker. This is a good resource to help you
 identify and repair accessibility issues. Access the Accessibility Checker from Files > Info > Check for Issues >
 Check Accessibility.

How to Make PDF Documents Accessible
PDF (portable document format) is an open sandard for formatting documents. PDF creates fles that look the
 same when printed as when exchanged electronically. When you share a PDF fle, almos everyone can read it
 using free Adobe Reader® software or the Adobe Reader mobile app.

Mos PDF fles are converted from an application such as Microsoft Word. Many programs and plug-ins can
 create PDF fles, but very few create tagged PDF fles. PDF tags provide a hidden sructure and textual
 representation of the PDF content so that it can be read by a screen reader. PDF tags are similar to HTML tags
 and Word syles.

Adobe Acrobat is the original application for creating PDF documents and converting other documents into PDF.
 Too many diferent combinations of authoring software and PDF converters exis to describe each one in this
 topic. If you are converting a Word fle to PDF and you have created an accessible Word fle using heading tags,
 alt text for graphics, and so on, Ofce 2010 can create tagged PDFs natively. You can also download and insall
 the Adobe add-in, called PDFMaker, to create PDF fles from Word. If you are using earlier versions of Ofce,
 you mus have the add-in to create tagged PDF fles.

If you are using the Adobe add-in, click Save as Adobe PDF from the File menu. In the PDFMaker dialog box,
 click Enable Accessibility and Refow with tagged Adobe PDF from the Settings tab. If you are using the native
 save, click Save as PDF. Before you save the fle, click Options, and then select Document sructure tags for
 accessibility.

Adobe Acrobat X and later has an accessibility checker that scans your PDF and alerts you to any problems.
 The accessibility checker will help you correct any issues. You can also correct table coding using Acrobat's
 TouchUp Reading Order Table Editor. To learn more about using Adobe Acrobat to create accessible fles, visit
 Adobe.com and search for "accessibility." 

© 

http://www.adobe.com/cfusion/search/index.cfm?term=accessible+PDF&loc=en_us&siteSection=acrobat%3Akb


Creating Alt Text for Microsoft Office Software 
Excel 

1. Do one of the following: 

o For a shape, picture, chart, SmartArt graphic, or other object, right-
click it, click Format object, and then click the Alt Text pane. 

To add Alt Text to the entire SmartArt graphic or chart, click the border of the 
SmartArt graphic or chart, and not an individual shape or piece. 

o For a table, right-click the table, click Table, and then 
click Alternative Text. 

o For a PivotTable, right-click it, point to PivotTable Options, and then 
click Alt Text. 

2. In the Description box, enter an explanation of the shape, picture, chart, 
table, PivotTable, SmartArt graphic, or other object. This box should always 
be filled in. 

3. If you want, in the Title box, enter a brief summary. This box should only be 
filled in if you are entering a detailed or long explanation in 
the Description box. 

NOTE: Unless you have a complex chart or table, you will usually want to enter 
text in just the Description box. When you have complex content to describe, 
then filling in the Title field is useful so reading the full description is not 
necessary unless desired. 

 

Outlook 

1. Do one of the following: 

o For a shape, picture, chart, SmartArt graphic, or other object, right-
click it, click Format object, and then click the Alt Text pane. 

To add Alt Text to the entire SmartArt graphic or chart, click the border of the 
SmartArt graphic or chart, and not an individual shape or piece. 



o For a table, right-click the table, click Table Properties, and then click 
the Alt Text tab. 

2. In the Description box, enter an explanation of the shape, picture, chart, 
table, SmartArt graphic, or other object. This box should always be filled in. 

3. If you want, in the Title box, enter a brief summary. This box should only be 
filled in if you are entering a detailed or long explanation in 
the Description box. 

NOTE: Unless you have a complex chart or table, you will usually want to enter 
text in just the Description box. When you have complex content to describe, 
then filling in the Title field is useful so reading the full description is not 
necessary unless desired. 

 

PowerPoint 

1. Do one of the following: 

o For a shape, picture, chart, table, SmartArt graphic, or other object, 
right-click it, click Format object, and then click the Alt Text pane. 

To add Alt Text to the entire SmartArt graphic or chart, click the border of the 
SmartArt graphic or chart, and not an individual shape or piece. 

2. In the Description box, enter an explanation of the shape, picture, chart, 
table, SmartArt graphic, or other object. This box should always be filled in. 

3. If you want, in the Title box, enter a brief summary. This box should only be 
filled in if you are entering a detailed or long explanation in 
the Description box. 

NOTE: Unless you have a complex chart or table, you will usually want to enter 
text in just the Description box. When you have complex content to describe, 
then filling in the Title field is useful so reading the full description is not 
necessary unless desired. 

 

 

Word 



1. Do one of the following: 

o For a shape, picture, chart, SmartArt graphic, or other object, right-
click it, click Format object, and then click the Alt Text pane. 

To add Alt Text to the entire SmartArt graphic or chart, click the border of the 
SmartArt graphic or chart, and not an individual shape or piece. 

o For a table, right-click the table, click Table Properties, and then click 
the Alt Text tab. 

2. In the Description box, enter an explanation of the shape, picture, chart, 
table, SmartArt graphic, or other object. This box should always be filled in. 

3. If you want, in the Title box, enter a brief summary. This box should only be 
filled in if you are entering a detailed or long explanation in 
the Description box. 

NOTE: Unless you have a complex chart or table, you will usually want to enter 
text in just the Description box. When you have complex content to describe, 
then filling in the Title field is useful so reading the full description is not 
necessary unless desired. 

 

Make the Alt Text command readily available 

If you frequently add alternative text to shapes, pictures, charts, tables, SmartArt 
graphics, or other objects, you can add the Alt Text command to the Quick Access 
Toolbar to create a shortcut to it. 

1. In the upper-left corner above the Ribbon, click Customize Quick Access 
Toolbar. 

2. Click More Commands, and then under Choose commands 
from click Commands Not in the Ribbon. 

3. Click Alt Text and then click Add. 

To use the Alt Text command on the Quick Access Toolbar, select the shape, 
picture, chart, table, SmartArt graphic, or other object, before you click the 
toolbar button, and then add your alternative text. 
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Note:

Acrobat DC tools make it easy to create accessible PDFs and check the
 accessibility of existing PDFs. You can create PDFs to meet common
 accessibility standards, such as Web Content Accessibility Guidelines
 (WCAG) 2.0 and PDF/UA (Universal Access, or ISO 14289). The simple,
 guided workflow lets you do the following:

Make PDFs accessible: A predefined action automates many tasks, checks
 accessibility, and provides instructions for items that require manual fixes.
 Quickly find and fix problem areas.

Check accessibility: The Full Check tool verifies whether the document
 conforms to accessibility standards, such as PDF/UA and WCAG 2.0.

Report accessibility status: The Accessibility Report summarizes the
 findings of the accessibility check. It contains links to tools and documentation
 that assist in fixing problems.

 Make PDFs accessible (Acrobat Pro DC)

The Make Accessible action walks you through the steps required to make a
 PDF accessible. It prompts to address accessibility issues, such as a missing
 document description or title. It looks for common elements that need further
 action, such as scanned text, form fields, tables, and images. You can run
 this action on all PDFs except dynamic forms (XFA documents) or portfolios.

1. Choose Tools > Action Wizard.

The Action Wizard toolset is displayed in the secondary toolbar.

A list of available actions is displayed under the Action List in the
 right-hand pane.

2. From the Action List, click Make Accessible.

The right-hand pane changes to display each task included in the Make
Accessible action, as well as the instructions to execute the action.

3. Select the files that you want to apply the Make Accessible action to. By
default, the action runs on the document that's currently open. Select
Add Files to select additional files or a folder to run the action on.

MENU SEARCH ERICA
Was this helpful?

Yes   No

https://helpx.adobe.com/acrobat/topics.html
http://helpx.adobe.com/en/acrobat.html
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Select Add Files to run the report on additional files or folders.

4. Click Start.

5. Follow the prompts to complete the Make Accessible action.

 Check accessibility of PDFs (Acrobat Pro
 DC)

A good way to check the accessibility of a document is to use tools that your
 readers will use. Even if you do not have access to those tools, Adobe
 Acrobat DC provides an automated way to check the accessibility of a PDF
 file. The Full Check feature in Acrobat DC checks a PDF for many of the
 characteristics of accessible PDFs. You can choose which accessibility
 problems to look for and how you want the results reported.

1. Choose Tools > Accessibility.

The Accessibility toolset is displayed in the secondary toolbar.

2. In the secondary toolbar, click Full Check.

The Accessibility Checker Options dialog box is displayed.

3. In the Report Options section, select options for how you want to view
the results. You can save the results as an HTML file on your system,
or attach the results file to the document itself.

4. Select a page range if you prefer to check individual pages of a
document.

When you have a large document, running a full check one page at a
 time can be more efficient.

5. Select one or more of the Checking Options.

6. Click Start Checking. The results are displayed in the Accessibility
Checker panel on the left, which also has helpful links and hints for
repairing issues. If you created a report in step 2, the results are
available in the selected folder.

Because the Full Check feature cannot distinguish between essential and
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 nonessential content types, some issues it reports don’t affect readability.
 It’s a good idea to review all issues to determine which ones require
 correction.

The report displays one of the following statuses for each rule check:

Passed: The item is accessible.
Skipped By User: Rule was not checked because it wasn't selected
 in the Accessibility Checker Options dialog box.
Needs Manual Check: The Full Check feature couldn't check the
 item automatically. Verify the item manually.
Failed: The item didn't pass the accessibility check.

Accessibility Checker rules statuses.

In addition to Full Check, Acrobat DC provides other methods to check
 PDF accessibility:

Use Reflow view to quickly check the reading order.
Use Read Out Loud to experience the document as readers who use
 the text-to-speech conversion tool experience it.
Save the document as accessible text and then read the saved text file
 in a word-processing application. This exercise enables you to
 emulate the end-user experience of readers who use a braille printer
 to read the document.
Use the Touch Up Reading Order tool, Order, Tags, and Content
 panels to examine the structure, reading order, and contents of a PDF.

 See also
Reading PDFs with reflow and accessibility features
Accessibility preferences
Creating accessible PDFs
Standard PDF tags (Acrobat Pro)

https://helpx.adobe.com/content/help/en/acrobat/using/reading-pdfs-reflow-accessibility-features.html#reflow_a_pdf
https://helpx.adobe.com/content/help/en/acrobat/using/reading-pdfs-reflow-accessibility-features.html#reflow_a_pdf
https://helpx.adobe.com/content/help/en/acrobat/using/reading-pdfs-reflow-accessibility-features.html#read_a_pdf_with_read_out_loud
https://helpx.adobe.com/content/help/en/acrobat/using/touch-reading-order-tool-pdfs.html
https://helpx.adobe.com/content/help/en/acrobat/using/touch-reading-order-tool-pdfs.html
https://helpx.adobe.com/content/help/en/acrobat/using/reading-pdfs-reflow-accessibility-features.html
https://helpx.adobe.com/content/help/en/acrobat/using/accessibility-features-pdfs.html
https://helpx.adobe.com/content/help/en/acrobat/using/creating-accessible-pdfs.html
https://helpx.adobe.com/content/help/en/acrobat/using/editing-document-structure-content-tags.html#standard_pdf_tags
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 Fix accessibility issues (Acrobat Pro DC)

To fix a failed check after running Full Check, right-click (Windows) or Ctrl-
click (Mac OS) the item in the Accessibility Checker panel. Choose one of the
 following options from the context menu:

Acrobat either fixes the item automatically, or displays a dialog box
 prompting you to fix the item manually.

Deselects this option in the Accessibility Checker Options dialog
 box for future checks of this document, and changes the item status to
 Skipped.

Opens the online Help  where you can get more details about the
 accessibility issue.

Runs the checker again on all items. Choose this option after
 modifying one or more items.

Displays a report with links to tips on how to repair failed
 checks.

Opens the Accessibility Checker Options dialog box, so you can
 select which checks are performed.

 Accessibility issues

 Document

 Prevent security settings from interfering with screen
 readers

A document author can specify that no part of an accessible PDF is to be
 copied, printed, extracted, commented on, or edited. This setting could
 interfere with a screen reader's ability to read the document, because screen
 readers must be able to copy or extract the document's text to convert it to
 speech.

This flag reports whether it's necessary to turn on the security settings that
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 allow accessibility.

To fix the rule automatically, select Accessibility Permission Flag on the

 Accessibility Checker panel. Then, choose Fix from the Options  menu.

Or, fix accessibility permissions manually:

1. Choose File > Properties > Security.

2. Choose No Security from the Security Method drop-down list.

3. Click OK and close the Document Properties dialog box.

If your assistive technology product is registered with Adobe as a Trusted
 Agent, you can read PDFs that might be inaccessible to another assistive
 technology product. Acrobat recognizes when a screen reader or other
 product is a Trusted Agent and overrides security settings that would typically
 limit access to the content for accessibility purposes. However, the security
 settings remain in effect for all other purposes, such as to prevent printing,
 copying, extracting, commenting, or editing text.

See the related WCAG section: 1.1.1 Non-text Content. (A), 4.1.2
 Name, role, value

 Image-only PDF

Reports whether the document contains non-text content that is not
 accessible. If the document appears to contain text, but doesn't contain fonts,
 it could be an image-only PDF file.

To fix this rule check automatically, select Image-only PDF on the Accessibility

 Checker panel, and choose Fix from the Options  menu.

Or, to fix this rule check manually, use OCR to recognize text in scanned
 images:

1. Choose Tools > Enhance Scans.

The Enhance Scans toolset is displayed in the secondary toolbar.

2. In the secondary toolbar, choose Recognize Text > In This File.

3. Select the pages you want to process, the document language, and then
click  Recognize Text.

See the related WCAG section: 1.1.1. Non-text content (A)

 Tagged PDF

If this rule check fails, the document isn't tagged to specify the correct reading

https://helpx.adobe.com/content/help/en/acrobat/using/create-verify-pdf-accessibility.html#main-pars_table_0
https://helpx.adobe.com/content/help/en/acrobat/using/create-verify-pdf-accessibility.html#main-pars_table_0
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Note:

 order.

To fix this item automatically, select Tagged PDF on the Accessibility Checker

 panel, and then choose Fix from the Options  menu. Acrobat automatically
 adds tags to the PDF.

To specify tags manually, do one of the following:

Enable tagging in the application in which the PDF was authored, and re-
create the PDF.
Choose Tools > Accessibility > Autotag Document in Acrobat DC. The
 Add Tags Report appears in the navigation pane if there are any issues.
 The report lists potential problems by page, provides a navigational link to
 each problem, and provides suggestions for fixing them.
Choose Tools > Accessibility > Reading Order in Acrobat DC, and create
 the tags tree. For more information, see Touch Up Reading Order tool
 overview.

Open the Tags  panel and create the tags tree manually. To display
 the Tags panel, choose View > Show/Hide > Navigation Panes > Tags.
 For more information, see Edit document structure with the Content and
 Tags panel.

See the related WCAG section: 1.3.1 Info and Relationships, 1.3.2,
 2.4.1, 2.4.4, 2.4.5, 2.4.6, 3.1.2, 3.3.2, 4.1.2 Name, role, value

 Logical reading order

Verify this rule check manually. Make sure that the reading order displayed in
 the Tags panel coincides with the logical reading order of the document.

 Document language

Setting the document language in a PDF enables some screen readers to
 switch to the appropriate language. This check determines whether the
 primary text language for the PDF is specified. If the check fails, set the
 language.

To set the language automatically, select Primary Language in the

 Accessibility Checker tab, and then choose Fix from the Options  menu.
 Choose a language in the Set Reading Language dialog box, and then click
 OK.

To set the language manually, do one of the following:

Choose File > Properties > Advanced and then select a language from the
 drop-down list in the Reading Options section. (If the language doesn't
 appear in the drop-down list, you can enter the ISO 639 code for the
 language in the Language field.) This setting applies the primary
 language for the entire PDF.

https://helpx.adobe.com/content/help/en/acrobat/using/touch-reading-order-tool-pdfs.html
https://helpx.adobe.com/content/help/en/acrobat/using/touch-reading-order-tool-pdfs.html
https://helpx.adobe.com/content/help/en/acrobat/using/touch-reading-order-tool-pdfs.html
https://helpx.adobe.com/content/help/en/acrobat/using/editing-document-structure-content-tags.html
https://helpx.adobe.com/content/help/en/acrobat/using/editing-document-structure-content-tags.html
https://helpx.adobe.com/content/help/en/acrobat/using/create-verify-pdf-accessibility.html#main-pars_table_0
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Set the language for all text in a subtree of the tags tree. Open the Tags 

 panel. Expand the Tags root and select an element. Then choose

 Properties from the Options  menu. Choose a language from the
 Language drop-down list. (To display the Tags panel, choose View >
 Show/Hide > Navigation Panes > Tags.)
Set the language for a block of text by selecting the text element or

 container element in the Content  panel. Then, right-click (Windows)
 or Ctrl-click (Mac OS) the text and choose Properties from the context
 menu and choose a language from the Language drop-down list. (To
 display the Content panel, choose View > Show/Hide > Navigation Panes
> Content.)

See the related WCAG section: Language of Page (Level A)

 Title

Reports whether there is a title in the Acrobat application title bar.

To fix the title automatically, select Title in the Accessibility Checker tab, and

 choose Fix from the Options  menu. Enter the document title in the
 Description dialog box (deselect Leave As Is, if necessary).

Or, fix the title manually:

1. Choose File > Properties > Description.

2. Enter a title in the Title text box.

3. Click Initial View, and then choose Document Title from the Show drop-
down list.

4. Click OK to close the Description dialog box.

See the related WCAG section: 2.4 Page Titled (Level A)

 Bookmarks

This check fails when the document has 21 or more pages, but doesn't have
 bookmarks that parallel the document structure.

To add bookmarks to the document, select Bookmarks on the Accessibility

 Checker panel, and choose Fix from the Options  menu. In the Structure
 Elements dialog box, select the elements that you want to use as bookmarks,
 and click OK. (You can also access the Structure Elements dialog box by
 clicking the Options menu on the Bookmark tab and selecting the New
 Bookmarks From Structure command.)

See the related WCAG sections: 2.4.1 Bypass Blocks (Level A), 2.4.5
 Multiple Ways (Level AA)
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 Color contrast

When this check fails, it's possible that the document contains content that
 isn't accessible to people who are color-blind.

To fix this issue, make sure that the document's content adheres to the
 guidelines outlined in WCAG section 1.4.3. Or, include a recommendation
 that the PDF viewer use high-contrast colors:

1. Choose Edit > Preferences (Windows) or Acrobat > Preferences (Mac
OS).

2. Click Accessibility.

3. Select Replace Document Colors, and then select Use High-Contrast
Colors. Choose the color combination that you want from the drop-down
list, and then click OK.

 Page content

 Tagged content

This check reports whether all content in the document is tagged. Make sure
 that all content in the document is either included in the Tags tree, or marked
 as an artifact.

Do one of the following to fix this rule check:

Open the Content  panel and right-click (Windows) or Ctrl-click (Mac
 OS) the content that you want to mark as an artifact. Then, select Create
 Artifact from the context menu. (To display the Content tab, choose View
> Show/Hide > Navigation Panes > Content.)

Tag the content by choosing Tools > Accessibility > Reading Order. Select
 the content, and then apply tags as necessary.

Assign tags using the Tags  panel. Right-click (Windows) or Ctrl-click
 (Mac OS) the element in the Tags tree, and choose Create Tag From
 Selection. Items such as comments, links, and annotations don't always
 appear in the Tags tree. To find these items, choose Find from the
 Options menu. (To display the Tags panel, choose View > Show/Hide >
 Navigation Panes > Tags.)

See the related WCAG sections: 1.1.1 Non-text content (A), 1.3.1 Info
 and Relationships (Level A), 1.3.2 Meaningful Sequence (Level A), 2.4.4 Link
 Purpose (In Context) (Level A), 3.1.2 Language of Parts (Level AA), 4.1.2
 Name, role, value

https://helpx.adobe.com/content/help/en/acrobat/using/create-verify-pdf-accessibility.html#main-pars_table_0
https://helpx.adobe.com/content/help/en/acrobat/using/create-verify-pdf-accessibility.html#main-pars_table_0


Create and verify PDF accessibility, Acrobat Pro DC

Note:

Note:

 Tagged annotations

This rule checks whether all annotations are tagged. Make sure that
 annotations such as comments and editorial marks (such as insert and
 highlight) are either included in the Tags tree or marked as artifacts.

Open the Content  panel, and right-click (Windows) or Ctrl-click (Mac
 OS) the content that you want to mark as an artifact. Then, select Create
 Artifact from the context menu. (To display the Content panel, choose
 View > Show/Hide > Navigation Panes > Content.)
Tag the content by choosing Tools > Accessibility > Reading Order. Select
 the content, and then apply tags as necessary.

Assign tags using the Tags  panel. (To display the Tags panel, choose
 View > Show/Hide > Navigation Panes > Tags.)

To have Acrobat DC assign tags automatically to annotations as they're
 created, choose Tag Annotations from the Options menu on the Tags panel.

See the related WCAG section: 1.3.1 Info and Relationships (Level A),
 4.1.2 Name, role, value

 Tab order

Because tabs are often used to navigate a PDF, it's necessary that the tab
 order parallels the document structure.

To fix the tab order automatically, select Tab Order on the Accessibility

 Checker panel, and choose Fix from the Options  menu.

To manually fix the tab order for links, form fields, comments, and other
 annotations:

1. Click the Page Thumbnails panel on the navigation pane.

2. Click a page thumbnail, and then choose Page Properties from the

Options  menu.

3. In the Page Properties dialog box, choose Tab Order. Then, select Use
Document Structure, and click OK.

4. Repeat these steps for all thumbnails in the document.

See the related WCAG section: 2.4.3, Focus Order (Level A)

 Character encoding

Specifying the encoding helps PDF viewers' present users with readable text.
 However, some character-encoding issues aren't repairable within Acrobat
DC.
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To ensure proper encoding, do the following:

Verify that the necessary fonts are installed on your system.
Use a different font (preferably OpenType) in the original document, and
 then re-create the PDF.
Re-create the PDF file with a newer version of Acrobat Distiller.
Use the latest Adobe Postscript driver to create the PostScript file, and
 then re-create the PDF.

The WCAG doesn't address Unicode character mapping.

 Tagged multimedia

This rule checks whether all multimedia objects are tagged. Make sure that
 content is either included in the Tags tree or marked as an artifact.

Open the Content  panel and right-click (Windows) or Ctrl-click (Mac OS)
 the content that you want to mark as an artifact. Then, select Create Artifact
 from the context menu. (To display the Content panel, choose View >
 Show/Hide > Navigation Panes > Content.)

Tag the content by choosing Tools > Accessibility > Reading Order. Select the
 content, and then apply tags as necessary.

Assign tags using the Tags  panel. Right-click (Windows) or Ctrl-click (Mac
 OS) the element in the Tags tree, and choose Create Tag From Selection.
 (To display the Tags panel, choose View > Show/Hide > Navigation Panes >
 Tags.)

See the related WCAG sections: 1.1.1 Non-text Content. (A), 1.2.1
 Audio- only and Video- only (Prerecorded). (A), 1.2.2 Captions (Prerecorded).
 (A), 1.2.3 Audio Description or Media Alternative (Prerecorded). (A), 1.2.5
 Audio Description (Prerecorded). (AA)

 Screen flicker

Elements that make the screen flicker, such as animations and scripts, can
 cause seizures in individuals who have photosensitive epilepsy. These
 elements can also be difficult to see when the screen is magnified.

If the Screen Flicker rule fails, manually remove or modify the script or content
 that causes screen flicker.

See these related WCAG sections: 1.1.1 Non-text Content. (A), 1.2.1
 Audio- only and Video- only (Prerecorded). (A), 1.2.2 Captions (Prerecorded).
 (A), 1.2.3 Audio Description or Media Alternative (Prerecorded). (A), 2.3.1
 Three Flashes or Below Threshold. (Level A)

 Scripts
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Content cannot be script-dependent unless both content and functionality are
 accessible to assistive technologies. Make sure that scripting doesn't interfere
 with keyboard navigation or prevent the use of any input device.

Check the scripts manually. Remove or modify any script or content that
 compromises accessibility.

See these related WCAG sections: 1.1.1 Non-text Content. (A), 2.2.2
 Pause, Stop, Hide. (Level A), 4.1.2 Name, role, value

 Timed responses

This rule check applies to documents that contain forms with JavaScript. If the
 rule check fails, make sure that the page does not require timed responses.
 Edit or remove scripts that impose timely user response so that users have
 enough time to read and use the content.

See the related WCAG section: 2.2.1 Timing Adjustable. (Level A)

 Accessible links

For URLs to be accessible to screen readers, they must be active links that
 are correctly tagged in the PDF. (The best way to create accessible links is
 with the Create Link command, which adds all three links that screen readers
 require to recognize a link.) Make sure that navigation links are not repetitive
 and that there is a way for users to skip over repetitive links.

If this rule check fails, check navigation links manually and verify that the
 content does not have too many identical links. Also, provide a way for users
 to skip over items that appear multiple times. For example, if the same links
 appear on each page of the document, also include a "Skip navigation" link.

See the related WCAG section: 2.4.1 Bypass Blocks. (Level A)

 Forms

 Tagged form fields

In an accessible PDF, all form fields are tagged and are a part of the
 document structure. In addition, you can use the tool tip form filed property to
 provide the user with information or to provide instructions.

To tag form fields, choose Tools > Accessibility > Autotag Form Fields.

See the related WCAG sections: 1.3.1 Info and Relationships. (Level
 A), 4.1.2 Name, role, value

https://helpx.adobe.com/content/help/en/acrobat/using/create-verify-pdf-accessibility.html#main-pars_table_0
https://helpx.adobe.com/content/help/en/acrobat/using/create-verify-pdf-accessibility.html#main-pars_table_0
https://helpx.adobe.com/content/help/en/acrobat/using/create-verify-pdf-accessibility.html#main-pars_table_0
https://helpx.adobe.com/content/help/en/acrobat/using/create-verify-pdf-accessibility.html#main-pars_table_0


Create and verify PDF accessibility, Acrobat Pro DC

Note:

Note:

 Field descriptions

For accessibility, all form fields need a text description (tool tip).

To add a text description to a form field:

1. Select one of the Form tools, and then right-click (Windows) or Ctrl-click
(Mac OS) the form field.

2. Choose Properties from the context menu.
3. Click the General properties tab.
4. Enter a description of the form field in the Tooltip field.

See the related WCAG sections: 1.3.1 Info and Relationships. (Level
 A), 3.3.2 Labels or Instructions (Level A), 4.1.2 Name, role, value

 Alternate text

 Figures alternate text

Make sure that images in the document either have alternate text or are
 marked as artifacts.

If this rule check fails, do one of the following:

Select Figures Alternate Text in the Accessibility Checker panel, and

 choose Fix from the Options  menu. Add alternate text as prompted in
 the Set Alternate Text dialog box.
Use the Tags panel to add alternate text for images in the PDF.

Open the Content  panel and right-click (Windows) or Ctrl-click (Mac
 OS) the content that you want to mark as an artifact. Then, select Create
 Artifact from the context menu. (To display the Content panel, choose
 View > Show/Hide > Navigation Panes > Content.)

See the related WCAG section: 1.1.1 Non-text Content. (A)

 Nested alternate text

Screen readers don't read the alternate text for nested elements. Therefore,
 don't apply alternate text to nested elements.

To remove alternate text from nested elements, do the following:

1. Choose View > Show/Hide > Navigation Panes > Tags.
2. Right-click (Windows) or Ctrl-click (Mac OS) a nested element in the
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 Tags panel and choose Properties from the context menu.
3. Remove both the Alternate Text and the text to which it's applied from

the Object Properties dialog box, and then click Close.

See the related WCAG section: #1.1.1 Non-text Content. (A)

 Associated with content

Make sure that alternate text is always an alternate representation for content
 on the page. If an element has alternate text, but does not contain any page
 content, there is no way to determine which page it is on. If the Screen
 Reader Option in the Reading preferences is not set to read the entire
 document, then screen readers never read the alternate text.

1. Right-click (Windows) or Ctrl-click (Mac OS) an item to check.

2. Open it in the Tags  panel. (To display the Tags panel, choose View >
 Show/Hide > Navigation Panes > Tags.)

3. Remove the Alternate Text from the Tags panel for any nested item that
has no page content.

See the related WCAG section: 1.1.1 Non-text Content. (A)

 Hides annotation

Alternate text can't hide an annotation. If an annotation is nested under a
 parent element with alternate text, then screen readers don't see it.

To remove alternate text from nested elements:

1. Choose View > Show/Hide > Navigation Panes > Tags.
2. Right-click (Windows) or Ctrl-click (Mac OS) a nested element in the

Tags panel and choose Properties from the context menu.
3. Remove the alternate text from the Object Properties dialog box, and

then click OK.

See the related WCAG sections: 1.3.1 Info and Relationships. (Level
 A), 4.1.2 Name, role, value

 Other elements alternate text

This report checks for content, other than figures, that requires alternate text
 (such as multimedia, annotation, or 3D model). Make sure that alternate text
 is always an alternate representation for content on the page. If an element
 has alternate text but does not contain any page content, there is no way to
 determine which page it is on. If the Screen Reader Options in the Reading
 preferences is not set to read the entire document, then screen readers don't
 read the alternate text.
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1. Choose View > Show/Hide > Navigation Panes > Tags.
2. Right-click (Windows) or Ctrl-click (Mac OS) a nested element in the

Tags  panel and choose Properties from the context menu.
3. Remove the alternate text from the Object Properties dialog box, and

then click OK.

See the related WCAG section: 1.1.1 Non-text Content. (A)

 Tables

Because table structure can be complex, it is best practice to check them for
 accessibility manually.

 Rows

This rule checks whether each TR in a table is a child of Table, THead,
 TBody, or TFoot.

See Correct table tags with the Tags panel.

Related WCAG section: 1.3.1 Info and Relationships. (Level A)

 TH and TD

In a proper table structure, TH and TD are children of TR.

See Correct table tags with the Tags panel.

See related WCAG section: #1.3.1 Info and Relationships. (Level A)

 Headers

For accessibility, it's necessary that all tables in the PDF have a header.

See Correct table tags with the Tags panel.

See the related WCAG section: 1.3.1 Info and Relationships. (Level A)

 Regularity

To be accessible, tables must contain the same number of columns in each
 row, and rows in each column.
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See Correct table tags with the Tags panel.

See the related WCAG section: 1.3.1 Info and Relationships. (Level A)

 Summary

Table summaries are optional, but can improve accessibility.

1. Choose Tools > Accessibility > Reading Order.
2. Select the table by drawing a rectangle around it.
3. In the Touch UP Reading Order dialog box, click Table.
4. Right-click (Windows) or Ctrl-click (Mac OS) Table.
5. Click Edit Table Summary.
6. Enter a summary and click OK.

See the related WCAG section: 1.3.1 Info and Relationships. (Level A)

 Lists

 List items

The check reports whether each List Item (LI) is a child of List (L). When this
 rule check fails, the structure of this list is incorrect. Lists must have the
 following structure: A List element must contain List Item Elements. And, List
 Item Elements can only contain Label Elements and List Item Body Elements.

To fix the list structure:

1. Find the list in the Accessibility Checker panel by right-clicking
(Windows) or Ctrl-clicking (Mac OS) the failed element and choosing
Show In Tags Panel.

2. Create elements, change the types of elements, or rearrange existing
elements by dragging them.

See the related WCAG section: 1.3.1 Info and Relationships. (Level A)

 Lbl and LBody

Lists must have the following structure: A List element must contain List Item
 Elements. And, List Item Elements can only contain Label Elements and List
 Item Body Elements. When this rule check fails, the structure of this list is
 incorrect.

To fix the list structure:

1. Find the list in the Accessibility Checker panel by right-clicking
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 (Windows) or Ctrl-clicking (Mac OS) the failed element and choosing
 Show In Tags Panel.

2. Create elements, change the types of elements, or rearrange existing
elements by dragging them.

See the related WCAG section: 1.3.1 Info and Relationships. (Level A)

 Headings

 Appropriate nesting

This rule checks nested headings. When this check fails, headings are not
 nested properly.

To fix the list structure:

1. Find the list in the Accessibility Checker panel by right-clicking (Windows)
or Ctrl-clicking (Mac OS) the failed element and choosing Show in Tags
Panel.

2. Create elements, change the types of elements, or rearrange existing
elements by dragging them.

See the related WCAG section: 2.4.6 Headings and Labels. (Level
 AA). The order of headings is not required under WCAG, and is only an
 advisory technique.
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Real Connections: Making Distance Learning  
Accessible to Everyone

Distance learning has been around for 
a long time. For years instructors have 
taught students across great distances via 
correspondence courses using printed 
materials. The early days of television 
witnessed the introduction of televised 
courses. Today, an instructor can 
videoconference with several classrooms 
full of students. Early online courses using 
email were rapidly followed by web-based 
instruction. Today, the lines are blurred 
between different types of distance learning 
courses as multiple modes of delivery are 
employed in a single course. For example, 
a class “library” could be a website; class 
discussions could take place using a message 
board; some course content could be 
delivered using online materials and videos.

Access to more students is a common reason 
given for providing instruction in a distance 
learning format. However, these access 
arguments usually focus on people separated 
by distance and time and often do not 
include consideration of the needs of people 
with disabilities. In fact, the design of many 
distance learning courses erects barriers to the 
full participation of students and instructors 
with some types of disabilities.

Ensuring that individuals with disabilities can 
participate in distance learning courses can 
be argued on ethical grounds. Many people 
simply consider it to be the right thing to do. 
Others are more responsive to legal mandates. 
The Americans with Disabilities Act (ADA) 
of 1990 and its 2008 amendments mandate 
that no otherwise qualified individuals 
shall, solely by reason of their disabilities, be 
excluded from participation in, be denied the 
benefits of, or be subjected to discrimination 

in public programs. The ADA applies to 
Internet-based programs and services. Clearly, 
distance learning programs must make their 
offerings available to people with disabilities 
who are eligible to take a class.

The following paragraphs discuss access 
issues and present design considerations 
for ensuring that a course is accessible to 
potential instructors and students with a 
range of abilities and disabilities. The field of 
universal design provides a framework for 
this discussion. 

Access Barriers
Thousands of specialized hardware and 
software products available today allow 
individuals with a wide range of abilities and 
disabilities to productively use computing 
and networking technologies. If a prerequisite 
to a course is Internet access, administrators 
and instructors can assume that any student 
enrolled will have access to the assistive 
technology they require. However, assistive 
technology alone does not remove all access 
barriers. Described below are examples of 
access challenges in distance learning courses 
faced by students and instructors who have 
access to assistive technology.

Blindness
A student or instructor who is blind may use 
a computer equipped with text-to-speech 
software. Basically, this system reads, with 
a synthesized voice, whatever text appears 
on the screen. He cannot interpret graphics 
(including photographs, drawings, and image 
maps) unless text descriptions are provided. 
Printed materials, videos, presentations, 
and other visual materials also create access 
challenges for him. These barriers can be 
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overcome with alternate media such as 
accessible electronic text, and text-based 
descriptions.

Other Visual Impairments
A student or instructor who has limited vision 
can use special software to enlarge screen 
images. He may see only a small portion of 
a web page at a time. Consequently, he can 
easily become confused when web pages 
are cluttered and when layouts change from 
page to page. Standard printed materials may 
also be inaccessible to him; he may require 
large print or electronic text that his system 
can enlarge for him. Individuals who are 
colorblind cannot successfully navigate web 
pages that require the user to distinguish 
some color combinations.

Specific Learning Disabilities
Some specific learning disabilities impact the 
ability to read, write, or process information. 
A student with a learning disability may 
use a speech output or screen enlargement 
system similar to those used by people with 
visual impairments. She may have difficulty 
understanding websites when the information 
is cluttered and when the screen layout 
changes from one page to the next. 

Mobility Impairments
A student or instructor with a mobility 
impairment who cannot move his hands 
may use an alternative keyboard or speech 
input to gain access to online course materials 
and communication tools. Another student 
or instructor may be able to use standard 
input devices, but lack the fine motor skills 
required to select small buttons on the screen. 
If his input method is slow, a person with 
a mobility impairment may not be able 
to effectively participate in synchronous 

(real-time) communications. If any place-
bound meetings are required in a distance 
learning course, a participant with a mobility 
impairment may require that the location be 
wheelchair-accessible. 

Hearing Impairments
Most Internet resources are accessible to 
people with hearing impairments because 
these resources do not require the ability to 
hear. However, when websites include audio 
output without providing text captioning or 
transcription, a student who is deaf is denied 
access to the information. Course videos 
that are not captioned are inaccessible to this 
student. He may also be unable to participate 
in a telephone conference or videoconference 
unless accommodations (e.g., sign language 
interpreters) are provided for that part of a 
distance learning course.

Speech Impairments 
A student with a speech impairment may not 
be able to effectively participate in interactive 
telephone conferences or videoconferences. 
However, modes of participation that do not 
require the ability to speak, such as email, are 
fully accessible.

Seizure Disorders
Attention-grabbing flickers, at certain rates 
(typically between 2 to 55 hertz), can induce 
seizures for people who are susceptible to 
them. They should be avoided.

Universal Design
The design of a distance learning class can 
impact the participation of students and 
instructors with visual, hearing, mobility, 
speech, and learning disabilities. Planning 
for access as the course is being developed 
is much easier than creating accommodation 
strategies once a person with a disability 
enrolls in the course or applies to teach it.  
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Universal design (UD) is defined by the 
Center for Universal Design (CUD) at North 
Carolina State University as “the design of 
products and environments to be usable by 
all people, to the greatest extent possible, 
without the need for adaptation or specialized 
design” (http://www.ncsu.edu/ncsu/design/cud/). 
At the CUD, a group of product developers, 
architects, environmental designers, and 
engineers established a set of principles of 
universal design to apply in the design of 
products, environments, and communication 
and other electronic systems. General 
principles include the following: the design 
is useful to people with diverse abilities; 
and the design accommodates a wide range 
of individual preferences and abilities; the 
design communicates necessary information 
effectively to the user, regardless of ambient 
conditions or the user’s sensory abilities. 

UD principles and strategies have been 
applied to libraries and other educational 
products and environments. Consult The 
Center of Universal Design in Education (CUDE) 
at the University of Washington (www.uw.edu/
doit/CUDE/) for detailed information about 
UD.

When UD principles are applied, products 
meet the needs of potential users with a 
variety of characteristics. Disability is just one 
of many characteristics that an individual 
might possess. Others include height, age, 
race, native language, ethnicity, and gender. 
All potential characteristics of participants 
should be considered when developing a 
distance learning course. Just as modern 
sidewalks and buildings are designed to be 
used by everyone, distance learning designers 
should create learning environments that 
allow all potential students and instructors to 
fully participate. 

The next sections of this publication provide 
examples of strategies for making distance 
learning courses welcoming, accessible, 
and usable to everyone. Be sure to include a 
statement on all promotional materials about 
how to obtain materials in alternate format 
and other disability-related accommodations.

On-Site Instruction
The interactive video sessions, proctored 
examinations, and retreats for students in 
some distance learning courses require place-
bound meetings. In these cases, the facility 
should be wheelchair accessible. The furniture 
should be flexible enough to accommodate 
wheelchair-users and accessible restrooms 
and parking should be available nearby. 
Standard disability-related accommodations, 
such as sign language interpreters, should be 
provided when requested. Instructors should 
speak clearly; face students when speaking 
to facilitate lipreading; and read aloud and 
describe text and other visual materials for 
those who cannot see them. 

http://www.ncsu.edu/ncsu/design/cud/
http://www.uw.edu/doit/CUDE/
http://www.uw.edu/doit/CUDE/
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Internet-Based Communication
Some distance learning programs employ 
real-time communication in their courses. 
In this case, students communicate 
synchronously (at the same time), as 
compared to asynchronously (not necessarily 
at the same time). Besides providing 
scheduling challenges, synchronous 
communication is difficult or impossible for 
someone who cannot communicate quickly. 
For example, someone with a learning 
disability who takes a long time to compose 
her thoughts or someone whose input method 
is slow may not be fully included in the 
discussion. In addition, some synchronous 
software erects barriers for individuals 
who are blind. Instructors who choose to 
use synchronous tools should plan for an 
alternate method of communication (e.g., 
email) when not all students in a group can 
fully participate using thr synchronous tool.

Text-based, asynchronous tools such as 
email, message boards, and email-based 
lists generally erect no special barriers for 
students with disabilities. If a prerequisite to a 
course is for students to have access to email, 
the instructor can assume that participants 
with disabilities already have an accessible 
email program to use. Email communication 
between individual students, course 
administration staff, the instructor, guest 
speakers, and other students is accessible to 
all parties, regardless of disability. 

Web Pages
Applying UD principles makes web pages 
accessible to individuals with a wide range 
of disabilities. Guidelines for making web 
pages accessible have been developed by 
the Web Accessibility Initiative (WAI) of the 
World Wide Web Consortium (W3C). W3C, 
an industry group that was founded in 1994 
to develop common protocols that enhance 
interoperability and guide the evolution of the 

web, is committed to ensuring that the World 
Wide Web is fully accessible to people with 
disabilities. 

There are basically two approaches for 
making web page content and navigation 
accessible. Certain types of inaccessible data 
and features need to be avoided or alternative 
methods need to be provided for carrying out 
the function or accessing the content provided 
through an inaccessible feature or format. 
For example, an online learning designer can 
avoid using a graphic that is inaccessible to 
individuals who are blind, or can create a text 
description of the content that is accessible to 
text-to-speech software. 

Web pages for a distance learning class should 
be tested with a variety of monitors, computer 
platforms, and a web browser with the 
graphics and sound-loading features turned 
off (to simulate the experiences of people with 
sensory impairments). Testing to see if all 
functions at a website can be accessed using 
a keyboard alone is also a good accessibility 
test.

Course designers using learning management 
systems (LMSs; such as Blackboard, eCollege, 
and Canvas) can employ product accessibility 
tools to create accessible courses. 

Documents
Students who are blind or who have specific 
learning disabilities that affect their ability to 
read may require that printed and electronic 
documents (e.g., PDF, Word, PowerPoint) be 
available in accessible formats. Making the 
content of materials available in an accessible 
web-based format (HTML) may provide the 
best solution for students. Otherwise, consult 
resources to make specific files accessible. 
Prepare to make them in text-based formats 
with structured headings and the content of 
images described in alternative text.
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Videoconference
Ideally, whenever a video presentation is 
used in a distance learning course, captioning 
should be provided for those who have 
hearing impairments and audio description 
(that describes aurally the visual content) 
should be provided for those who are blind. 
If a video publisher does not make these 
options available, the distance learning 
program should have a system in place to 
accommodate students who have sensory 
impairments. For example, the institution 
could hire someone local to the student to 
describe the visual material to a blind student 
or to sign audio material for a student who 
is deaf. Real-time captioning (developed 
at the time of the presentation) or sign 
language interpreting should be provided 
for videoconferences when requested by 
participants who are deaf. 

Teleconference
Sometimes, online courses include 
teleconferencing opportunities for discussion 
in small groups. This mode of communication 
creates scheduling challenges for everyone. 
It is also inaccessible to a student who is 
deaf. Instructors who use teleconferencing 
for small group discussions should allow 
alternative communication (e.g., email) 

that is accessible to everyone in a specific 
group. Or, a student who is deaf might 
be able to participate in a teleconference 
by using the Telecommunications Relay 
Service (TRS), where an operator types 
what the speaker says for a student who 
is deaf to view on his text telephone (TTY) 
and translates his printed input into speech. 
However, this system might be too slow to 
allow participation in lively conversations. 
Another accommodation approach involves 
setting up a private chat room on the web. 
A transcriptionist types the conversation for 
the student who is deaf to view. The student 
can also type his contributions into the chat 
room and they can be voiced by someone in 
the group who is monitoring the chat room. 
Various options should be discussed with the 
student who needs an accommodation.

Benefits of Accessible Design for 
People without Disabilities 
People without disabilities may have 
temporary or situational constraints that are 
similar to those imposed by disabilities. For 
example, people who cannot access graphics 
due to computer system limitations are in a 
similar situation as students who are blind. 
A noisy environment that prohibits the use 
of audio features imposes constraints similar 
to those faced by students with hearing 
impairments. Those for whom English 
is a second language experience reading 
difficulties similar to those experienced 
by people with some types of learning 
disabilities. People who need to operate a 
computer but whose hands are occupied with 
other activities face challenges similar to those 
who use a hands-free input method because 
of a disability.

Applying UD principles assists both people 
with and people without disabilities. For 
example, using clear and simple language 
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and navigational mechanisms on web 
pages facilitates use by those whose native 
language is not the one in which the course 
is taught, as well as people with visual and 
learning disabilities. People who have turned 
off support for images on their browsers in 
order to maximize access speed, benefit when 
multimedia features provide text alternatives 
for the content, as do people who are blind 
and those who wish to use search tools to 
locate specific content. Similarly, people who 
cannot view the screen because they must 
attend to other tasks benefit from text-to-
speech systems used by people who are blind. 
Captions provided on video assist people 
who work in noisy or noiseless surroundings, 
people for whom English is a second 
language, and people who have hearing 
impairments. Making sure that information 
conveyed with color is also available without 
color benefits those using monochrome 
monitors as well as those who are colorblind. 
Providing multiple formats of information 
also addresses differences in learning styles. 

Getting Started
Distance learning programs should be 
proactive in making their courses accessible. 
Rather than wait until someone with a 
disability enrolls in a course to address 
accessibility issues, they should consider 
them as they plan the course. To get started, 
program staff can
• think about the wide range of abilities and 

disabilities potential students might have
• include information in promotional 

publications on how to request 
accommodations

• arrange wheelchair-accessible facilities for 
on-site instruction

• make sure media can be accessed using 
sight or hearing alone, and online content 
can be accessed with a keyboard alone

• adopt and enforce accessibility standards
• provide information about standards, 

training, and support to instructors and 
design staff

• use the accessibility features of an LMS
• periodically review and update standards, 

procedures, and support issues

For a list of ten indicators for accessible 
distance learning programs consult the 
publication Equal Access: Universal Design of 
Distance Learning Programs at www.uw.edu/doit/
equal-access-universal-design-distance-learning-
programs.

Conclusion
Distance learning courses are designed to 
reach out to students from anywhere. If UD 
principles are used in creating these classes, 
they will be accessible to any students who 
enroll in them and any instructors who are 
hired to teach them. Designed correctly, 
distance learning options create learning 
opportunities for students with a broad range 
of abilities and disabilities. Designed poorly, 
they erect new barriers to equal participation 
in academics and careers. UD can bring 
us closer to making learning accessible to 
anyone, anywhere, at any time.

http://www.washington.edu/doit/equal-access-universal-design-distance-learning-programs
http://www.washington.edu/doit/equal-access-universal-design-distance-learning-programs
http://www.washington.edu/doit/equal-access-universal-design-distance-learning-programs


7

Video
A short video presentation, Real Connections: 
Making Distance Learning Accessible 
to Everyone, demonstrates key points 
summarized in this publication. It may 
be freely viewed online at www.uw.edu/
doit/videos/index.php?vid=22 or purchased 
in DVD format. Permission is granted to 
reproduce DO-IT videos and publications for 
educational, noncommercial purposes as long 
as the source is acknowledged.

Additional Resources
The following resources are useful to those 
who wish to research this topic further. 

AccessDL (The Center on Accessible Distance 
Learning) 
www.uw.edu/doit/programs/accessdl

Americans with Disabilities Act of 1990  
www.ada.gov/pubs/ada.htm

CAST (Center for Applied Special 
Technology) 
www.cast.org

The Center for Universal Design 
www.ncsu.edu/ncsu/design/cud/

The Center for Universal Design in Education 
www.uw.edu/doit/programs/center-universal-
design-education/overview

Closing the Gap Resource Directory 
www.closingthegap.com

Creating Video and Multimedia Products 
that are Accessible to People with Sensory 
Impairments 
www.uw.edu/doit/creating-video-and-multimedia-
products-are-accessible-people-sensory-
impairments

EASI (Equal Access to Software and 
Information) 
easi.cc

Equal Access: Universal Design of Distance 
Learning Programs 
www.uw.edu/doit/equal-access-universal-design-
distance-learning-programs

IMS Guidelines for Developing Accessible 
Learning Applications 
www.imsglobal.org/accessibility/accessiblevers/
index.html

SNOW (Special Needs Ontario Window) 
snow.idrc.ocad.ca/

Trace Center 
www.trace.wisc.edu

W3C, Web Content Accessibility Guidelines 
2.0 
www.w3.org/TR/WCAG20/

WebAIM—Web Accessibility in Mind 
www.webaim.org

http://www.uw.edu/doit/videos/index.php?vid=22
http://www.uw.edu/doit/videos/index.php?vid=22
http://www.uw.edu/doit/programs/accessdl
http://www.ada.gov/pubs/ada.htm
http://www.cast.org/
www.ncsu.edu/ncsu/design/cud/
http://www.ncsu.edu/ncsu/design/cud/
http://www.uw.edu/doit/programs/center-universal-design-education/overview
http://www.uw.edu/doit/programs/center-universal-design-education/overview
http://www.closingthegap.com/
http://www.uw.edu/doit/creating-video-and-multimedia-products-are-accessible-people-sensory-impairments
http://www.uw.edu/doit/creating-video-and-multimedia-products-are-accessible-people-sensory-impairments
http://www.uw.edu/doit/creating-video-and-multimedia-products-are-accessible-people-sensory-impairments
http://easi.cc/
http://www.uw.edu/doit/equal-access-universal-design-distance-learning-programs
http://www.uw.edu/doit/equal-access-universal-design-distance-learning-programs
http://www.imsglobal.org/accessibility/accessiblevers/index.html
http://www.imsglobal.org/accessibility/accessiblevers/index.html
http://snow.idrc.ocad.ca/
http://www.trace.wisc.edu/
http://www.w3.org/TR/WCAG20/
http://www.webaim.org/
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Accessibility Features

The goal of Blackboard Learn is to provide an accessible platform for
 sudents and insructors for equal access to online courses. Insructors
 have some responsibility to make their course content accessible.
 Students need to ask for accommodations if they need them. Find out
 how you can create and participate in inclusive learning experiences
 by using the accessibility features in Blackboard Learn.

Blackboard is fully committed to ensuring that our platform contains no
 barriers for users with disabilities and is both usable and accessible by everyone, regardless of age, ability, or
 situation. Blackboard measures and evaluates accessibility levels using two sets of sandards: Section 508 of
 the Rehabilitation Act issued from the United States federal government and the Web Content Accessibility
 Guidelines (WCAG 2.0) issued by the World Wide Web Consortium (W3C).

Design Accessible Content
The following lis includes the top fve things you need to know about designing accessible content:

1. If you are adding images to your content, you mus defne alternative (alt) text for them. Alt text should be
simple and succinct, and describe exactly what the image is. Example alt="photograph of a Cell 
Dividing." If an image is a diagram that conveys more complicated information, a long description or  
textual format of the material is required.

2. If you are adding video or other multi-media content to your course, you mus include descriptive captions for
the content to ensure users with hearing impairments can consume it. To learn more, see Bes Practice:
Captioning Video Content.

The linked resources are available in English only.

Related content

Learn Accessibility Conformance
 Statement

 Help   English (US)

 Accessibility Home 

https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility/Best_Practice_Captioning_Video_Content
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility/Best_Practice_Captioning_Video_Content
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Administrator/030_Accessibility/Learn_Accessibility_Conformance_Statement
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Administrator/030_Accessibility/Learn_Accessibility_Conformance_Statement
https://en-us.help.blackboard.com/
https://en-us.help.blackboard.com/@api/deki/pages/4098/pdf?stylesheet=default
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility
https://en-us.help.blackboard.com/
https://en-us.help.blackboard.com/
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3. One of the top complaints from sudents with visual impairments is the inability to consume attached fles.
Format attached documents with appropriate headings to ensure they can be properly consumed by screen
readers. When creating your documents, use the Formatting and Style options available in Microsoft Ofce,
Adobe, or other word processing tools to defne appropriate headings and liss.

4. Properly tag attached PDF fles to ensure their sructures can be read by screen readers. Simple methods for
"print" or "save" to PDF create a single image of the fle. While the document looks like it is properly
sructured, the screen reader is not able to interact with or read any of the material. To learn more about
making accessible PDF documents, see Meet PDF Accessibility Standards on the Adobe Acrobat website.

5. Be sure that you provide your sudents with clear expectations, insructions, and directions for all assignments
and tess. Students with cognitive impairments or learning disabilities can have trouble focusing on even
simple tasks. Clear directions and undersandable expectations can help them focus, making them much
more likely to succeed.

Using Blackboard With a Hearing Impairment
While the Blackboard Learn product does not auto-caption media fles, it does provide full support for captions in
 all media types that you can upload or view within your course content. With some forethought, you can even
 caption the videos you add with Browse My YouTube Videos (Video Everywhere) . To learn more, see Bes
 Practice: Captioning Video Content.

Using Blackboard With a Visual Impairment
The following lis includes the top fve things to know about using Blackboard with a visual impairment:

1. Blackboard Learn is developed agains the W3C Web Content Accessibility Guidelines to ensure its
compatibility with the lates versions of assisive technology including screen readers such as JAWS and
VoiceOver.

2. Pages in Blackboard Learn follow a common sructure to ensure familiarity as you navigate through the
sysem. A combination of headings and ARIA landmarks are used to defne the sructure of the page.
Features such as the global navigation menu and Quick Links can help with faser, more efcient navigation.
All keyboard navigation follows commonly used web navigation models.

3. The Quick Links feature goes beyond traditional skip links, allowing you to jump directly to any heading or
ARIA landmark on the current page. You can open Quick Links with a keyboard shortcut (Shift+Alt+L) from
anywhere in a page so that it's always easy to move around.

4. Alt tags are used to identify all images used within Blackboard Learn. When insructors are building course
content, they are prompted to add alt text to images they upload, as well to ensure visual information is
available to all users.

5. If you have defned high contras settings on your computer, you can enable high contras syles on the login
page of Blackboard Learn. Doing so will inform the sysem to respect your operating sysem selections to
ensure the bes visual experience based on your personal needs.

http://www.adobe.com/products/acrobat/pdf-accessibility-wcag-508-compliance-standards.html
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Student/040_In_Your_Course/020_Content_Editor/Video_Everywhere
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility/Best_Practice_Captioning_Video_Content
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility/Best_Practice_Captioning_Video_Content
http://www.w3.org/TR/WCAG/
http://www.freedomscientific.com/products/fs/jaws-product-page.asp
http://www.apple.com/accessibility/osx/voiceover/
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Student/030_Nav_My_Blackboard#global_nav
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility/010_Quick_Links
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility/010_Quick_Links
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Using Blackboard With a Mobility Impairment
The following lis includes the top fve things to know about using Blackboard with a mobility impairment:

1. Keyboard navigation throughout the Blackboard Learn sysem follows common web navigation models to
ensure consisency and familiarity with other web-based experiences.

2. Quick links will aggregate up a lis of all the headings and landmarks on the page. This allows you to quickly
fnd and navigate to elements in the middle of the page. You can open Quick Links with a keyboard shortcut
(Shift+Alt+L) from anywhere in the page so that it's always easy to move around.

3. Keyboard shortcuts are available for a variety of tools in Blackboard Learn to increase efciency for keyboard
users. Keyboard shortcuts are specifc to the current page or tool in use. Discover them by opening the Quick
Links tool (Shift+Alt+L). To learn more, see Keyboard Shortcuts for the Content Editor.

4. Located on every page where you can reorder items using drag-and-drop function, the keyboard accessible
reordering tool displays the items on the page as a lis. You can use keyboard commands to reorder the
items. To learn more, see Keyboard Accessible Reordering.

Using Blackboard With a Learning Disability
The following lis includes the top fve things to know about using Blackboard with a learning disability:

1. When you are in a course, you can collapse the course menu to reduce the clutter on the page and help you
focus on the task at hand. Bring the menu back at any time by holding your mouse on the left of the screen
and clicking the bar that appears. This control is also accessible with a keyboard.

2. Menu options, buttons, and controls that are not always needed only appear when the items they relate to
receive focus from either the mouse or keyboard. This helps reduce the visual noise on the page and ensures
access to the menus as soon as you need them.

3. Activity counters within the global navigation menu and My Blackboard tools can alert you to new items or
information requiring your attention. As you review these items, the counters are cleared so that you are
always aware of what is new or has changed since you las accessed the sysem.

4. If your sysem is enabled, you can set up individual notifcations for new content, due dates, discussion poss,
and other items within Blackboard Learn to alert you to information even when you are not logged into the
sysem. These notifcations are sent to you by email, shown in My Blackboard updates, or the Notifcations
Dashboard. If Blackboard Connect is insalled, you can receive alerts by text message.

5. The Blackboard Learn sysem allows insructors to set up accommodations for tess based on individual
needs. If you require more time, more attempts, diferent display options, or an alternative tesing location,
contact your insructor.

Accessibility Features in Blackboard Learn

https://en-us.help.blackboard.com/Learn/9.1_2014_04/Student/040_In_Your_Course/020_Content_Editor#keyboard_shortcuts
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/090_Course_Content/010_Create_Content/060_Edit_and_Manage_Course_Areas_and_Content#keyboard_accessible
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Student/030_Nav_My_Blackboard#global_nav
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As a sudent or an insructor, awareness and use of these features and tools creates an accessible environment
 for success.

My Blackboard
My Blackboard aggregates information from across the Blackboard Learn sysem and focuses on the individual
 user. From a single place, users can get a quick overview of everything related to various tools and courses, as
 well as their academic or insitutional network and community. This allows users to respond, review, and directly
 interact with the information presented there. Activity counters quickly call attention to items requiring a user's
 attention since he las accessed My Blackboard. Having a single place to go can simplify the overall experience
 for sudents with disabilities and help them feel more focused on the tasks they need to complete. Students can
 get an overview of outsanding information before diving into the details of their courses.

To learn more, see My Blackboard and Navigation.

Global Navigation
The global navigation menu refers to the set of links that appears at the top of the Blackboard Learn interface. To
 access it, click your name or use a keyboard shortcut. This menu provides a consisent, quick, and easy way to
 fnd information. You can also navigate to tools like My Blackboard, your courses, and even some personal
 settings from anywhere in the sysem.

Adaptive Release
With adaptive release, insructors can create individualized learning paths for sudents. Adaptive release controls
 the release of content to sudents based on a set of rules an insructor creates. The rules may be related to
 availability, date and time, individual users, group membership, scores or attempts on any Grade Center item,
 calculated columns in the Grade Center, or review satus of an item in the course. Insructors can use adaptive
 release to target alternative content formats or additional materials directly to the sudents who need them.

To learn more, see Release Content.

Quick Links
Located in the top left of the interface, the Quick Links icon opens a lis of all the ARIA landmarks, as well as an
 outline of all content headings on the page you are viewing. Any available keyboard shortcuts for the current tool
 or page also appear. You can quickly locate any heading or section within any page in the Blackboard Learn

https://en-us.help.blackboard.com/Learn/9.1_2014_04/Student/030_Nav_My_Blackboard
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Student/030_Nav_My_Blackboard#global_nav
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/090_Course_Content/030_Release_Content


Accessibility Features - Blackboard Help

 application and jump directly to it. Quick Links is specifc to the page you are viewing. You can open it at any
 time with a keyboard shortcut (Shift+Alt+L). This shortcut provides a signifcant increase in efciency for users
 who rely primarily on their keyboards for navigating within the application.

To learn more, see Quick Links.

Tes Exceptions
New settings appear on the Tes  and Survey Options pages called Tes/Survey Availability Exceptions . With
 these settings, insructors can select one or more groups or sudents and make a number of exceptions to the
 already esablished availability settings for a tes or survey. Exceptions provide an accommodation to a sudent
 with a disability, such as allowing more time or attempts on the tes, or providing accommodation for technology
 and language diferences.

To learn more, see Tes and Survey Options .

Keyboard Accessible Reordering
Located on every page where you can reorder items using drag-and-drop function, the keyboard accessible
 reordering tool displays the items on the page as a lis. You can use keyboard commands to reorder the items.

To learn more, see Keyboard Accessible Reordering.

YouTube Player Controls
The YouTube mashup allows an insructor to search for and embed YouTube videos directly in course content.
 When the video is displayed, sudents can use the accessible player controls that allow them to play, pause,
 sop, and control the volume of a video with a keyboard or screen reader. They are not required to interact with
 the more challenging Flash based controls that are present with the default YouTube videos.

Notifcations
You can confgure Blackboard to send out notifcations through a variety of channels, informing users about
 changes to their courses. Notifcations are specifc to the individual user, so both insructors and sudents can
 set what notifcations are sent to them, as well as when and how they want to receive notifcations. Users can
 click a link within a notifcation and go directly to the individual item without the need to consume all the
 surrounding content. When integrated with Blackboard Connect, users can optionally receive notifcations by

https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/050_Accessibility/010_Quick_Links
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/110_Tests_Surveys_Pools/020_Test_and_Survey_Options
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/090_Course_Content/010_Create_Content/060_Edit_and_Manage_Course_Areas_and_Content#keyboard_accessible
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 text (SMS), text-to-voice, and telephone. These capabilities allow all users to undersand what is happening with
 their courses in the medium that is mos comfortable for them.

To learn more, see Notifcations and Notifcation Dashboard Settings.

Display Options and Content Folders
Insructors can control the visual display of content on content pages or within folders in their courses. Options
 include showing only the text, showing only an icon to represent a content object, and showing both the text and
 the icon. With a lot of content on a page, sudents with cognitive disabilities can fnd it challenging to consume
 the information. Insructors can use folders and formatting to control the amount of clutter and help sudents to
 focus on one element at a time.

To learn more, see Course Style Options.

Content Editor
The content editor in Blackboard Learn is based on third-party technology from TinyMCE. It provides accessible
 controls, as well as keyboard shortcuts for formatting content created within it. The editor properly cleans up
 unnecessary HTML code that may be included when content is copied from Microsoft Ofce documents. This
 clean HTML ensures that screen reader users can fully consume any content created in or copied into the
 editor.

The formatting controls in the editor also ensure that headings added to content by an insructor do not confict
 with the overall semantic sructure of the page the content is displayed in. Building accessible content within a
 course is key to the success of all sudents. The content editor helps ensure that any content you create within it
 meets user and sysem expectations.

To learn more, see Content Editor.

High Contras Styles
On the login page for the Blackboard Learn sysem, you can choose to enable a high contras setting. This
 ensures the sysem uses the contras settings you already defned in your operating sysem to display text,
 menus, and other navigation controls within the Blackboard Learn environment. For users with visual
 impairments, the contras settings defned within the operating sysem likely provide the mos comfortable
 manner to view and consume information. The high contras support in Blackboard Learn allows you to continue
 to use them.

To learn more, see Log In to Learn.

https://en-us.help.blackboard.com/Learn/9.1_2014_04/Administrator/060_Application_Management_and_Support/Tools_Management/Notifications
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/070_Notifications/010_Notifications_Settings
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/050_Course_Customization/030_Course_Style_Options
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor/040_In_Your_Course/020_Content_Editor
https://en-us.help.blackboard.com/Learn/9.1_2014_04/Student/020_Get_Started/020_Login
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Page Design

  Strive for clean and simple.
The following lis presents ideas for page design, layout, and
 typography to help make your content efective and increase its
 readability.

Design Principles
Keep pages clean and uncluttered. Use plenty of white space to
 separate paragraphs, images, and other page elements to avoid overwhelming readers.

Align text and headings on the left. Online readers' eyes usually scan down the left side of the page. Centering
 headings will make your readers work harder to say focused on the material.

Use block-syle paragraphs. Leave a space between each paragraph and do not indent the frs line.

Be consisent. Create predictability by using layouts that repeat design elements from page to page. Use the
 same fonts, colors, icons, and heading syles on each page to help sudents feel comfortable and fnd
 information faser.

Use headings. Chunk information and make your page easier to scan. Choose your color scheme carefully
 and use colors that maximize readability. When in doubt, use black on white.

Use tables for presenting data. Do not use tables when creating your page layout. You can add tags to tables
 used for data so screen readers can interpret header rows and cell data. If you use tables to defne the layout
 of your page, screen readers will have a more difcult time interpreting the information on the page.

Use simple typography. Use no more than three font faces in your entire course. Be consisent with how you
 use them. For example, use Verdana for body copy text, and use Times New Roman for subheadings. Use
 fonts that are sandard for everyone’s computers and easy to read, such as Arial, Times New Roman,
 Trebuchet, Georgia, and Verdana.

To learn more, visit 10 Typography Misakes for examples of good and bad usage. The website is an
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 excellent example of all the principles lised for good page design.

Layout Examples
Click the following images to enlarge them in your browser. Use your browser's back button to return to the topic.

Easy-to-scan headings
Useful, simple icons added to the headings help readers easily determine what they want to read.

Color draws attention to elements of the page, such as "Example."

Horizontal bars divide the page into manageable chunks.

White space improves page layout, and emphasizes and divides the content. It leads a reader’s eye from one
 element to another.

Images speak for themselves
Some learners prefer to have information presented visually. Try using a mix of images and text to accommodate
 for this learning syle.

Ask yourself: Can a learner look at an image and undersand the concept without reading the text?

Use icons consisently
To help keep pages short and concise, ofer more information in links to other pages. For example, if you want
 sudents to view videos, always use the same icon when introducing the link. 

Consisency helps users become comfortable with how to navigate in your course and what to expect.

https://en-us.help.blackboard.com/@api/deki/files/3695/page_layout_1.png
https://en-us.help.blackboard.com/@api/deki/files/3696/page_layout_2.png
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Writing for the Web

  Reading online is quite
 diferent from reading printed
 material. 
In preparing content for your online course, you may fnd you have
 exising materials you want to incorporate into Blackboard Learn. To
 help maximize sudent learning, chances are you need to do some
 editing to get these ready for the web.

In a 1997 survey conducted by Jakob Nielson, researchers found approximately 80% of their tes users scanned
 web pages. A mere 16% read through the content word for word.

The sudy also showed mos users read in a roughly "F" formation. Firs, they read across the top part of the
 page. Next, they skip down several lines and carry out a second horizontal sweep, following this up with a
 vertical skimming of the left side of the page.

What can you learn from the online reading habits of the tes users? Put the mos important information in the
 frs two paragraphs. If sudents do not read any further, at leas they are exposed to the main concepts you
 want to get across. Students who have cognitive difculties may quit reading part way through the page and will
 beneft if the information is sructured in this way.

Consider using more of the following guidelines from Jakob Nielson's website.

 Assis page scanning
Present information in chunks.

Use bulleted liss to further break up content.
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Put your mos important content at the top of the screen or in the region of the
 browser window that loads frs. This portion of the web page is visible without
 scrolling.

In your subheadings, paragraphs, and bullet points, add information-carrying
 words. This allows sudents to quickly see these keywords when skimming down
 the left side of the page.

Use brief sentences.

 Create well-sructured paragraphs
Present one idea per paragraph. Limit paragraphs to two to four sentences.

Put the mos important information in the frs sentence, followed by details.

 Reduce word count
Use 50% less words than you use in print.

If a page is longer than two or three screens, break it up into several shorter pages.

 Highlight key words
Use color, bold text, italic, or typeface variations, but in moderation.

Avoid using ALL CAPS. This is difcult to read and carries extra emphasis in a screen reader—may
 sound like shouting. Moreover, capitalized words in sentences and paragraphs are harder to read than
 lowercase words. Capitalization causes problems for people with dyslexia.

Avoid underlining. Students may assume it is a link.

 Use a conversational tone
Write as if you are having a conversation, keeping the tone informal, but
 informational.

Use personal pronouns and action verbs.

Use active voice so sentences are concise, fow smoothly, and are easy to
 undersand.

Avoid jargon and unnecessarily complex or technical language.

https://en-us.help.blackboard.com/@api/deki/files/3693/scan_page.png
https://en-us.help.blackboard.com/@api/deki/files/3694/speech_bubbles.png
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Bes Practice: Presenting Content

  Outsanding online courses
 begin with outsanding content
 presented

       in a way that minimizes
 barriers to undersanding. 
Efective content design can create a more compelling and engaging
 showcase for your course material. More importantly, well-designed
 content can help achieve the following:

Ease of learning: How quickly can a new sudent navigate through your course
 while learning the material?

Efciency of use: After a sudent is familiar with your course setup, how quickly can
 they accomplish tasks?

Subjective satisfaction: How much do sudents enjoy working through your course
 material?

Usability: Can users with diferent levels of ability, experience, knowledge,
 language skills, hardware, or concentration level use your course easily?

Accessibility: Products and services that are accessible provide the means for
 people with disabilities to receive the same level of information, services, and use that people without
 disabilities receive. Is your course a level playing feld?

Efective design can also be a simple and sraightforward design. Clean and simple can be aeshetically pleasing
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 and sill have impact.

Pages with simple design:

Download quickly.

Are easy for sudents to undersand and navigate.

Create emphasis and predictability.

Have a fresh, up-to-date feel.

Are more likely to meet accessibility guidelines.

A well-designed course requires planning. You mus consider not only visual design, but also writing syle, tone,
 arrangement of information, and accessibility.

https://www.youtube.com/user/BlackboardTV
https://www.youtube.com/user/BlackboardTV
https://blackboard.secure.force.com/
https://blackboard.secure.force.com/
https://blackboard.secure.force.com/
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Color

   1 in every 12 men and 1 in
 every 165 women report some
 form of

 color vision disability.
Many of us realize the power and signifcance color schemes and color
 cues play in learning. Mos of us have
 specifc color preferences. Color blindness is
 only one important fact to keep in mind
 when devising a color scheme that makes
 your content accessible to all sudents.

Colors appear diferently depending on the
 person, the computer, the monitor, the
 operating sysem, or the browser used.
 Because you cannot be sure everyone will see the "real" colors you chose, try to view your course on an array
 of computers and browsers to see what others may see.

Key Color Considerations
Use a consisent color scheme. Use no more than fve colors in your palette. Diferent shades of the same hue
 with one or two extra colors as accents work well.

Choose a light shade for the background color. Dark text agains a white background is the mos readable
 combination. If you decide to use a non-white background, select a light color to maximize contras. Avoid
 dark pages or loud glaring colors, such as bright red, green, or yellow. These cause eye fatigue and are hard
 to read.

1
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Use color discreetly and use srong color sparingly. For example, black on yellow is a good color combination
 because the contras between the colors is srong. But for the entire page? Insead, use the black and yellow
 combination for drawing attention to a portion of your page, such as an information chart.

Choose diferent colors for each of the three link satuses: visited, active, and satic. Keep these consisent
 throughout the course. Link colors should be dark enough to be easily visible on a white background.

Avoid placing red and green, and blue and brown together. These color pairings are hard to tell apart by
 people with color blindness.

Do not rely on color alone to relay key information. Make important text sand out by highlighting it in bold,
 using an aserisk (*) beside it, or using the emphasis tag. Use the ALT attribute on colored images to help
 convey information that is color dependent.

Harmonious Color Combinations

 Monochromatic

Monochromatic color schemes use a single color. You can use difering values of one color to
 create the feel of diferent colors. Monochromatic color schemes are harmonious and peaceful,
 and provide a feel of sophisication. Using a single color creates unity and can help to create or
 tie things together.

 Analogous

Analogous color combinations use colors that are related. Analogous color schemes use colors
 that are next to each other on the color wheel. They usually match well and create serene and
 comfortable designs. These combinations are often found in nature, and are harmonious and
 pleasing to the eye. A selection of blues and purples, or reds and oranges create an analogous
 color scheme.

 Contrasing

Contrasing colors are complementary and pleasing to the eye. Colors that are opposites create
 contrasing color schemes. For example, yellow and purple or red and green are contrasing
 colors. Contrasing color schemes generally use a warm color and a cool color.

 Triad

Triadic color combinations are comprised of three opposing colors. A triadic color scheme uses
 colors that are evenly spaced around the color wheel. Red, yellow, and blue would be a triadic
 color scheme.
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Graphics

  Use graphics purposefully and
 not jus because they look good.
You can use graphics to enhance other content or serve as sandalone
 insructional elements. They can provide valuable information, such as
 charts, photos, diagrams, examples. They can assis in navigation with
 the use of banners or provide visual cues to help orient the sudent to
 the course with the use of icons.

Benefts of Graphics
Navigation. Users locate information more quickly through visual clues.

Undersanding. Increase retention and make difcult information easy to undersand.

Models. Depict a concept visually to save time and increase efectiveness.

Relationships. Connections between ideas or concepts are more easily undersood with images.

Tips for Adding Graphics to Your Course
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Use simple graphics. Clean and simple is often the mos efective. You do not want design overtaking content,
 nor do you want to increase download time unnecessarily. Avoid lengthy text and lots of numbers within the
 graphic.

Avoid background images. Use a white or pale solid background with dark text insead of adding background
 images. High contras between text and background is easier to read.

Watch the fle size. Large and numerous images may look great on your page, but they will frusrate users who
 mus wait for images to load.

Use the right format. You mus save your pictures in a web-ready format. In general, use the PNG format for
 simple graphics, such as logos, charts, and drawings. The JPG format is usually better for photos and images
 with subtle shadings or gradients. The JPG format also allows for better compression of a fle—a 1500 KB fle
 can reduce to 150 KB—but this may reduce some image quality. Select the bes format for better image
 quality and smaller fle size.

Crop photos. Cut out nonessential areas of an image to maximize impact and decrease download time.

Use animated images sparingly. They can cause the screen, or parts of it, to ficker and change rapidly.
 Animations can detract from the accessibility and usability of a page. Moving images also cause problems for
 sudents with cognitive impairments and may be hard to interpret by sudents who have low vision.

Provide alternative text using the ALT attribute . For detailed images like graphs or maps, use the long
 description attribute to provide more information. Screen readers and other text-to-speech software read the
 image’s alternative text aloud to the user.

https://www.youtube.com/user/BlackboardTV
https://www.youtube.com/user/BlackboardTV
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Bes Practice: Captioning Video Content

About Captioning
If you want to fully engage learners with video content, add captions.
 Captioning video creates accessible content for individuals who are
 deaf or hearing impaired. Captions are also important for anyone
 working in a noisy environment. Captions add another dimension to
 video content, making a richer learning experience for sudents who
 have specifc neurological processing problems, non-native speakers,
 adults working toward basic literacy, and children learning to read.

Diferent Types of Captions
The following lis includes the diferent types of captioning. Not all types of captioning fulfll all accessibility
 requirements.

Closed Captions: Video that has closed captions is denoted with a familiar CC icon . Using closed
 captions is optional. Users can turn them on or of with their video player or other controls. Closed captions for
 video on television are read by a decoder that is part of the hardware of all television sets sold in the United
 States. Closed captions for video on the web are read by a media player if it supports closed captions. Not all
 versions of media players support closed captions. Closed captions are not part of the actual video sream
 and exis in a separate text sream. 

Open Captions: Video that is accessed on the web can use open captions to provide on-screen text. Open
 captions are always displayed because they are part of the video sream. Open captions are not subject to
 diferent media player features. Users do not have to know how to turn the captions on. A disadvantage of
 open captions is that if the video is compressed, there can be a loss of quality and readability. They can also

Users who want to access closed captions need to undersand how to turn them on from their
 televisions or media players. Include insructions for users in your course.
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 be disracting to some users.

Audio Description: Adding a written description of sound efects such as "foor creaking" or "glass shattering"
 provides a richer experience for viewers. Audio descriptions are part of open or closed captions. They can fll
 in missing information a narrator fails to provide. For example, if a narrator says, "As you can see, the three
 main points support the conclusion," but doesn't say what those three main points are, audio description
 provides the missing information in the captions.

Real-time Captions: Taking place during a synchronous event such as sreaming video or a Blackboard
 Collaborate session, real-time captioning, sometimes referred to as real-time text, is a transcription service
 similar to TDD/TTY for telephones. Transcription services are separate from Blackboard Learn. There is
 usually a cos for the service and the service needs to be arranged in advance of the event.

Subtitles: Translating jus dialog and not including sound efects or other description, subtitles assume that
 viewers can see and hear. Only spoken dialog is captioned and often translated into a diferent language.

Finding Captioned Content
The easies and fases way to add captioned content to your course is to locate videos that already have
 captions. A relatively small percentage of videos are captioned, but you can locate them by fltering your search.
 In YouTube, enter your search term and then add a comma followed by cc. For example, when searching for
 captioned videos on MOOCs, type "MOOC, cc" in the search box.

iTunes and Hulu have flters to help you locate videos that have captions. Jus because a video has captions
 doesn't make the actual content any better or worse than uncaptioned videos. Before adding a captioned video
 to your course, play it all the way through to ensure the captions are accurate and the content is what you are
 expecting.

How to Caption a Video with YouTube
You can caption any videos that you own, meaning you uploaded them to your YouTube account. YouTube's
 automatic captioning service provides a solid sart to captioning your videos.

Having a soryboard is important, even if you are making informal videos. Have an outline and what you are
 going to say typed out. This takes a little extra time up front, but it saves time in the long run. With a soryboard,
 you'll sound better in your video, and you'll make fewer retakes. You'll also be able to copy and pase your
 narration into YouTube insead of retyping it into the caption editor.

1. Type an outline and basic soryboard.

2. Create your video.

3. Upload the video to YouTube.

4. Wait two to six hours.

5. Log back in to YouTube and click Video Manager.

The easies way to avoid requiring audio description in the example is to have a soryboard that
 the narrator follows that details visual information out loud.

TM



Best Practice: Captioning Video Content - Blackboard Help

6. Click Edit and click Captions.

7. Click Automatic Captions.

8. Edit the exising captions. Sometimes the automatic approximations are hilarious so this is fun.

Although YouTube's automatic captioning is far from perfect, it will get you 80 percent of the way there. The
 clearer your speaking voice and diction, the better results you'll get. The bes part of the automatic captioning
 tool is the time codes are synched to your content. All you need to do is edit the exising text in each frame.

https://www.youtube.com/user/BlackboardTV
https://www.youtube.com/user/BlackboardTV
https://blackboard.secure.force.com/
https://blackboard.secure.force.com/
https://blackboard.secure.force.com/


 

Adding captions to YouTube videos 
1. Visit your Video Manager and click the drop-down menu 

next to the “Edit” button for the video you’d like to add 
captions to 

 
2. Select Subtitles and CC 

 
3. Select the original language of the video from the drop- 

down menu (160 languages) 
 

4. Click the Add subtitles or CC button 
 

5. Choose the language of the subtitles or CC you would like to 
create. 

 
6. Click English (automatic) to see text of captions. 

*(It may take up to an hour for the automatic captions to be 
generated.) 

 
7. Once the English (automatic) caption option becomes 

available, click on the link to view the subtitles text. 
 
8. These captions are auto-generated. Listen and view the 

captions to determine if edits should be made. 
 
9. If edits are needed, click the edit button and type in the 

correct captioning.  Be sure to save any changes. 
 
10. Publish the final captions by clicking the publish button. 

 
 
Be sure to add tag ”yt;cc=on” in the tags box if you would like 
your video to automatically include captions. 
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Links on a Web Page

PAGE CONTENT

 In-Text Links  Navigational Link Blocks  Link Text (New Page)

Helping users understand the destinations of links is an important step towards increasing the

 usability and accessibility of a Web page.

Guidelines for In-Text Links

These guidelines apply to links embedded within the text of a document or a Web page.

Write links that make sense out of context. Use descriptive link text detailing the destination, not

 just “click here,” or other ambiguous phrases Link text should be made up of phrases rather

 than single words, so that users with limited motor control will not have difficulty selecting

 links.

Unclear Link Text Examples

Click here for instructions on how to use the new Penn State Web tool.

Learn more about color and accessibility here and here

Home Accommodations Blockers Courses Websites Multimedia

Testing/Triage Software Training

Sites at Penn State Log in

http://accessibility.psu.edu/linktext
http://accessibility.psu.edu/
http://accessibility.psu.edu/accommodations/
http://accessibility.psu.edu/blockers/
http://accessibility.psu.edu/courses/
http://accessibility.psu.edu/webpagetools/
http://accessibility.psu.edu/multimedia/
http://accessibility.psu.edu/testing/
http://accessibility.psu.edu/software/
http://accessibility.psu.edu/training/
http://accessibility.psu.edu/
http://accessibility.psu.edu/feed/
http://sites.psu.edu/
http://sites.psu.edu/accessibility/wp-login.php?redirect_to=http%3A%2F%2Fsites.psu.edu%2Faccessibility%2Flinkshtml%2F
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Story 1 (Read More) | Story 2 (Read More)

Accessibility 101 (Register) | Accessibility 102 (Register

Syllabus: PDF Word

Usable Link Text

Instructions for the new Penn State Web tool are available online.

Learn more about color and accessibility in terms of contrast and color coding

Story 1: Read More) | Story 2: Read More)

Register for: Accessibility 101, Accessibility 102

Syllabus (PDF) Syllabus (Word)

NOTE: Some search engines, such as Google, give higher rankings to sites that use “context-rich”

 text links.

Other In-Text Link Design Guidelines

1. Maintain the standard that text links are underlined and are a different color value (lighter or

darker) than the main text. This provision will help colorblind users find links more easily,

and is good usability practice.

2. Avoid links opening in a new window unless absolutely necessary. New windows are

disorienting to users of both screen readers and visual browsers (because the Back button

becomes "disabled") Also be aware that some users of visual browsers disable pop-up

windows to avoid advertising.

NOTE: If links do open in a new window, include a textual indication (e.g. External Resources

[New Window]) so screen reader users are aware of the new window.

3. If you use JavaScript links, such as those to open pop-up windows, make sure they are coded

to be accessible to screen readers. Many JavaScript links are unusable in screen readers.

4. If you use an image or image map to create links, make sure the destination is included in an

ALT tag. See the Image Maps and Image pages for more details on creating accessible links

with images.

5. You can insert "Top of Page" links after each section in longer documents to reduce the need

to scroll up (which can be difficult for motion impaired users). These links should be

formatted differently from other links so that users know they are page-internal.

Guidelines for Blocks of Navigational Links

http://accessibility.psu.edu/linkshtml/contrast
http://accessibility.psu.edu/linkshtml/colorcoding
http://accessibility.psu.edu/linkshtml/links
http://accessibility.psu.edu/linkshtml/links
http://accessibility.psu.edu/popups
http://accessibility.psu.edu/imagemaps
http://accessibility.psu.edu/imagemaps
http://accessibility.psu.edu/linkshtml/images
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http://accessibility.psu.edu/linkshtml/[5/4/2016 4:06:39 AM]

These guidelines apply primarily to blocks of navigational links in Web pages or PDF files.

1. If your Web site uses a block of navigational links on each page, make sure a skip navigation

strategy has been implemented so that screen readers can avoid reading these links on each

page.

WCAG 2.0 Guideline 13.6 —"Group related links, identify the group (for user agents), and,

 until user agents do so, provide a way to bypass the group."

2. Whenever possible, break up long lists of links into categorized blocks separated by headers

(e.g. H1, H2). Otherwise, you may have to implement a Skip Navigation strategy.

3. Maintain a consistent set of navigational links on every page of your site, even if you must

implement a skip navigation strategy.

4. You can place a breadcrumb trail, a listing of the page’s location in the site’s hierarchy, below

the page’s title bar to help users keep track of their location within a complex site.

Bread Crumb Trail Example

NOTE: The safest symbol indicating a subordinate page is the colon (:) instead of punctuation

 symbols like » ("Right double angle bracket) or > ("greater than"). It’s also best to avoid to avoid

 arrow symbols (e.g. →) since they may not even be pronounced by a screen reader.

A Breadcrumb Trail

Creating Accessible Web sites Home :  HTML and Web Page Accessibility :  Links

HTML Reference

http://accessibility.psu.edu/skipnav
http://accessibility.psu.edu/headers
http://accessibility.psu.edu/skipnav
http://accessibility.psu.edu/accessibility
http://accessibility.psu.edu/accessibility/webpagetools
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Myths of Web Accessibility

Some Accessibility Gotchas

Tutorial Page 6

In the years of discussion about accessibility in Web design, some implementation myths have

 emerged.

Below are some of the most common misconceptions.

1. There’s only a small audience for accessibility.

Myth —Accessibility compliance only benefits users registered with the Office of Disability

 Services.

Reality —Accessibility accommodations benefit users beyond those with an “official disability.”

 Consider how many people watch closed captions on TV, even if they are not deaf. At some point

 almost all of us will be in a situation where an image link is broken, colors are not

 distinguishable, text is too small, audio is not working, we cannot see the whole screen or we

Home Accommodations Blockers Courses Websites Multimedia

Testing/Triage Software Training

Sites at Penn State Log in

http://accessibility.psu.edu/
http://accessibility.psu.edu/accommodations/
http://accessibility.psu.edu/blockers/
http://accessibility.psu.edu/courses/
http://accessibility.psu.edu/webpagetools/
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http://accessibility.psu.edu/testing/
http://accessibility.psu.edu/software/
http://accessibility.psu.edu/training/
http://accessibility.psu.edu/
http://accessibility.psu.edu/feed/
http://sites.psu.edu/
http://sites.psu.edu/accessibility/wp-login.php?redirect_to=http%3A%2F%2Fsites.psu.edu%2Faccessibility%2Faccommodations%2Fmyths%2F
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 cannot move the mouse properly.

2. Only accessibility experts can implement accessibility
fxes.

Myth —Accessibility issues are so arcane only an expert can really fix them.

Reality —Most accessibility fixes are simple to understand and implement once the content

 creator is aware of the tools and techniques. For instance, techniques in creating accessible

 Word documents involve applying tools such as Heading styles, the table of contents generator

 and appropriate selection of fonts. The most specialized tool, ALT tagging images, can be

 quickly accessed by right-clicking the image and selecting the Format Picture option. The same

 is true for PowerPoint, ANGEL and many other common tools.

3. Waiting for problems is just as easy as doing it now.

Myth —You don’t need to worry about implementing accessibility until a user requests

 accommodation.

Reality —If “an ounce of prevention is worth a pound of cure,” then one minute of implementing

 an extra tag or adding more descriptions is worth one hour of finding each problem and figuring

 out how to fix it. Retrofitting a site for accessibility is far more time-consuming

 than implementing accessibility measures from the beginning.

Myth 2 —I rarely get accommodation requests for a course and then usually to extend deadlines.

 Accessibility isn’t an issue for this course.

Reality —The number of cases of accommodations for blind, low vision and deaf students has

 increased significantly at Penn State, particularly for online courses. Students may also wait until

 the semester is partly complete before requesting assistance. Developing an accessibility plan

 may save instructors remediation effort in the future.

4. Fixing just the Blockers fxes all major issues

Myth —Once I make sure the blockers are fixed, the remaining issues are relatively minor.

Reality —Although Penn State designated some blockers as being important to fix first, the

http://accessibility.psu.edu/accommodations/microsoftword
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 other remaining issues such as keyboard accessibility, color coding and others can pose serious

 issues, even to screen reader issues. A full accessibility plan should address all issues.

5. If it’s audio, then a screen reader can access it.

Myth —If my content is delivered by audio, then by default a visually impaired user can access

 it.

Reality —The navigation to the audio (including the login process) may not be accessible.

6. ARIA/Standards/CSS styling will guarantee
accessibility.

Myth —If I use CSS, create standards compliant code and implement ARIA, I can guarantee that

 my site will be accessible.

Reality —Although these techniques can significantly improve accessibility if implemented

 properly, you can also create additional accessibility issues if you use the markup incorrectly.

The same statement applies to other standards such as HTML 5, XML, MathML, Unicode, etc.

 These standards facilitate data exchange, and are easier for assistive technologies to work with,

 but do not guarantee accessibility.

7. Accessibility means no more tables, JavaScript, Flash,
image maps or frames.

Myth —All HTML tables, JavaScript, image maps, multimedia and frames must be removed to be

 standards-compliant.

Reality —None of these eliminations are required by WCAG 2.0. What is required is that these

 tools be implemented with sufficient information for a screen reader to use. In most cases, this

 only requires the addition of a few specific attributes. Even JavaScript programmers have

 developed techniques to create accessible code, especially in terms of the recently developed

 ARIA standard

http://www.w3.org/WAI/intro/aria
http://www.w3.org/WAI/intro/aria
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8. Accessible design interferes with design.

Myth —An accessible Web site is a plain

 Web site or one without any design innovations.

Reality —More complex designs can be implemented while remaining accessible. The key is to

 incorporate elements that do not interfere with legibility, screen reader access or keyboard

 access. See the following accessibility Web sites for examples: WebAIM, Jim Thatcher

 Accessibility Tutorials, and Accessify.com.

It is also the case that many accessibility principles (e.g. good color contrast, good semantic

 structure) do follow good design and Web development principles.

9. A text-only or an “Accessible site” is a good
accessibility option.

Myth —Creating a parallel, text-only site or service while maintaining an inaccessible site is the

 best solution for accessibility.

Reality —Most users prefer that accessibility options be incorporated into a single Web site,

 saving text-only transcripts

 for multimedia content and plug-ins. The reasons include:

1. Many people with disabilities feel that text-only sites are exclusionary. A single site with

appropriate accessibility is perceived as more inclusive to the entire Internet community.

2. It’s much more difficult to maintain a second site. Once it’s out of date, you are out of

compliance, because equivalent information is not available to everyone.

3. Newer screen readers can actually process accessible HTML better than they can a text-only

site.

4. Text-only sites may address some accessibility issues specific to screenreaders, but not all

accessibility issues.

5. Accessibility goes beyond “text-only,” so the original site must be reviewed in any case.

NOTE: It can be beneficial to provide portions content in alternate formats to enhance

 accessibility. Examples include Flash vs. non-Flash, PDF vs. Word and other alternate formats.

10. Accessibility requires EM and STRONG tags.

http://www.webaim.org/
http://www.jimthatcher.com/
http://www.jimthatcher.com/
http://www.accessify.com/
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Myth —You must replace the B (bold

 face) and I (italics) tags with STRONG and EM tags

 to be compliant.

Reality —Although this is recommended in the Web Standards community for a variety of

 reasons, it makes little practical impact in visual browsers or screen readers.

11. Minimum WCAG 2.0 compliance fxes all problems.

Myth —If you meet the minimum requirements for WCAG 2.0 compliance, you will never have to

 worry about accessibility issues again.

Reality —Not all user needs can be accounted for in any guideline. A user may require further

 assistance because of a particular combination of needs. In addition, advances in Internet

 options will inevitably create additional accessibility issues. This page and this site are

 continually updated to ensure compliance with accessibility guidelines. The goal of WCAG 2.0 is

 to address common barriers to usability in order to reduce future accessibility issues.
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Equal Access: Universal Design of Your Project 

As increasing numbers of people with disabilities 
participate in academic opportunities and careers, 
the accessibility of classes, service offices, libraries, 
computer labs, electronic resources, events, and 
specific project activities increases in importance. 
The goal is simply equal access; everyone who 
qualifies to use your resources or participate 
in sponsored activities should be able to do so 
comfortably and efficiently. 

Legal Issues
Section 504 of the Rehabilitation Act of 1973, the 
Americans with Disabilities Act of 1990, and the 
Americans with Disabilities Act Amendments of 
2008 mandate that no otherwise qualified person 
with a disability shall, solely by reason of his or 
her disability, be excluded from the participation 
in, be denied the benefits of, or be subjected to 
discrimination in public programs. This means that 
courses, student services, information resources, and 
project activities should be accessible to qualified 
individuals with disabilities.

Universal Design
An approach to making facilities, information, and 
activities accessible to and usable by everyone is 
called universal design (UD). Universal design 
means that rather than designing for the average 
user, you design for people with differing native 
languages, genders, racial and ethnic backgrounds, 
abilities, and disabilities. Make sure that project 
staff and volunteers are trained to support people 
with disabilities, respond to specific requests for 
accommodations in a timely manner, and know who 
to contact regarding disability-related issues. The 
universal design of your project offerings will make 
everyone feel welcome and minimize the need for 
special accommodations for individual participants. 

Guidelines and Examples
Addressing the following questions provides a good 
starting point for making your facility, information 
resources, and project activities universally 
accessible. This content does not provide legal 
advice. Contact the Office for Civil Rights (OCR) 
about legal mandates.

Planning, Policies, and Evaluation
Consider diversity issues as you plan and evaluate 
services.

 — Are people with disabilities, racial and ethnic 
minorities, men and women, young and 
old students, and other groups represented 
in the project planning process in numbers 
proportional to those of the whole campus or 
community?

 — Do you have project policies and procedures 
that ensure access to facilities, events, and 
information resources for people with 
disabilities?

 — Are disability-related access issues and 
other diversity issues addressed in program 
evaluation plans and instruments?

 — Do you address issues related to the inclusion of 
participants with disabilities in grant proposals, 
perhaps by partnering with an organization with 
expertise in this area? 

Information Resources and Technology
If career services uses computers as information 
resources, ensure these systems employ accessible 
design, that staff members are aware of accessibility 
options, and systems are in place to make 
accommodations.

 — Do pictures in your publications and website 
include people with diverse characteristics with 
respect to race, gender, age, and disability?

 — In key publications of your project, do you 
include a statement about your commitment to 
access and procedures for requesting disability-
related accommodations? For example, you 
could include the following statement: “Our 
project’s goal is to make materials and activities 
accessible to all participants. Please inform 
organization leaders of accessibility barriers you 
encounter and request accommodations that will 
make project activities and information resources 
accessible to you.”

 — Are all printed publications available 
(immediately or in a timely manner) in alternate 
formats such as Braille, large print, and 
electronic text? 

by Sheryl Burgstahler, Ph.D.
A checklist for making projects welcoming, accessible, and usable



2

 — Are key documents provided in language(s) 
other than English?

 — Are printed materials in your facility or at an 
event within easy reach from a variety of heights 
and without furniture blocking access? 

 — Do electronic resources, including web pages, 
adhere to accessibility standards adopted, your 
institution, or your project or funding source? 
Section 508 Standards for Electronic and Information 
Technology (www.access-board.gov/508.htm) and 
Web Accessibility Initiative (WAI) (www.w3.org/
WAI/) are most commonly used. For example, 
are text alternatives provided for graphic images 
on web pages? Can the content be accessed with 
a text-only browser and by using the keyboard 
alone? For general information about making 
your website accessible to everyone, consult 
the video and presentation World Wide Access: 
Accessible Web Design at www.uw.edu/doit/videos/
index.php?vid=35.

 — Do you include a statement on your website 
affirming your commitment to accessible 
design? For example, you could include the 
following statement: “We strive to make our 
website accessible to everyone. We provide 
text descriptions of graphic images and photos. 
Video clips are open-captioned and audio-
described. Suggestions for increasing the 
accessibility of these pages are welcome.”

 — Do videos developed or used in the project have 
captions? Are they audio-described? 

 — Is an adjustable-height table available for each 
type of workstation to assist participants who 
use wheelchairs or are small or large in stature? 

 — Do you provide adequate work space for both 
left- and right-handed users?

 — Is software to enlarge screen images and a large 
monitor available to assist people with low 
vision and learning disabilities?

 — Do you provide a trackball to be used by 
someone who has difficulty controlling a mouse? 

 — Are staff members aware of accessibility options 
(e.g., enlarged text feature) included in computer 
operating systems and of assistive technology 
available in the facility?

 — Are procedures in place for a timely response to 
requests for assistive technology? 

For more information, consult Creating Video and 
Multimedia Products That Are Accessible to People with 
Sensory Impairments at www.uw.edu/doit/Brochures/
Technology/vid_sensory.html and the Working 
Together videos and publications at www.uw.edu/
doit/Resources/at.html. For making distance learning 
accessible, consult Real Connections: Making Distance 
Learning Accessible to Everyone video presentation 
and publication at www.uw.edu/doit/Video/real_con.
html.

Project and Activity Facilities
Ensure that facilities, activities, materials, and 
equipment are physically accessible to and usable by 
all participants, and that all potential characteristics 
are addressed in safety considerations.

 — Ensure physical access, comfort, and safety 
within an environment that is welcoming to 
visitors with a variety of abilities, racial and 
ethnic backgrounds, genders, and ages.

 — Are there parking areas, pathways, and 
entrances to the building that are wheelchair 
accessible and clearly identified?

 — Are all levels of the facility connected via an 
accessible route of travel?

 — Are aisles kept wide and clear of obstructions for 
the safety of users who have mobility or visual 
impairments? 

 — Are wheelchair-accessible and child-friendly 
restrooms with well-marked signs available in or 
near the facility?

 — Is at least part of a service counter or desk at a 
height accessible from a seated position?

 — Is adequate light available?
 — Are there ample high-contrast, large-print 

directional signs to and throughout the facility, 
that include directions to accessible routes? 
When appropriate are these signs marked in 
Braille?  

Consult the ADA Checklist for Readily Achievable 
Barrier Removal at www.ada.gov/checkweb.htm for more 
suggestions. For computing facilities, consult the 
Equal Access: Universal Design of Computer Labs video 
and publication at www.uw.edu/doit/videos/index.
php?vid=12. 

http://www.access-board.gov/508.htm
http://www.w3.org/WAI/
http://www.w3.org/WAI/
http://www.uw.edu/doit/videos/index.php?vid=35
http://www.uw.edu/doit/videos/index.php?vid=35
http://www.washington.edu/doit/Brochures/Technology/vid_sensory.html
http://www.washington.edu/doit/Brochures/Technology/vid_sensory.html
http://www.washington.edu/doit/Resources/at.html
http://www.washington.edu/doit/Resources/at.html
http://www.washington.edu/doit/Video/real_con.html
http://www.washington.edu/doit/Video/real_con.html
http://www.ada.gov/checkweb.htm
http://www.uw.edu/doit/videos/index.php?vid=12
http://www.uw.edu/doit/videos/index.php?vid=12
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Staff
Make sure staff are prepared to work with all 
program participants.

 — Are all staff members familiar with the 
availability and use of the Telecommunications 
Relay Service, assistive technology, and alternate 
document formats?

 — Do all staff members know how to respond to 
requests for disability-related accommodations, 
such as sign language interpreters?

 — Are project staff and contractors in specific 
assignment areas (e.g., web page development, 
video creation) knowledgeable about 
accessibility requirements and considerations?

 — Are all staff members aware of  issues related 
to communicating with participants who 
have disabilities? Do staff deliver conference 
presentations and exhibits that are accessible to 
all participants? See Presentation, Exhibit, and 
Other Communication Hints at the end of this 
publication. For further suggestions, consult 
Effective Communication: Faculty and Students 
with Disabilities at www.uw.edu/doit/Brochures/
Academics/effective.html.

Checklist Updates
To increase the usefulness of this working document, 
send suggested improvements to sherylb@uw.edu.

Additional Resources
For more information about applications of 
universal design consult www.uw.edu/doit/Resources/
udesign.html or The Center for Universal Design 
in Education at www.uw.edu/doit/programs/center-
universal-design-education/overview. The book 
Universal Design in Higher Education: From Principles 
to Practice published by Harvard Education Press 
shares perspectives of UD leaders nationwide. 
To receive a 20% discount, visit www.uw.edu/doit/
universal-design-higher-education-coupon.

About DO-IT
DO-IT (Disabilities, Opportunities, Internetworking, 
and Technology) serves to increase the successful 
participation of individuals with disabilities in 
challenging academic programs and careers such 
as those in science, engineering, mathematics, and 
technology. 

For further information, to be placed on the DO-IT 
mailing list, request materials in an alternate format, 
or to make comments or suggestions about DO-IT 
publications or web pages, contact:

DO-IT 
Box 354842 
University of Washington 
Seattle, WA 98195-4842 
doit@uw.edu 
www.uw.edu/doit/
206-685-DOIT (3648) (voice/TTY) 
888-972-DOIT (3648) (toll free voice/TTY)  
509-328-9331 (voice/TTY) Spokane 
206-221-4171 (fax) 
Founder and Director: Sheryl Burgstahler, Ph.D.
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Presentation, Exhibit, and Other Communication Hints

Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to delivering a presentation, hosting an exhibit, and other-
wise relating to people with disabilities. However, here are some helpful hints. 

General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining—it’s liberating!

• Provide information in alternate means (e.g., written, spoken, diagrams).
• Do not interact with a person’s guide dog or service dog unless you have received permission 

to do so.
• Use large bold fonts with high contrast on uncluttered overhead displays.
• Speak all of the content presented with overhead projections and other visuals.
• Repeat questions from audience members.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer instruction both orally and in writing. If asked, read instructions to individuals who have 

specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.



Increasing numbers of people with disabilities 
attend professional conferences and meetings. 
Most presenters and exhibitors have the goal 
that everyone who visits an exhibit, attends 
a presentation, or seeks information from a 
publication is able to do so. Reaching this 
goal, however, involves efforts at many levels. 
Following are a few examples:
• Exhibits and presentation rooms need to 

be arranged in such a way that individuals 
using wheelchairs can access materials and 
products, see the presenters, and otherwise 
fully participate.

• Presenters need to deliver spoken, video, and 
printed information in multiple formats so 
that participants with sensory impairments 
can access the content. 

• Webmasters, product developers, and material 
creators need to be aware of accessibility 
issues and apply accessible design principles.

Legal Issues
Section 504 of the Rehabilitation Act of 1973, the 
Americans with Disabilities Act of 1990, and the 
Americans with Disabilities Act Amendments of 
2008 prohibit discrimination against individuals 
with disabilities. According to these laws, no 
otherwise qualified person with a disability shall, 
solely by reason of his or her disability, be excluded 
from the participation in, be denied the benefits 
of, or be subjected to discrimination under any 
program or activity of a public entity. This means 
that conference and meeting activities should be 
accessible to attendees with disabilities.

Universal Design
An approach to making facilities, information, 
and activities accessible to and usable by everyone 
is called universal design. Universal design means 
that rather than designing for the average user, 
you design for people with a broad range of 
characteristics such as native language, gender, 

racial and ethnic background, age, and disability. 
Make sure that presenters and exhibit staff are 
trained to support people with disabilities, 
respond to specific requests for accommodations 
in a timely manner, and know who to contact 
regarding disability-related issues. Ensure that 
everyone feels welcome, and can
• get to the facility and maneuver within it,
• communicate effectively with support staff, 
• access printed materials and electronic 

resources, and
• fully participate in events and other activities. 

Guidelines and Examples
Addressing the following questions provides a 
good starting point for making your conference 
exhibits, presentations, and information resources 
universally accessible. This content does not 
provide legal advice. Contact the Office for 
Civil Rights (OCR) for information about legal 
mandates.

Exhibit and Presentation Facilities 
Ensure physical access, comfort, and safety within 
an environment that is inclusive to people with a 
variety of abilities, racial and ethnic backgrounds, 
genders, and ages.

 — Is the exhibit and presentation area wheelchair 
accessible? Aisles should be kept wide and 
clear of obstructions for the safety of users 
who have mobility or visual impairments. 
Remove a few chairs in a presentation room or 
lab so that a wheelchair user has options for 
locations to sit in the room.

 — Are signs and posters in high contrast 
and large print so that they can be read by 
someone with limited vision? 

A checklist for making conference exhibits and presentations welcoming and accessible 
to everyone
by Sheryl Burgstahler, Ph.D.

Equal Access: Universal Design of Conference  
Exhibits and Presentations 
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Staff
Make sure that staff members are prepared to 
work with all participants.

 — Do all staff members know how to respond to 
requests for disability-related accommodations 
provided by your organization (e.g., 
presentation and exhibit materials in alternate 
formats) and by the conference organizer (e.g., 
sign language interpreters)? 

 — Are all staff members aware of issues related 
to communicating with participants who have 
disabilities? See Presentation, Exhibit, and 
other Communication Hints at the end of this 
publication for specific guidelines. For further 
suggestions, consult Effective Communication: 
Faculty and Students with Disabilities.1

 — Are staff and contractors that create materials 
used in exhibits and presentations (e.g., web 
pages, video presentations) knowledgeable 
about accessibility considerations and directed 
to employ accessible design principles?

Information Resources and Technology
If your exhibit or presentation uses computers 
as information resources, ensure these systems 
employ accessible design, that staff members are 
aware of accessibility options, and systems are in 
place to make accommodations.

 — In key publications, do you include a 
statement about your commitment to 
universal access and procedures for requesting 
disability-related accommodations? For 
example, you could include the following 
statement: “Our goal is to make all materials 
and products accessible to everyone. Please 
inform staff of accessibility barriers you 
encounter and request accommodations that 
will make our programs, and information 
resources accessible to you.” 

 — Are all printed publications available 
(immediately or in a timely manner) in 
alternate formats such as Braille, large print, 
and electronic text? 

 — Are key documents provided in language(s) 
other than English?

 — Are printed materials within easy reach from 
a variety of heights and without furniture 
blocking access? Are staff ready to assist 
visitors who cannot reach handouts?

 — Do overhead presentation materials use large, 
clear characters that can be seen by most 
individuals from the back of a large room? If 
you demonstrate web pages do you present 
them in enlarged print that participants who 
have visual impairments can read? Do you 
also ensure that key content is spoken?

 — Do electronic resources, including web 
pages, adhere to accessibility guidelines or 
standards adopted by your organization, 
project, or funding source? Guide to the Section 
508 Standards for Accessible Electronic and 
Information Technology2 and the World Wide 
Web Consortium’s Accessibility Guidelines3 are 
most commonly used. For information about 
making your website accessible to everyone, 
consult the World Wide Access: Accessible Web 
Design video and publication.4 

 — Do video presentations developed or used in 
your exhibit or presentation have captions? 
It is also a good idea to have them audio 
described (where additional visual content is 
verbalized for someone who is blind) or have 
a transcription available in a text format. 

 — If your exhibit or presentation provides 
computers for participants, are you ready to 
respond to requests for assistive technology 
that individuals with disabilities might make? 
In most cases, it would be reasonable that such 
requests be made before the event; adopt a 
procedure to respond in a timely manner.

 — Do you place computers on an adjustable-
height table? 

 — Do you provide a trackball for someone 
unable to use a mouse? 

 — Do you provide a large screen monitor and 
enlargement software (often built into an 
application)?

 — If your company produces electronic 
technology, is it designed in such a way to 
be accessible to people with disabilities? A 
universal design approach is appropriate 
here; the U.S. Federal Government provides a 
model for accessible design in its Guide to the 
Section 508 Standards for Accessible Electronic 
and Information Technology.2

http://www.washington.edu/doit/Brochures/Academics/effective.html
http://www.washington.edu/doit/Brochures/Academics/effective.html
http://www.access-board.gov/sec508/guide/
http://www.access-board.gov/sec508/guide/
http://www.access-board.gov/sec508/guide/
http://www.w3.org/WAI/
http://www.washington.edu/doit/Video/www.html
http://www.washington.edu/doit/Video/www.html
http://www.access-board.gov/sec508/guide/
http://www.access-board.gov/sec508/guide/
http://www.access-board.gov/sec508/guide/
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Checklist Updates
This checklist was field tested at more than twenty 
postsecondary institutions nationwide.5 The 
results of a nationwide survey to test face-validity 
of checklist items let to further refinement of 
the checklist. To increase the usefulness of this 
working document, send suggestions to  
sherylb@uw.edu.

Additional Resources
For more information about making conferences 
accessible, consult Planning an Accessible Conference 
published by SIGACCESS and written by Shari 
Trewin.6 

For more detailed content online consult Making 
Exhibits Accessible7, Removing Barriers: Planning 
Meetings That Are Accessible To All Participants8, 
Creating Video and Multimedia Products That Are 
Accessible to People with Sensory Impairments9, 
Working Together videos and publications10, and 
the Equal Access: Universal of Design Computer Labs 
video and publication.11 

For more information about applications of universal 
design consult The Center for Universal Design in 
Education.12 The book Universal Design in Higher 
Education: From Principles to Practice published by 
Harvard Education Press shares perspectives of UD 
leaders nationwide. To receive a 20% discount visit 
the DO-IT website.13

Cited Web Resources
1. www.uw.edu/doit/Brochures/Academics/effective.

html
2. www.access-board.gov/sec508/guide/
3. www.w3.org/WAI/
4. www.uw.edu/doit/Video/www.html
5. www.uw.edu/doit/Brochures/Academics/admin.

html
6. www.sigaccess.org/community/accessible_conference/
7. www.openexhibits.org/research/cmme/
8. http://www.fpg.unc.edu/~ncodh/pdfs/

rbmeetingguide.pdf
9. www.uw.edu/doit/Brochures/Technology/vid_

sensory.html
10. www.uw.edu/doit/Resources/at.html

11. www.uw.edu/doit/Video/equal.html
12. www.uw.edu/doit/CUDE/
13. www.uw.edu/doit/UDHE/coupon.html

About DO-IT
DO-IT (Disabilities, Opportunities, 
Internetworking, and Technology) serves to 
increase the successful participation of individuals 
with disabilities in challenging academic 
programs and careers such as those in science, 
engineering, mathematics, and technology. 

For further information, to be placed on the DO-
it mailing list, request materials in an alternate 
format, or to make comments or suggestions 
about DO-IT publications or web pages, contact:

DO-IT
University of Washington
Box 354842
Seattle, WA 98195-4842
doit@uw.edu
www.uw.edu/doit/
206-685-DOIT (3648) (voice/TTY)
888-972-DOIT (3648) (toll free voice/TTY) 
509-328-9331 (voice/TTY) Spokane 
206-221-4171 (fax)
Founder and Director: Sheryl Burgstahler, Ph.D.
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Presentation, Exhibit, and Other Communication Hints

Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to delivering a presentation, hosting an exhibit, and other-
wise relating to people with disabilities. However, here are some helpful hints. 

General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining—it’s liberating!

• Provide information in alternate means (e.g., written, spoken, diagrams).
• Do not interact with a person’s guide dog or service dog unless you have received permission 

to do so.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• Speak all of the content presented with overhead projections and other visuals.
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer directions or instructions both orally and in writing. If asked, read instructions to 

individuals who have specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Repeat questions from audience members.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.







_______________________________________________________________________________________ 
Guidelines for Creating Accessible Printed Posters  Page 3 of 11 
Gilson & Kitchin, 2007 

Using Accessible Text 
• Is poster text legible from a distance of 3 to 6 feet? (Font size)  

o Title: Ideal is 158-point font (1.5 inches).  Use at least 72 point font or 

larger for poster titles (The title should be viewable from 10 to 15 feet 

away to catch the attention of the reader (Conner, ND)). 

o Section Title: Ideal is 56-point font (.54 inches).  Use at least 46 to 56-

point font for section titles (Texas Tech University, 2007). 

o Block Text/Body: Ideal is 36-point font (.34 inches).  At least 24-36 

point font for body text. 

o Sizes may vary depending on the viewing distance and amount of text 

to be included (Texas Tech University, 2007). 

 

Figure 1: Example poster text.   
Examples in actual size are given for 158-point font for a poster title,  
56-point font for a section title (heading), and 36-point for body (block) text.  
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• Is the font choice legible enough? (Font type)  

o Use non-serif (san-serif) fonts (University of Edenburgh, 2005). 

o Serif means a small decorative line added as embellishment to the 

basic form or main strokes of an alphabetical letter. Typefaces are 

often described as being serif or sans serif (without serifs). The most 

common serif typeface is Times Roman. A common sans serif 

typeface is Helvetica. Serif fonts can be more difficult to read, 

particularly the more decorative, hand written, and italicized fonts 

(Wikipedia, June, 2007; Shaw, May, 2007). 

o Common sans serif fonts (Shaw, May, 2007):  

 Helvetica 

 Veranda 

 Microsoft sans serif 

 For a list of fonts and explanations see: 

http://www.codestyle.org/css/font-family/sampler-

SansSerif.shtml 

 
Figure 2: Example serif and sans serif font.   
Notice the sans serif Arial font does not have decorative tails at the end of 
character strokes unlike the Harrington font. 

 
 



_______________________________________________________________________________________ 
Guidelines for Creating Accessible Printed Posters  Page 5 of 11 
Gilson & Kitchin, 2007 

• Is the font color contrasted enough with the background (Lighthouse 

International, 2007)?  

o Black text with white back ground is the most legible with printed 

material. 

o Still, you may want to use different colors.  If this is important to your 

design for aesthetic or other reasons it is better to use combinations 

different from black text on white background only for larger or 

highlighted text, such as headlines and titles. 

 
Figure 3: Contrast example for a heading.   
Notice the white text on solid color background. 

 
 

• Is the line spacing too crowded? 

 “Leading” refers to the amount of added vertical spacing between lines 

of type.  In this text the leading or line spacing is 1.5.  Using between 

1.2 and 2.0 line-spacing allows the reader greater ease in moving from 

line to line (Wikipedia, 2007). 

• Tracking is the space between characters.  If your processor 

allows for letter-spacing adjustments +3 is adequate.  

• You can increase tracking for headlines but you should not use 

less then +3 for tracking anywhere. 

 

• Are there too many lines per text block? (See Figure 4) 

o Text block:  Could be a standard 11 by 8.5 piece of paper, which will 

hold about 100 words or 19 lines of text with 

 Font size 24 



_______________________________________________________________________________________ 
Guidelines for Creating Accessible Printed Posters  Page 6 of 11 
Gilson & Kitchin, 2007 

 Lines-pacing 1.2 

o A text block could also be the text associated with a particular heading 

arrange in way other than a rectangular block. 

Figure 4: Sample block text using different shaped areas for text (i.e. 
rectangle and oval). 

Notice that lines of text are spaced using 1.5 line-spacing and the space 
between text characters is spaced to increase access.  Arial font is used in 
the figure below. 
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Using Images/graphics without losing access 
o It is not necessary to completely avoid using images.  Instead, use them 

creatively and ensure that all elements work together to draw the audience to 

understand the message. 

o Do all images used to communicate ideas have sufficient text labels and text 

captions (American Society of Primatologists [ASP], 2002)?   

 Captions and/or alternative text allow the audience to access more 

precisely what the image is intended to communicate. 

o Place images/graphics with consideration to where in the sequence of text 

they belong (ASP, 2002). 

o Do not place text over images (Lighthouse International, 2007). 

o Are image/graphic titles appropriately referred to in the text (ASP, 2002)? 

o Are the uses of any charts (pie, line, scatter, histograms, etc.) used 

appropriately and with clear textual explanations of the data?  

o Is the resolution of the images correct for large printing?  Using .gif, .jpeg, 

.bmp, .eps, .png, etc. files that are not rendered at a sufficient resolution will 

cause them to blur and be of poor visual quality in your printed poster.  As a 

general rule, use a minimum 300 dots per inch (dpi) when saving images 

created in programs such as Adobe™ Illustrator™, InDesign™, or 

Photoshop™.  Avoid copying and pasting images from the web that are below 

250kb for best results (TTU, 2007). 

 



_______________________________________________________________________________________ 
Guidelines for Creating Accessible Printed Posters  Page 8 of 11 
Gilson & Kitchin, 2007 

Typical Poster Sizes and Use of Space 
• Typical poster sizes are:  

o 40” x Up to 56” 

o 34” x Up to 56” 

o 22” x Up to 56” 

• Know what size is required or available per the conference poster guidelines. 

• Be wary of crowding a small poster.  If possible, have a larger poster and 

utilize more white space to improve access 

 

Figure 5: Crowed white space.   
Notice the block text using insufficient line spacing and under-utilized use 
of white space. 

 

 

Figure 6: Optimized white space.   
Notice increased line spacing and efficient use of white space. 
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Organization of information 

• Location of the poster title should generally be across the top of the page and 

displayed prominently. 

• Headings and sub headings should be displayed in relationship to the 

body/block text they lead. 

• An introduction to the poster should be clear, engage the audience, and 

inform them of the power message to take from the poster. 

• Readers should be logically led in the correct direction from heading to 

heading by a clear narrative and attractive while logical design of the poster. 

(See figure 7). 

 

Figure 7: A Poster Layout 
Notice that the organization flows from the title spanning the top of the 
page to the left column and then reads from the top of each column to the 
bottom progressing from left to right.  Other types of organization are 
useful as well, such as progressively numbering each heading. 
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Providing multiple formats 
Providing multiple formats increases the options for how to access the 
poster.  Increasing options for access is good design (Slatin & Rush, 2002). 

• Poster content should also be provided in the following formats: 

o A data version that allows for the easy alteration of font, type size, and 

interpretation by a screen reader, such as:  

 Microsoft Word™ .doc/.rtf. 

 Html (Webpage) 

o Data versions that can be provided via the web, email, or CD.  CD’s 

can provide the most immediate access to the poster content and be 

handed out during the poster session with printed handouts. 

o Avoid handouts of power point slides.  Text is often extremely reduced, 

rendering it inaccessible.  Use standard letter (8.5 inch by 11 inch) size 

paper with 12-point sans serif fonts. 

o Provide a large print hardcopy.  Large print for standard letter pages is 

at least 18-point text. 
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As increasing numbers of people with dis-
abilities pursue educational opportunities that 
require computer use, accessibility of comput-
ing facilities is critical. The vision is simply 
equal access. Everyone who needs to use your 
lab should be able to do so comfortably. 

Universal Design
To make your lab accessible, employ prin-
ciples of universal design (UD). Universal 
design means that rather than designing your 
facilities and services for the average user, 
it is designed for people with a broad range 
of abilities, disabilities, ages, reading levels, 
learning styles, native languages, cultures, 
and other characteristics. Keep in mind that 
individuals using your lab may have learning 
disabilities or visual, speech, hearing, and mo-
bility impairments. Preparing your computer 
lab accessible to them will minimize the need 
for special accommodations for those who 
use your services and for future employees as 
well. Make sure everyone 

• feels welcome,
• can get to the facility and maneuver within 

it,
• is able to communicate effectively with 

support staff
• is able to access printed materials and elec-

tronic resources, and
• can make use of equipment and software.
 
Train staff to support people with disabilities. 
Have a plan in place to respond to specific ac-
commodation requests in a timely manner. 

Equal Access: Universal Design of Computer 
Labs

Guidelines and Examples
The following questions can guide you in 
making your computer lab universally ac-
cessible. To clarify legal issues, consult your 
campus legal counsel or ADA/504 compli-
ance officer or call your regional Office for 
Civil Rights (OCR). 

First Steps
To begin the process of making your com-
puter lab accessible to everyone, take the 
following steps. 

1. Include students with disabilities in plan-
ning and evaluating lab products and 
services.

2. Develop policies and procedures that 
ensure access to lab facilities, computers, 
and electronic resources for people with 
disabilities. Require that accessibility be 
considered in the procurement process.

3. Ensure that the facility and services are 
wheelchair-accessible and publications can 
be reached from a seated position.

4. In key lab documents, include a state-
ment about your commitment to universal 
access and procedures for requesting dis-
ability-related accommodations.

5. Make signs with high contrast and large 
print.

6. Make key documents available in formats 
accessible to those who have low vision 
and those who are blind (e.g., large print, 
Braille, electronic).

7. Although a lab cannot be expected to 
have specialized equipment for every type 
of disability on hand, staff should make 
equipment available that they anticipate 
will be most often used or that is available 
at relatively low cost. This might include

A checklist for making computer labs welcoming, accessible, and usable
by Sheryl Burgstahler, Ph.D.
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• an adjustable table for each type of 
workstation in your lab; 

• a wrist rest and forearm rest; 
• a trackball; 
• software to modify keyboard response 

such as sticky keys, repeat rate, and 
keystroke delay (that may be available 
in the operating system);

• software to enlarge screen images (that 
may be available in the operating sys-
tem), along with a large monitor;

• large-print keytop labels; and 
• web resources that adhere to accessibil-

ity standards or guidelines adopted by 
the lab.

8. Once a lab is established and serves a large 
number of users, consider adding
• text-to-speech software; 
• scanner and optical character recogni-

tion (OCR) software; 
• CCTV to enlarge printed 

documentation; 
• Braille translation software and printer; 
• word prediction software; 
• hearing protectors; 
• keyboard guards to assist those who 

have limited fine motor skills; 
• alternative keyboards, mini-keyboards, 

or extended keyboards for users with 
mobility impairments; 

• speech input software; and 
• one-handed keyboards or “keyboard 

layout” software. 
9. Develop a procedure to ensure quick 

responses to requests for assistive tech-
nology that you do not currently have 
available or for other disability-related 
accommodations. 

10. Train staff on available accessible products 
in the lab, on appropriate communication, 
and on procedures for addressing requests 
for accommodations. Include accessibility 
issues in all training offered in the lab. 

11. Include people with disabilities when 
addressing accessibility in periodic lab 
evaluations.

Planning, Policies, and Evaluation 
Consider diversity issues as you plan and 
evaluate your computer lab.

 — Are people with disabilities, racial and 
ethnic minorities, men and women, young 
and old students, and other groups repre-
sented on your staff, faculty, and student 
body in numbers proportional to those of 
the whole campus or community?

 — Are people with disabilities, racial and 
ethnic minorities, men and women, young 
and old students, and other groups repre-
sented in lab planning and review process-
es and advisory committees in numbers 
proportional to those of the whole campus 
or community? 

 — Do you have policies and procedures that 
ensure access to facilities, printed materi-
als, computers, and electronic resources 
for people with disabilities?

 — Do policies and procedures require that 
accessibility be considered in the pro-
curement process for software and other 
information technology? (See the federal 
government’s Section 508 Standards for 
Accessible Electronic and Information 
Technology at www.access-board.gov/508.
htm.) 

 — Do you have a procedure to ensure a 
timely response to requests for disability-
related accommodations? 

 — Are disability-related access issues ad-
dressed in your evaluation methods? 

Physical Environments
Ensure physical access, comfort, and safety 
within an environment that is welcoming to 
visitors with a variety of abilities, racial and 
ethnic backgrounds, genders, and ages.

 — Are there parking areas, pathways, and 
entrances to the building that are wheel-
chair-accessible and clearly defined? 

 — Are all levels of the facility connected via 
an accessible route of travel? 
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 — Are there ample high-contrast, large-print 
directional signs to and throughout the 
lab? Is Braille signage available when 
appropriate?

 — Do elevators have auditory, visual, and 
tactile signals and are elevator controls ac-
cessible from a seated position?

 — Are wheelchair-accessible and child-
friendly restrooms with well-marked signs 
available in or near the lab? 

 — Is at least part of a service counter or 
desk at a height accessible from a seated 
position? 

 — Are aisles wide and clear of obstructions 
for wheelchair users who have mobility or 
visual impairments?

 — Is adequate light available?
 — Are there quiet work or meeting areas 
where noise and other distractions are 
minimized and/or facility rules in place 
(e.g., no cell phone use) to minimize noise? 

 — Can at least one public telephone be 
reached from a seated position? 

Lab Staff
Make sure staff are prepared to work with all 
students.

 — Are staff members familiar with the avail-
ability and use of the Telecommunications 
Relay Service, assistive technology, and 
alternate document formats? 

 — Do staff members know how to respond to 
requests for disability-related accommoda-
tions such as sign language interpreters? 

 — Are staff members aware of issues related 
to communicating with students with 
different characteristics regarding race 
and ethnicity, age, and disability? (See the 
Communication Hints at the end of this 
publication.) 

 — Do staff members have ready access to a 
list of on- and off-campus resources for 
students with disabilities?

 — Is the Webmaster knowledgeable about ac-
cessible web design? 

Information Resources and Technology
Ensure that lab publications and websites 
welcome a diverse group and that informa-
tion is accessible to everyone.

 — Do pictures in your publications and web-
site include people with diverse character-
istics with respect to race, gender, age, and 
disability?

 — In key publications, do you include a state-
ment about your commitment to univer-
sal access and procedures for requesting 
disability-related accommodations? For 
example, you could include the following 
statement: “Our goal is to make all materi-
als and services accessible. Please inform 
staff of accessibility barriers you encoun-
ter and request accommodations that will 
make activities and information resources 
accessible to you.” 

 — Are all printed software and hardware 
documentation and other publications 
available (immediately or in a timely man-
ner) in alternate formats such as Braille, 
large print, and electronic text?

 — Are key documents provided in 
language(s) other than English?

 — Are printed materials within easy reach 
from a variety of heights and without fur-
niture blocking access? 

 — Do electronic resources, including web 
pages, adhere to accessibility guidelines 
or standards adopted by your institu-
tion or your specific project or funding 
source? Section 508 Standards for Accessible 
Electronic and Information Technology (www.
access-board.gov/sec508/guide/) and Web 
Accessibility Initiative (WAI) (www.w3.org/
WAI/) are most commonly used. For 
information about making your website 
accessible to everyone, consult World Wide 
Access: Accessible Web Design video and 
publication at www.uw.edu/doit/Video/www.
html. 
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 — Do video presentations used by the lab 
have captions? Audio descriptions?

 — Are accessibility issues incorporated into 
mainstream web design and other technol-
ogy training for students and staff?

 — Is an adjustable-height table available 
for each type of workstation in the lab? 
Can the height be adjusted from a seated 
position?

 — Do some keyboards have large-print key 
labels, Braille labels, or home-row key in-
dicators to help users with visual impair-
ments locate keys? 

 — Is screen enlargement software available 
for users with low vision, perhaps in the 
operating systems of the computers? Is 
a large monitor available so that a larger 
amount of screen can be viewed while 
magnified? 

 — Is a trackball available for those who have 
difficulty controlling a mouse? 

 — Are a wrist rest and forearm rest available 
for those who require extra support while 
typing? 

 — Is equipment marked with large-print and 
Braille labels? 

 — Is software available to modify keyboard 
response, such as sticky keys, repeat rate, 
and keystroke delay, perhaps by making 
accessibility features of operating systems 
readily available? 

 — Is word prediction software available to 
reduce the number of keystrokes needed 
for text entry? 

 — Can controls on computers, printers, scan-
ners, and other information technology be 
reached from a seated position?

 — Are adequate work areas available for 
both right- and left-handed users?

Checklist Updates
This checklist was field tested at more than 
twenty postsecondary institutions nationwide 
(see www.uw.edu/doit/Brochures/Academics/
admin.html). To increase the usefulness of this 
working document, send suggestions to  
sherylb@uw.edu.

Additional Resources
An electronic copy of the most current ver-
sion of this publication can be found at 
www.uw.edu/doit/Brochures/Technology/comp.
access.html. A 10-minute video, Equal Access: 
Universal Design of Computer Labs, dem-
onstrates key points summarized in this 
publication. An online version may be freely 
viewed at www.uw.edu/doit/Video/equal.html or 
purchased in DVD format. 

For further guidelines and suggestions on 
how to create accessible computer labs consult 
the ADA Checklist for Readily Achievable Barrier 
Removal at www.ada.gov/checkweb.htm. 

A useful online interactive tool for learning 
about IT accessibility and managing your 
lab’s IT accessibility goals is the Information 
Technology in Education Accessibility Checklist at 
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www.uw.edu/accessit/it-checklist/. For more in-
formation about assistive technology, consult 
the videos and publications at www.uw.edu/
doit/Resources/technology.html.

The Student Services Conference Room at www.
uw.edu/doit/Conf/ includes a collection of docu-
ments and videos to help you make student 
services accessible to everyone. Included are 
checklists for career services, distance learning, 
computer labs, recruitment and admissions, 
registration, housing and residential life, 
financial aid, libraries, tutoring and learning 
centers, and student organizations. The Student 
Services Conference Room also hosts a searchable 
Knowledge Base of questions and answers, case 
studies, and promising practices. 

For more information about applications of 
universal design consult www.uw.edu/doit/
Resources/udesign.html or The Center for Universal 
Design in Education at www.uw.edu/doit/CUDE/. 
The book Universal Design in Higher Education: 
From Principles to Practice published by Harvard 
Education Press shares perspectives of UD 
leaders nationwide. To receive a 20% discount, 
visit www.uw.edu/doit/UDHE/coupon.html.

About DO-IT
DO-IT (Disabilities, Opportunities, 
Internetworking, and Technology) serves to 
increase the successful participation of indi-
viduals with disabilities in challenging academic 
programs such as those in science, engineering, 
mathematics, and technology. Primary funding for 
the DO-IT program is provided by the National 
Science Foundation, the State of Washington, and 
the U.S. Department of Education. 

For further information, to be placed on the DO-IT 
mailing list, request materials in an alternate for-
mat, or to make comments or suggestions about 
DO-IT publications or web pages, contact:

DO-IT 
University of Washington 
Box 354842 
Seattle, WA 98195-4842 
doit@uw.edu
www.uw.edu/doit/
206-685-DOIT (3648) (voice/TTY) 
888-972-DOIT (3648) (toll free voice/TTY) 
509-328-9331 (voice/TTY) Spokane 
206-221-4171 (fax) 
Founder and Director: Sheryl Burgstahler, Ph.D.
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Communication Hints
 
Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to relating to people with disabilities. However, here are 
some helpful hints. 
General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining—it’s liberating!

• Do not interact with a person’s guide dog or service dog unless you have received permission 
to do so.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• Speak all of the content presented with overhead projections and other visuals.
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer directions or instructions both orally and in writing. If asked, read instructions to 

individuals who have specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• In groups raise hands to be recognized so the person who is deaf knows who is speaking. 

Repeat questions from audience members.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.



Equal Access: Universal Design of Libraries

Libraries play an important role in ensuring 
that everyone has access to information in 
printed and electronic forms. In making these 
resources accessible and useful to everyone, 
principles of universal design (UD) can be 
employed. 

Legal Issues
Section 504 of the Rehabilitation Act of 1973, 
the Americans with Disabilities Act of 1990, 
and the Americans with Disabilities Act 
Amendments of 2008 prohibit discrimina-
tion against individuals with disabilities. 
According to these laws, no otherwise quali-
fied person with a disability shall, solely by 
reason of his or her disability, be excluded 
from the participation in, be denied the 
benefits of, or be subjected to discrimination 
under any program or activity of a public 
entity. “Person with a disability” means “any 
person who has a physical or mental impair-
ment which substantially limits one or more 
major life activities including walking, seeing, 
hearing, speaking, breathing, learning, and 
working, has a record of such an impairment, 
or is regarded as having such an impairment.”

Universal Design
Universal design (UD) means that rather than 
designing your facility and services for the av-
erage user, you design them for people with a 
broad range of abilities, disabilities, and other 
characteristics—such as age, reading ability, 
learning style, language, culture, and others. 
Keep in mind that students and other visi-
tors may have learning disabilities or visual, 
speech, hearing, and mobility impairments. 
Making your library accessible to them will 
make it more usable by everyone and mini-
mize the need for special accommodations for 
those who use your services and for future 

employees as well. Ensure that everyone feels 
welcome, and can
• get to the library facility and maneuver 

within it,
• communicate effectively with support 

staff,
• access printed materials and electronic 

resources, and
• fully participate in events and other 

activities.

Train staff to support people with disabilities, 
respond to specific requests for accommoda-
tions in a timely manner, and know whom 
they can contact if they have disability-related 
questions. 

Guidelines and Examples
The following questions can guide you in 
making your library accessible to everyone. 
This content does not provide legal advice. To 
help clarify issues, consult your institution’s 
legal counsel or ADA/504 compliance officer 
or call the regional Office for Civil Rights 
(OCR) can also help clarify issues.

A checklist for making libraries welcoming, accessible, and usable
by Sheryl Burgstahler, Ph.D.
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Planning, Policies, and Evaluation
Consider diversity issues as you plan and 
evaluate services.

 — Are people with disabilities, racial and 
ethnic minorities, men and women, young 
and old students, and other groups repre-
sented on your staff in numbers propor-
tional to those of the whole campus or 
community?

 — Does the library have a written policy and 
description of services for patrons with 
disabilities, including information on how 
to request accommodations? 

 — Is accessibility included in the procure-
ment of library holdings?

 — Does the library have a procedure in place 
that ensures timely response to requests 
for disability-related accommodations and 
other special assistance?

 — Are disability-related access issues ad-
dressed in your evaluation methods?

Physical Environments and Products 
Ensure physical access, comfort, and safety 
within an environment that is inclusive of 
people with a variety of abilities, racial and 
ethnic backgrounds, genders, and ages.

 — Are there parking areas, pathways, and 
entrances to the library that are wheel-
chair-accessible and clearly identified? 

 — Are all levels of the library connected via 
an accessible route of travel, or are there 
procedures to assist patrons with mobility 
impairments in retrieving materials from 
inaccessible locations?

 — Do elevators have auditory, visual, and 
tactile signals and are elevator controls ac-
cessible from a seated position? 

 — Are wheelchair-accessible restrooms with 
well marked signs available in or near the 
library?

 — Are information desks and facilities such 
as book returns wheelchair accessible?

 — Are aisles kept wide and clear of obstruc-
tions for the safety of users who have 
mobility or visual impairments?

 — Are there ample high-contrast, large print 
directional signs throughout the library? 
Are shelf and stack identifiers provided 
in large print and Braille formats? Are call 
numbers on book spines printed in large 
type? Is equipment marked with large 
print and Braille labels?

 — Is adequate light available?
 — Are private study areas available for pa-
trons with disabilities who need to bring 
personal equipment, who need the assis-
tance of a reader, or who are distracted by 
noise and movement around them?

Library Staff
Make sure staff are prepared to work with all 
patrons.

 — Are all staff members aware of issues 
related to communicating with patrons of 
different races and ethnicities, ages, and 
abilities? (See Communication Hints at the 
end of this publication for suggestions.)

 — Are staff trained in the use of  the 
Telecommunications Relay Service, as well 
as assistive computer technology provided 
in the library? 

 — Are staff trained in policies and proce-
dures for providing accommodations to 
patrons with disabilities? 

 — Do staff members have ready access 
to a list of resources for patrons with 
disabilities?
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 — Are staff knowledgeable about federally-
funded Talking Book and Braille Libraries 
and other organizations that provide rel-
evant services to patrons with disabilities?

 — Do service staff wear large-print name 
badges?

 — If there are staff members with sign lan-
guage skills, are they identified to other 
staff members so that, when available, 
they can assist patrons who are deaf? 

Information Resources and Technology
Ensure that publications and websites 
welcome a diverse group and content is acces-
sible to everyone.

 — Can the library’s electronic and infor-
mation resources, including web pages, 
online catalogs, indexes, and full-text da-
tabases and CD-ROMs, be accessed with a 
variety of adaptive computer technologies 
such as screen readers?

 — Are librarians prepared to assist patrons 
with inaccessible electronic resources by 
providing consultations or materials in 
other formats?

 — Are reader and research assistants avail-
able to patrons with visual impairments?

 — Are reference and circulation services 
available by both phone and email?

 — Are resource delivery services available 
for patrons unable to leave their homes, 
retirement facilities, or hospitals?

 — Are applications for the nationwide net-
work of Talking Book and Braille Libraries 
available for patrons with print-related 
disabilities?

 — In key publications and on your website, 
do you include a statement about your 
commitment to universal access and pro-
cedures for requesting disability-related 
accommodations? For example, “Our 
library’s goal is to make all materials and 
activities accessible. Please inform project 

staff of accessibility barriers you encounter 
and of accommodations that will make 
information resources accessible to you.”

 — Are all printed library publications avail-
able (immediately or in a timely manner) 
in alternate formats such as Braille, large 
print, and electronic text? 

 — Are key documents provided in languages 
other than English?

 — Do electronic resources, including web 
pages, adhere to accessibility guide-
lines adopted by your institution or 
library? Section 508 Standards for Accessible 
Electronic and Information Technology (www.
access-board.gov/508) and Web Content 
Accessibility Guidelines (WCAG) (www.
w3.org/WAI/intro/wcag.php) are most com-
monly used. For general information 
about making your website accessible 
to everyone, consult World Wide Access: 
Accessible Web Design video and publica-
tion at www.uw.edu/doit/Video/www.html.

 — Do you include a statement on your web-
site affirming your commitment to acces-
sible design? For example, “We strive to 
make our website universally accessible. 
We provide text descriptions of graphics 
and photos. Video clips are open-cap-
tioned and audio-described, providing 
access to users who can’t hear the audio or 
see the video, respectively. Suggestions for 
increasing the accessibility of these pages 
are welcome.”

 — Do videos developed or used in the library 
have captions? For more information, con-
sult Creating Video and Multimedia Products 
That Are Accessible to People with Sensory 
Impairments at www.uw.edu/doit/Brochures/
Technology/vid_sensory.html.

 — Is an adjustable-height table available for 
each type of workstation to assist students 
who use wheelchairs or are small or large 
in stature? 

http://www.access-board.gov/508
http://www.access-board.gov/508
http://www.w3.org/WAI/intro/wcag.php
http://www.w3.org/WAI/intro/wcag.php
http://www.washington.edu/doit/Video/www.html
http://www.washington.edu/doit/Brochures/Technology/vid_sensory.html
http://www.washington.edu/doit/Brochures/Technology/vid_sensory.html
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 — Do you provide adequate work space for 
both left- and right-handed users?

 — Is software to enlarge screen images and a 
large monitor available to assist students 
with low vision and learning disabilities?

 — Do you provide a trackball to be used by 
someone who has difficulty controlling a 
mouse? 

 — Are wrist and forearm rests available 
to assist some people with mobility 
impairments?

 — Are staff members aware of accessibil-
ity options (e.g., enlarged text feature) 
included in computer operating systems 
and of assistive technology available in the 
facility?

 — Are procedures in place for a timely 
response to requests for assistive technol-
ogy?  

Events 
Ensure that everyone feels welcome and 
can participate in events sponsored by the 
organization.

 — Are events located in wheelchair-acces-
sible facilities? Is the accessible entrance 
clearly marked? 

 — Is information about how to request dis-
ability-related accommodations included 
in publications promoting events?

 — Is accessible transportation available if 
transportation is arranged for other  
participants?

Checklist Updates
This checklist was field tested at more than 
twenty postsecondary institutions nationwide 
(see www.uw.edu/doit/Brochures/Academics/
admin.html). A nationwide survey to test 
face-validity of checklist items led to further 
refinement of the checklist. To increase the 
usefulness of this working document, send 
suggestions to sherylb@uw.edu.

Additional Resources
An electronic copy of the most current version 
of this publication as well as additional useful 
brochures can be found at www.uw.edu/doit/
Brochures/. A 10-minute video, Equal Access: 
Campus Libraries, demonstrates key points 
summarized in this publication. It may be 
freely viewed online and purchased in DVD 
format from DO-IT. Consult www.uw.edu/doit/
Video/ for access to this and other videos that 
may be of interest. Permission is granted to 
reproduce DO-IT videos and publications for 
educational, noncommercial purposes pro-
vided the source is acknowledged. 

For more information about making your 
library accessible to everyone, consult The 
Student Services Conference Room at www.
uw.edu/doit/Conf/. It includes checklists for 
career services, distance learning, computer 
labs, recruitment and admissions, registration, 
housing and residential life, financial aid, 
libraries, tutoring and learning centers, and 
student organizations. The Student Services 
Conference Room also includes a searchable 
Knowledge Base of questions and answers, 
case studies, and promising practices. 

http://www.washington.edu/doit/Brochures/Academics/admin.html
http://www.washington.edu/doit/Brochures/Academics/admin.html
mailto:sherylb@uw.edu
http://www.washington.edu/doit/Brochures/
http://www.washington.edu/doit/Brochures/
http://www.washington.edu/doit/Video/
http://www.washington.edu/doit/Video/
http://www.washington.edu/doit/Conf/
http://www.washington.edu/doit/Conf/
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For more information about applications 
of universal design consult www.uw.edu/
doit/Resources/udesign.html or The Center for 
Universal Design in Education at www.uw.edu/
doit/CUDE/. The book Universal Design in Higher 
Education: From Principles to Practice published 
by Harvard Education Press shares perspectives 
of UD leaders nationwide. To receive a 20% dis-
count visit www.uw.edu/doit/UDHE/coupon.html. 

About DO-IT
DO-IT (Disabilities, Opportunities, 
Internetworking, and Technology) serves 
to increase the successful participation of 
individuals with disabilities in challenging 
academic programs and careers, such as those 
in science, engineering, mathematics and 
technology. Primary funding for DO-IT is pro-
vided by the National Science Foundation, the 
U.S. Department of Education, and the State 
of Washington. 

For further information, to be placed on the 
DO-IT mailing list, request materials in an 
alternate format, or to make comments or 
suggestions about DO-IT publications or web 
pages, contact:

DO-IT 
University of Washington 
Box 354842 
Seattle, WA 98195-4842 
doit@uw.edu
www.uw.edu/doit/
206-685-DOIT (3648) (voice/TTY) 
888-972-DOIT (3648) (toll free voice/TTY)  
509-328-9331 (voice/TTY) Spokane 
206-221-4171 (fax) 
Founder and Director: Sheryl Burgstahler, Ph.D.

University of Washington
College of Engineering
UW Technology Services
College of Education

Grants and gifts fund DO-IT publications, videos, 
and programs to support the academic and career 
success of people with disabilities. Contribute 
today by sending a check to DO-IT, Box 355670, 
University of Washington, Seattle, WA 98195-5670.

Your gift is tax deductible as specified in IRS regula-
tions. Pursuant to RCW 19.09, the University of 
Washington is registered as a charitable organization 
with the Secretary of State, State of Washington. For 
more information, call the Office of the Secretary of 
State, 800-322-4483.
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01/02/14

Communication Hints
 
Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to relating to people with disabilities. However, here are 
some helpful hints. 
General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining— it’s liberating!

• Do not interact with a person’s guide dog or service dog unless you have received permission 
to do so.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• Speak all of the content presented with overhead projections and other visuals.
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer directions or instructions both orally and in writing. If asked, read instructions to 

individuals who have specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• In groups raise hands to be recognized so the person who is deaf knows who is speaking. 

Repeat questions from audience members.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.



Equal Access: Universal Design of Student  
Services

As increasing numbers of people with 
disabilities pursue educational opportunities at 
all levels, the accessibility of admissions offices, 
libraries, computer labs, tutoring centers, and 
other student services increases in importance. 
The goal is simply equal access; everyone who 
needs to use your services should be able to do 
so comfortably and efficiently. 

Legal Issues
Section 504 of the Rehabilitation Act of 1973, the 
Americans with Disabilities Act of 1990, and 
its 2008 Amendments prohibit discrimination 
against individuals with disabilities. According 
to these laws, no otherwise qualified person 
with a disability shall, solely by reason of 
his or her disability, be excluded from the 
participation in, be denied the benefits of, or be 
subjected to discrimination under any program 
or activity of a public entity. This means that 
student services as well as academic programs 
must be accessible to qualified students with 
disabilities.

Universal Design
You can make your student service accessible 
and useful to everyone by employing principles 
of universal design (UD). Universal design 
means that rather than designing your facility 
and services for the average user, you design 
them for people with a broad range of abilities, 
disabilities, ages, reading levels, learning 
styles, native languages, cultures, and other 
characteristics. Keep in mind that students and 
other visitors may have learning disabilities 
or visual, speech, hearing, and mobility 
impairments. Preparing your program to be 
accessible to them will make it more usable by 
everyone and minimize the need for special 

accommodations for those who use your 
services and for future employees as well. Make 
sure everyone feels welcome, and can
• get to the facility and maneuver within it,
• communicate effectively with support staff,
• access printed materials and electronic 

resources, and 
• fully participate in events and other 

activities. 

Train staff to support people with disabilities, 
respond to specific requests for 
accommodations in a timely manner, and know 
whom they can contact if they have disability-
related questions. 

A Process for Universal Design
the UD of all student services is a long-term 
goal. Deliberate, small steps can make that 
goal attainable for your service department. 
Below you will find a series of steps to lead you 
through the re-design of an existing service or 
the creation of a new one. As you travel through 
the phases of implementing UD, remember 
to plan ahead and keep the diverse needs of 
students at the forefront. 
1. Identify the service. Select a student service 

(e.g., library, tutoring center, career services 
office). Consider the purpose of the campus 
unit, specific services and resources 
provided, facility constraints, budget, and 
other issues that impact the range and 
delivery of services provided.

2. Define the universe. Describe the overall 
population and then consider the diverse 
characteristics of those who might 
potentially use the service (e.g., students and 
other visitors with diverse characteristics 
with respect to gender; age; size; ethnicity 

A checklist for making campus services welcoming, accessible, and usable
by Sheryl Burgstahler, Ph.D.
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and race; native language; learning style; 
and abilities to see, hear, manipulate objects, 
read, and communicate).

3. Involve consumers. Involve people with 
diverse characteristics (as identified in 
Step 2) in all phases of the development, 
implementation, and evaluation of the 
service. Also, gain perspectives of students 
through diversity programs such as the 
campus disability services office.

4. Adopt guidelines or standards. Review 
research and best practices to identify 
specific strategies for the delivery of an 
effective service (e.g., best practices for 
housing and food services, career services, 
a tutoring center, or other services as 
identified in Step 1). Create or select existing 
universal design guidelines and standards 
for the service. Integrate universal design 
practices with other best practices within the 
field of service.

5. Apply guidelines or standards. Apply universal 
design strategies in concert with other 
best practices, both identified in Step 4, 
to the overall design of the service, all 
subcomponents of the service, and all 
ongoing operations (e.g., procurement 
processes, staff training) to maximize the 
benefit of the service to students with the 
wide variety of characteristics identified in 
Step 2.

6. Plan for accommodations. Develop processes 
to address accommodation requests 
(e.g., arrangements for a sign language 
interpreter) from individuals for whom the 
design of the service does not automatically 
provide access. Share the process in signage, 
publications, and on a website.

7. Train and support. Tailor and deliver ongoing 
training and support to student service staff.

8. Evaluate. Include universal design measures 
in the evaluation of the service; evaluate the 
service with a diverse group of students; 
and make modifications based on their 

feedback. Provide ways to collect ongoing 
input from service users (e.g., through 
online and printed instruments and 
communications with staff). 

Guidelines and Examples
The following questions can guide you in 
making your campus service unit universally 
accessible. This content does not provide legal 
advice. To clarify issues, consult your campus 
legal counsel or ADA/504 compliance officer, or 
call the regional Office for Civil Rights (OCR). 
This checklist was developed in consultation 
with more than twenty postsecondary 
institutions as part of the AccessCollege project. 
It was field-tested at more than twenty 
postsecondary institutions nationwide.7 The 
results of a nationwide survey to test face-
validity of checklist items led to further 
refinement of the checklist. 

Planning, Policies, and Evaluation
Consider diversity issues as you plan and 
evaluate services.

 — Are people with disabilities, racial and 
ethnic minorities, men and women, 
young and old students, and other groups 
represented on your staff in numbers 
proportional to those of the whole campus 
or community?

 — Do you have policies and procedures that 
ensure access to facilities, printed materials, 
computers, and electronic resources for 
people with disabilities?

 — Is accessibility considered in the 
procurement process?

 — Do you have a procedure to ensure a timely 
response to requests for disability-related 
accommodations?

 — Are disability-related access issues 
addressed in your evaluation methods? 

Physical Environments and Products
Ensure physical access, comfort, and safety 
within an environment that is inclusive of 

http://www.washington.edu/doit/Brochures/Academics/admin.html
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people with a variety of abilities, racial and 
ethnic backgrounds, genders, and ages. 

 — Are there parking areas, pathways, 
and entrances to the building that are 
wheelchair-accessible and clearly identified?

 — Are all levels of the facility connected via an 
accessible route of travel?

 — Are there ample high-contrast, large-print 
directional signs to and throughout the 
office? 

 — Do elevators have auditory, visual and 
tactile signals and are elevator controls 
accessible from a seated position? 

 — Are wheelchair-accessible restrooms with 
well-marked signs available in or near the 
office?

 — Are universally-recognized icons used on 
signage?

 — Is at least part of a service counter or desk at 
a height accessible from a seated position?

 — Are aisles kept wide and clear of 
obstructions for the safety of users who have 
mobility or visual impairments?

 — Are there quiet work or meeting areas where 
noise and other distractions are minimized 
and/or facility rules in place (e.g., no cell 
phone use) that minimize noise?

 — Is adequate light available?

Consult the ADA Checklist for Readily Achievable 
Barrier Removal1 for more suggestions. For 
computing facilities, consult Equal Access: 
Universal Design of Computer Labs video and 
publication.2

Staff
Make sure staff are prepared to work with all 
students.

 — Are all staff members familiar 
with the availability and use of the 
Telecommunications Relay Service and 
alternate document formats?

 — Do staff members know how to respond 
to requests for disability-related 
accommodations, such as sign language 

interpreters?
 — Are all staff members aware of  issues 

related to communicating with students 
of different races and ethnicities, ages, 
and students who have disabilities? (See 
Communication Hints at the end of this 
publication.)

Information Resources and Technology
If your service unit uses computers as 
information resources, ensure these systems 
employ accessibility options, and systems are in 
place to make accommodations.

 — Do pictures in your publications and website 
include people with diverse characteristics 
with respect to race, gender, age, and 
disability?

 — In key publications and on your website, 
do you include a statement about your 
commitment to universal access and 
procedures for requesting disability-related 
accommodations? For example, you could 
include the following statement: “Our 
goal is to make all materials and services 
accessible. Please inform staff of accessibility 
barriers you encounter and request 
accommodations that will make activities 
and information resources accessible to 
you.”

 — Are all printed publications available 
(immediately or in a timely manner) in 
alternate formats such as Braille, large print, 
and electronic text? 

 — Are key documents provided in a 
language(s) other than English?

 — Are printed materials within easy reach 
from a variety of heights and without 
furniture blocking access?

 — Do electronic resources, including web 
pages, adhere to accessibility guidelines 
or standards adopted by your institution 
or your specific project or funding source? 
Section 508 Standards for Accessible Electronic 
and Information Technology3 and the World 
Wide Web Consortium’s Accessibility 
Guidelines4 are most commonly used. For 
information about making your website 
accessible to everyone, consult the World 

http://www.ada.gov/checkweb.htm
http://www.ada.gov/checkweb.htm
http://www.washington.edu/doit/Video/equal.html
http://www.washington.edu/doit/Video/equal.html
http://www.washington.edu/doit/Video/equal.html
http://www.access-board.gov/sec508/guide/
http://www.access-board.gov/sec508/guide/
http://www.w3.org/WAI/
http://www.w3.org/WAI/
www.washington.edu/doit/Video/www.html
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Wide Access: Accessible Web Design video and 
publication.5

 — Are videos used by your service captioned? 
 — Is an adjustable-height table available for 

each type of workstation to assist students 
who use wheelchairs or are small or large in 
stature? 

 — Do you provide adequate work space for 
both left- and right-handed users? 

 — Is software to enlarge screen images and a 
large monitor available to assist students 
with low vision and learning disabilities?

 — Do you provide a trackball to be used by 
someone who has difficulty controlling a 
mouse? 

 — Are staff members aware of accessibility 
options (e.g., enlarged text feature) included 
in computer operating systems and of 
assistive technology available in the facility?

 — Are procedures in place for a timely 
response to requests for assistive 
technology?

Note that your organization need not have 
special technology on hand for every type of 
disability but should have available assistive 
technology that can benefit many people. For 
more information about adaptive technology, 
consult the videos and publications.6

Events 
Ensure that everyone can participate in events 
sponsored by your organization.

 — Are events located in wheelchair- 
accessible facilities? Is the accessible 
entrance clearly marked? 

 — Is information about how to request  
disability-related accommodations included 
in publications promoting events?

 — Is accessible transportation available if 
transportation is arranged for other  
participants?

Checklist Updates
To increase the usefulness of this working 
document, send suggestions to sherylb@uw.edu. 
Each item, in keeping with the UD approach, 
should reflect a proactive practice that makes 
a student service more welcoming, accessible, 
and usable by students with a wide range of 
characteristics.

Additional Resources
An electronic copy of the most current version 
of this publication as well as additional 
useful brochures are available online.8 A 
14-minute video, Equal Access: Student Services9, 
demonstrates key points summarized in 
this publication. An online version may be 
freely viewed or purchased in DVD format. 
Permission is granted to reproduce DO-IT 
videos and publications for educational, 
noncommercial purposes provided the source is 
acknowledged. 

The Student Services Conference Room10 includes a 
collection of documents and videos to help you 
make student services accessible to everyone. 
They include checklists for career services, 
distance learning, computer labs, recruitment 
and admissions, registration, housing and 
residential life, financial aid, libraries, tutoring 
and learning centers, and student organizations. 
The Conference Room also includes a searchable 
Knowledge Base of questions and answers, case 
studies, and promising practices. 

For more information about applications of 
universal design consult The Center for Universal 
Design in Education website,11 or the book 
Universal Design in Higher Education: From 
Principles to Practice published by Harvard 
Education Press. To receive a 20% discount visit 
the DO-IT website.12

www.washington.edu/doit/Video/www.html
www.washington.edu/doit/Video/www.html
http://www.washington.edu/doit/Resources/at.html
mailto:sherylb@uw.edu
http://www.washington.edu/doit/Brochures/
http://www.washington.edu/doit/Video/ea_student.html
http://www.washington.edu/doit/Conf/
http://www.uw.edu/doit/CUDE/
http://www.uw.edu/doit/CUDE/
http://www.uw.edu/doit//UDHE/coupon.html
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Communication Hints
 
Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to relating to people with disabilities. However, here are 
some helpful hints. 
General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining—it’s liberating!

• Do not interact with a person’s guide dog or service dog unless you have received permission 
to do so.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• Speak all of the content presented with overhead projections and other visuals.
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer directions or instructions both orally and in writing. If asked, read instructions to 

individuals who have specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• In groups raise hands to be recognized so the person who is deaf knows who is speaking. 

Repeat questions from audience members.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.



Equal Access: Universal Design of Recruitment and 
Undergraduate Admissions

The admissions office is the gateway to two-
year colleges, vocational technical institutes, 
and universities, and it plays a central role in 
informing students and parents about campus 
programs and services. People with disabilities 
represent a significant and visible portion of 
those seeking information and admission. This 
publication identifies
• key access issues for recruitment and admis-

sions offices,
• disability-related issues with respect to ad-

mission policies and activities, and
• resources for additional information.

Legal Issues 
Section 504 of the Rehabilitation Act of 1973, the 
Americans with Disabilities Act of 1990, and the 
Americans with Disabilities Act Amendments of 
2008 prohibit discrimination against individu-
als with disabilities. According to these civil 
rights laws and corresponding regulations, no 
otherwise qualified person with a disability 
shall, solely by reason of his/her disability, be 
excluded from the participation in, be denied 
the benefits of, or be subjected to discrimina-
tion under any program or activity of a public 
entity. Program participants, as defined in the 
ADA and Section 504, include not only current 
and prospective students but also parents or 
other individuals with disabilities who seek 
information or participate in recruitment- or 
admissions-sponsored activities. 

Prospective and current students as well as visi-
tors may have learning disabilities and visual, 
speech, hearing, and mobility impairments. 
Keep in mind that most students with disabili-
ties have nonvisible disabilities such as learning 
disabilities, Attention-Deficit/Hyperactivity 
Disorder (ADHD), depression, and health 
impairments. With respect to recruitment and 

admissions office policies and procedures, ADA 
and Section 504 prohibit preadmission inquiries 
about disabling conditions, and prohibit limit-
ing the number or proportion of students with 
disabilities admitted or using tests or criteria for 
admission that have a disproportionate adverse 
effect on applicants with disabilities. 

Universal Design
To make your admissions or recruitment of-
fice accessible and useful to everyone, employ 
principles of universal design (UD). Universal 
design means that rather than designing your 
facility and services for the average user, you 
design them for people with a broad range of 
abilities, disabilities, ages, reading levels, learn-
ing styles, native languages, cultures, and other 
characteristics. Keep in mind that students and 
other visitors may have learning disabilities or 
visual, speech, hearing, and mobility impair-
ments. Preparing your program to be accessible 
to them will make it more usable by everyone 
and minimize the need for special accommoda-
tions for those who use your services and for 
future employees as well. Make sure everyone 
feels welcome, and can
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• get to the facility and maneuver within it,
• communicate effectively with support staff,
• access printed materials and electronic re-

sources, and
• fully participate in events and other 

activities.

Train staff to support people with disabilities, 
respond to specific requests for accommoda-
tions in a timely manner, and know whom 
they can contact if they have disability-related 
questions. 

Guidelines and Examples
The following questions can guide you in mak-
ing your campus service unit more inclusive. 
This content does not provide legal advice. To 
help clarify legal issues, consult your campus 
legal counsel or ADA/504 compliance officer or 
call your regional Office for Civil Rights (OCR).

Planning, Policies, and Evaluation
Consider diversity issues as you plan and 
evaluate services.

 — Are people with disabilities, racial and eth-
nic minorities, men and women, young and 
old students, and other groups represented 
on your staff in numbers proportional to 
those of the whole campus or community? 

 — Do you have policies and procedures that 
ensure access to facilities, printed materi-
als, computers, and electronic resources for 
people with disabilities?

 — Is accessibility considered in the procure-
ment process? 

 — Do you have a procedure to ensure a timely 
response to requests for disability-related 
accommodations? 

 — Are disability-related access issues ad-
dressed in your evaluation methods? 

Physical Environments and Products 
Ensure physical access, comfort, and safety 
within an environment that is inclusive of peo-
ple with a variety of abilities, racial and ethnic 
backgrounds, genders, and ages.

 — Are there parking areas, pathways, and 
entrances to the admissions office that are 
wheelchair-accessible and clearly identified? 

 — Are all levels of the facility connected via an 
accessible route of travel? 

 — Are there ample high-contrast large print di-
rectional signs to and throughout the office?

 — Do elevators have auditory, visual, and 
tactile signals and are elevator controls ac-
cessible from a seated position?

 — Are wheelchair-accessible restrooms with 
well marked signs available in or near the 
admissions office? 

 — Is at least part of a service desk or counter in 
the admissions office at a height accessible 
from a seated position? 

 — Are there private meeting areas where stu-
dents can discuss disability-related needs 
confidentially? 

 — Is adequate light available?

Consult the ADA Checklist for Readily Achievable 
Barrier Removal at www.ada.gov/checkweb.htm 
for more suggestions. For computing facili-
ties, consult the Equal Access: Universal Design 
of Computer Labs video and publication at www.
uw.edu/doit/Video/equal.html. 

Staff 
Make sure staff are prepared to work with cur-
rent and potential students.

 — Do all staff know how to respond to requests 
for disability-related accommodations, such 
as sign language interpreters, large-print 
publications, or sighted guide assistance for 
a visitor who is blind? 

 — Are staff members greeting the public in 
person or by telephone aware of issues 
related to communicating with visitors 
and students who have disabilities? (See 
Communication Hints for suggestions.) 
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 — Do staff have access to a current list of key 
campus offices or programs that offer dis-
ability-related assistance in order to respond 
to telephone, email, or visitor requests for 
information or assistance? This list might 
include contacts for disabled student ser-
vices, wheelchair-accessible transportation, 
assistive technology, accessible housing, and 
special types of financial aid. 

 — Do staff have basic knowledge of accessible 
travel routes to effectively direct visitors 
with disabilities to the office and to other 
key locations on campus? 

 — Is the office webmaster knowledgeable 
about accessible web design? Consult the 
video and publication World Wide Access: 
Accessible Web Design (www.uw.edu/doit/Video/
www.html) for further information. 

Information Resources and Technology
Ensure that publications and websites welcome 
a diverse group that the content is accessible to 
everyone. 

 — Do pictures in your publications and web-
site include people with diverse character-
istics with respect to race, gender, age, and 
disability?

 — In key publications and on your website, do 
you include a statement about your commit-
ment to universal access and procedures for 
requesting disability-related accommoda-

tions? For example, you could include the 
following statement, “Our goal is to make 
all materials and services accessible. Please 
inform staff of accessibility barriers you 
encounter and request accommodations 
that will make activities and information 
resources accessible to you.”

 — Are all printed publications available (im-
mediately or in a timely manner) in alternate 
formats such as Braille, large print, and 
electronic text? This includes admission ap-
plications and instructions, housing applica-
tions, and academic program applications as 
well as the campus catalogue and other key 
publications such as academic department 
publications distributed by admissions.  

 — Are key documents provided in language(s) 
other than English?

 — Does the campus map include sufficient 
disability access information (e.g., dis-
abled parking locations, accessible building 
entrances) to assist prospective and newly 
admitted students and other visitors with 
disabilities who are unfamiliar with the 
campus? 

 — Are videos used by admissions and re-
cruitment staff captioned? This applies to 
materials used on- or off-campus for exhib-
its, group presentations, or other events. 
Additionally, if videos about the campus are 
sent to prospective students, captioned for-
mats should be available upon request and 
so noted in admissions publications. 

 — Do electronic resources, including web 
pages and online admissions forms, adhere 
to accessibility guidelines or standards 
adopted by the institution or your of-
fice? Section 508 Standards for Accessible 
Electronic and Information Technology (www.
access-board.gov/508.htm) and World Wide 
Web Consortium’s Web Content Accessibility 
Guidelines (www.w3.org/WAI/) are most com-
monly used.  For general information about 
making your website accessible to everyone, 
consult the World Wide Access: Accessible Web 
Design video and publication at www.uw.edu/
doit/Video/www.html. 
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 — Is an adjustable-height table available for 
each type of workstation to assist students 
who use wheelchairs or are small or large in 
stature? 

 — Do you provide adequate work space for 
both left- and right-handed users?

 — Is software to enlarge screen images and a 
large monitor available to assist students 
with low vision and learning disabilities?

 — Do you provide a trackball to be used by 
someone who has difficulty controlling a 
mouse? 

 — Are staff members aware of accessibility op-
tions (e.g., enlarge text feature) included in 
computer operating systems and of assistive 
technology available in the facility?

 — Are procedures in place for a timely re-
sponse to requests for assistive technology?

Recruitment Events and Campus Tours 
Ensure that everyone feels welcome and can 
participate in all recruitment events and campus 
tours. If an event or program is sponsored by 
your office, publicize procedures about and ar-
range for accommodations for participants with 
disabilities. 

 — Are events that are sponsored by your office 
located in wheelchair-accessible facilities? 
Is the accessible entrance and travel route 
clearly marked? 

 — Is information about how to request dis-
ability-related accommodations included in 
publications promoting events?

 — Are procedures in place to ensure a timely 
response to requests for accommodations 
for on- and off-campus events? Common 
accommodation requests include sign 
language interpreters, alternate document 
formats, and accessible seating. 

 — Does your listing of recruitment and out-
reach organizations and schools include 
organizations for individuals with disabili-
ties? This list could include community in-
dependent living programs, state vocational 
rehabilitation agencies, high school-to-col-
lege transition programs, high school-high 

tech programs, the state agency or com-
mission for the blind, and local chapters of 
the Learning Disabilities Association. Your 
campus disabled students services office 
can assist you in identifying local and state 
organizations such as these. 

 — Does the admissions office have procedures 
in place to handle requests by visitors with 
disabilities for a special tour or an additional 
tour to get more detailed information about 
campus access features? These requests may 
best be met in cooperation with the disabled 
student services office. 

Applications and Disclosure 
Review your applications for admission to ensure 
that disability-related issues are handled properly.

 — Are you careful not to ask preadmission 
questions about disabling conditions or ac-
commodation needs? 

 — Have you been careful not to impose limita-
tions on the number or proportion of stu-
dents with disabilities who may be admitted 
to the university or to an academic depart-
ment or major? 

 — In publications and on web pages, do you 
tell applicants how to request accommoda-
tions for admissions tests? 

 — If an applicant voluntarily discloses disabili-
ties on the application or appends disabil-
ity-related information with the application, 
does the admissions office have a procedure 
to separate it from the applicant’s file and 
place it in a separate, secure location where 
it can later be forwarded to the disabled 
student services office?

 — Do admissions counselors avoid seeking out 
disability-related information or accom-
modation needs when an applicant visits or 
calls the admissions office? 

 — Are campus tour staff trained to act as sight-
ed guides for blind individuals? The campus 
disabled student services office may provide 
assistance in this area. 



5

Evaluation of Applications and Appeals
 — Have those who evaluate applications re-

ceived training about disabling conditions, 
possible educational impacts of disability, 
and how these may be reflected in prior 
educational records? This is especially im-
portant if personal or educational impacts 
are discussed by applicants in their essays. 

 — Do those who evaluate applications under-
stand that some students with disabilities 
(e.g., learning disabilities, brain injuries, sen-
sory impairments) may have received for-
mal approval for course substitutions (e.g., 
for foreign language)? The admissions office 
should have an approach for handling these 
situations and communicate the review 
policy to admissions staff and prospective 
students. It may also be advisable to form 
understandings between two- and four-year 
campuses in your state, especially if there 
are existing articulation agreements between 
institutions. 

 — If your admissions office accepts or consid-
ers appeals from applicants who have been 
denied admission, do you have procedures 
in place to give adequate consideration to 
those appeals where disability-related fac-
tors are involved?  

Informing Applicants and New Students 
about Accommodation Resources

 — Do you describe disability-related services 
in admission materials so that individuals 
may seek out further information?  

 — Do the admissions office and the disabled 
student services office have a procedure 
to inform applicants and newly admitted 
students about disability-related services? 
Some admissions offices include a separate 
tear-off request form that the applicant can 
send directly to the disabled student services 
office to request information. Similar infor-
mation should be included in new student 
information packets. Students should be 
encouraged to contact this office long before 
their first academic term begins because it 
takes time to process disability-related docu-
mentation, and determine and arrange for 
accommodations. 

Special Admission and Review Programs 
 — Do you have special admission programs 

(such as educational opportunity programs 
for low-income students, or TRIO student 
support services), and are they equally avail-
able to eligible individuals with disabilities 
who do not meet regular admission require-
ments? Reasonable accommodations should 
be provided. 

 — Do you have special admission programs or 
review procedures designed only for people 
with disabilities or for a specific disability 
group? Numerous campuses have these pro-
grams to which 1) applicants who are denied 
or not eligible for regular admission may 
apply or 2) individuals may voluntarily opt 
to apply for a special program and regular 
admission at the same time. There have been 
some Office for Civil Rights (OCR) cases 
involving complaints on the operation and 
practices of these special programs. Contact 
your OCR office for findings. Some such 
programs are acceptable so long as individu-
als are not denied the opportunity to apply 
for regular admission, are not required to 
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participate in the special program in order to 
receive academic accommodations required 
under the ADA or Section 504, and are not 
required to pay additional fees or sur-
charges for accommodations. These special 
programs should work closely with admis-
sions and disabled student services offices 
regarding communication of admission and 
application procedures, program operation, 
and provision of accommodations. 

Orientation for New Students 
 — Are orientation programs (whether oper-

ated by or coordinated between admissions, 
dean of students, or new student orientation 
programs) for new students accessible to 
students with disabilities? Consider fac-
tors such as accessible housing; accessible 
transportation if groups of new students are 
provided with transportation to off-campus 
orientation activities; and disability accom-
modations, including alternate format for 
print documents, interpreters for deaf stu-
dents, and accessible seating. 

 — Have peer leaders received training and 
awareness in disability etiquette and 
communication? 

 — Do you have places on registration forms to 
request disability accommodation? 

 — Is there a supplemental orientation program 
for new students with disabilities sponsored 
by the disability resources office? If so, is it 
also publicized by the admissions office in 
the publicity for the larger orientation? 

Readmission Requests or Applications 
Some admissions offices and academic 
departments have a central role in reviewing re-
admission requests or applications from former 
students who were suspended or on a leave of 
absence. 

 — Do the admissions office and relevant aca-
demic departments have procedures in place 
to review requests or applications in order 
to appropriately consider disability-related 
issues presented by applicants? 

 — In the readmissions process, do you consider 
the possibility of future accommodations or 
changes in a student’s disability (i.e., new or 
different medications) that would result in a 
different outcome for the student’s success?  

Checklist Updates
This checklist was field-tested at more than 
twenty postsecondary institutions nationwide 
(see www.uw.edu/doit/Brochures/Academics/admin.
html). The results of a nationwide survey to test 
face-validity of checklist items led to further 
refinement of this checklist. To increase the 
usefulness of this working document, send sug-
gestions to sherylb@uw.edu.

Additional Resources
An electronic copy of the most current version 
of this publication as well as additional useful 
brochures can be found at www.uw.edu/doit/
Brochures/. A 14-minute video, Equal Access: 
Student Services, demonstrates key points sum-
marized in this publication. An online version 
may be freely viewed at www.uw.edu/doit/Video/
ea_student.html or purchased in DVD format. 
Permission is granted to reproduce DO-IT vid-
eos and publications for educational,  
noncommercial purposes provided the source is 
acknowledged. 

The Student Services Conference Room at www.
uw.edu/doit/Conf/ includes a collection of docu-
ments and videos to help you make student 
services accessible to everyone. They include 
checklists for career services, distance learning, 
computer labs, recruitment and admissions, 
registration, housing and residential life, finan-
cial aid, libraries, tutoring and learning centers, 
and student organizations. The Student Services 
Conference Room also includes a searchable 
Knowledge Base of questions and answers, case 
studies, and promising practices. 
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For more information about applications of 
universal design consult www.uw.edu/doit/
Resources/udesign.html or The Center for Universal 
Design in Education at www.uw.edu/doit/CUDE/. 
The book Universal Design in Higher Education: 
From Principles to Practice published by Harvard 
Education Press shares perspectives of UD 
leaders nationwide. To receive a 20% discount, 
visit www.uw.edu/doit/UDHE/coupon.html.

About DO‑IT
DO-IT (Disabilities, Opportunities, 
Internetworking, and Technology) serves 
to increase the successful participation of 
individuals with disabilities in challenging aca-
demic programs and careers. Primary funding 
for DO-IT is provided by the National Science 
Foundation, the State of Washington, and the 
U.S. Department of Education. 

For further information, to be placed on the 
DO-IT mailing list, request materials in an 
alternate format, or to make comments or 
suggestions about DO-IT publications or web 
pages, contact:

DO-IT 
University of Washington 
Box 354842 
Seattle, WA 98195-4842 
doit@uw.edu
www.uw.edu/doit/
206-685-DOIT (3648) (voice/TTY) 
888-972-DOIT (3648) (toll free voice/TTY) 
509-328-9331 (voice/TTY) Spokane 
206-221-4171 (fax) 
Founder and Director: Sheryl Burgstahler, Ph.D.

Grants and gifts fund DO-IT publications, videos, 
and programs to support the academic and career 
success of people with disabilities. Contribute 
today by sending a check to DO-IT, Box 354842, 
University of Washington, Seattle, WA 98195-4842.

Your gift is tax deductible as specified in IRS regula-
tions. Pursuant to RCW 19.09, the University of 
Washington is registered as a charitable organization 
with the Secretary of State, State of Washington. For 
more information, call the Office of the Secretary of 
State, 800-322-4483.

University of Washington
College of Engineering
UW Information Technology
College of Education

Acknowledgment
The contents of this publication and ac-
companying video were developed under a 
grant from the U.S. Department of Education, 
#P333A020044. However, these contents do 
not necessarily represent the policy of the U.S. 
Department of Education, and you should 
not assume endorsement by the federal 
government. 

Copyright © 2012, 2008, 2006, 2004, 2003, 
University of Washington. Permission is 
granted to copy these materials for educational, 
noncommercial purposes provided the source is 
acknowledged.
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Communication Hints
 
Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to relating to people with disabilities. However, here are 
some helpful hints. 
General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining— it’s liberating!

• Do not interact with a person’s guide dog or service dog unless you have received permission 
to do so.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• Speak all of the content presented with overhead projections and other visuals.
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer directions or instructions both orally and in writing. If asked, read instructions to 

individuals who have specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• In groups raise hands to be recognized so the person who is deaf knows who is speaking. 

Repeat questions from audience members.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.



Equal Access: Universal Design of Registration

As increasing numbers of people with disabilities 
pursue educational opportunities at all levels, the 
accessibility of registration offices and other student 
services increases in importance. The goal is simply 
equal access; everyone who needs to use your 
services should be able to do so comfortably and 
efficiently. 

Administrators and support staff in the registration 
office should consider how accessible their services 
are to all students on campus, including those with 
disabilities. Some access questions that may arise 
include,“Is my staff knowledgeable and comfortable 
in dealing with students with disabilities?”,“Are our 
web resources accessible?”,“Are our publications 
available in accessible formats?” 

Legal Issues
Section 504 of the Rehabilitation Act of 1973, the 
Americans with Disabilities Act of 1990, and the 
Americans with Disabilities Act Amendments of 
2008 prohibit discrimination against individu-
als with disabilities. According to these laws, no 
otherwise qualified person with a disability shall, 
solely by reason of his or her disability, be excluded 
from the participation in, be denied the benefits of, 
or be subjected to discrimination under any pro-
gram or activity of a public entity. This means that 
postsecondary student services, as well as academic 
programs, must be accessible to qualified students 
with disabilities. 

Universal Design
To make your registration services accessible, 
employ principles of universal design. Universal 
design (UD) means that rather than designing your 
facility and services for the average user, you design 
them for people with a broad range of abilities, dis-
abilities, ages, reading levels, learning styles, native 
languages, cultures, and other characteristics. Keep 
in mind that students and other visitors may have 
learning disabilities or visual, speech, hearing, and 
mobility impairments. Preparing your program to 
be accessible to them will make it more usable by 

everyone and minimize the need for special accom-
modations. Make sure everyone feels welcome, and 
can
• get to the facility and maneuver within it,
• communicate effectively with support staff,
• access printed materials and electronic resources, 

and
• fully participate in events and other activities.

Train staff to support people with disabilities, re-
spond to specific requests for accommodations in a 
timely manner, and know whom they can contact on 
campus if they have disability-related questions. 

Guidelines and Examples
The following questions can guide you in making 
registration services universally accessible. Your 
disabled student services office may also be able 
to assist you in increasing the accessibility of your 
unit. This content does not provide legal advice. 
Your campus legal counsel or ADA/504 compliance 
officer or your regional Office for Civil Rights (OCR) 
can help clarify legal issues.

Planning, Policies, and Evaluation 
Consider diversity issues as you plan and evaluate 
services.

 — Are people with disabilities, racial and ethnic 
minorities, men and women, young and old 
students, and other groups represented on your 
staff in numbers proportional to those of the 
whole campus or community?

 — Do you have policies and procedures in place 
that ensure access to facilities, printed materials, 
computers, and electronic resources for people 
with disabilities? 

 — Do your procurement processes and procedures 
for software, technology, and furnishings comply 
with federal and state legislation (e.g. sections 
504 and 508) regarding accessibility standards? 

 — Do you have a procedure to ensure a timely 
response to requests for disability-related 
accommodations? 

 — Are disability-related access issues addressed in 
your evaluation methods? 

by Sheryl Burgstahler, Ph.D.
A checklist for making registration offices welcoming and accessible to everyone
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Physical Environments and Products 
Ensure that facilities, activities, materials, and equip-
ment are physically accessible to and usable by all 
students and that all potential student characteristics 
are addressed in safety considerations.

 — Are there parking areas, pathways, and entranc-
es to the building that are wheelchair-accessible 
and clearly identified? 

 — Are all levels of the facility connected via an ac-
cessible route of travel? 

 — Are there maps available that designate acces-
sible travel routes and building entrances? 

 — Are there ample high-contrast, large-print direc-
tional signs to and throughout the office? 

 — Do elevators have auditory, visual, and tactile 
signals and are elevator controls accessible from 
a seated position? 

 — Are wheelchair-accessible restrooms with well-
marked signs available in or near the office? 

 — Is adequate light available?
 — Is at least part of a service desk or counter at a 

height accessible from a seated position? 
 — Are aisles kept wide and clear of obstructions for 

the safety of users who have mobility or visual 
impairments? 

 — When there is a need to meet with an individual 
who uses a wheelchair, is there an office or meet-
ing room available that is accessible? 

Consult the ADA Checklist for Readily Achievable 
Barrier Removal at www.ada.gov/checkweb.htm for more 
suggestions. For computing facilities, consult the 
Equal Access: Universal Design of Computer Labs video 
and publication at www.uw.edu/doit/Video/equal.html.

Staff
Make sure staff are prepared to serve all current and 
prospective students.

 — Do staff members know how to respond to 
requests for disability-related accommodations, 
such as sign language interpreters and docu-
ments in alternate formats? 

 — Are staff members aware of how to access ac-
commodation or assistive technology resources 
(Braille printers, interpreters, large print, elec-
tronic text, speech output software, etc.) that are 
available on campus? 

 — Are all staff members aware of issues related 
to communicating with students with different 
characteristics regarding race and ethnicity, age, 
and disability? (See Communication Hints at the 
end of this publication.) 

Information Resources and Technology
If your learning center uses computers as infor-
mation resources, ensure these systems employ 
accessible design, that staff members are aware of 
accessibility options, and systems are in place to 
make accommodations.

 — Do pictures in your publications and website 
include people with diverse characteristics with 
respect to race, gender, age, and disability? 

 — In key publications and on your website, do you 
include a statement about your commitment to 
universal access and procedures for requesting 
disability-related accommodations? For exam-
ple, you could include the following statement: 
“Our goal is to make all materials and services 
accessible. Please inform staff of accessibility 
barriers you encounter, and request accommoda-
tions that will make activities and information 
resources accessible to you.” 

 — Are printed publications available in alternate 
formats such as Braille, large print, and elec-
tronic text? 

 — Are key documents provided in language(s) 
other than English?

 — Are printed materials within easy reach from a 
variety of heights and without furniture block-
ing access? 

 — Do electronic resources, including web pages, 
adhere to accessibility guidelines or standards 
adopted by your institution or your office? Is 
every step of your online registration process 
accessible to people with disabilities? Guide to 
the Section 508 Standards for Accessible Electronic 
and Information Technology (www.access-board.
gov/508.htm) and World Wide Web Consortium’s 
Web Content Accessibility Guidelines (www.w3.org/
WAI/) are most commonly used. For information 
about making your website accessible to every-
one, consult the World Wide Access: Accessible Web 
Design video and publication at www.uw.edu/doit/
Video/www.html.

 — Is an adjustable-height table available for each 
type of workstation to assist students who use 
wheelchairs or are small or large in stature? 

 — Do you provide adequate work space for both 
left- and right-handed users?

 — Is software to enlarge screen images and a large 
monitor available to assist students with low vi-
sion and learning disabilities?

 — Do you provide a trackball to be used by some-
one who has difficulty controlling a mouse? 
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 — Are staff members aware of accessibility options 
(e.g., enlarged text feature) included in computer 
operating systems and of assistive technology 
available in the facility?

 — Are procedures in place for a timely response for 
assistive technology?

For more information about assistive technology, 
consult the videos and publications at www.uw.edu/
doit/Resources/at.html.

Checklist Updates
This checklist was field-tested at more than twenty 
postsecondary institutions (see www.uw.edu/doit/
Brochures/Academics/admin.html). The result of a 
nationwide survey to test face-validity of checklist 
items led to further retirement of the checklist. To 
increase the usefulness of this working document, 
send suggestions to sherylb@uw.edu.

Additional Resources
An electronic copy of the most current version of 
this publication as well as additional useful bro-
chures can be found at www.uw.edu/doit/Brochures/. A 
14-minute video, Equal Access: Student Services, dem-
onstrates key points summarized in this publication. 
It may be freely viewed online at www.uw.edu/doit/
Video/ea_student.html and purchased in DVD format 
from DO-IT. Consult www.uw.edu/doit/Video/ for ac-
cess to this and other videos that may be of interest. 
Permission is granted to reproduce DO-IT videos 
and publications for educational, noncommercial 
purposes provided the source is acknowledged. 

For more information about applications of 
universal design consult www.uw.edu/doit/Resources/
udesign.html or The Center for Universal Design in 
Education at www.uw.edu/doit/CUDE/. The book 
Universal Design in Higher Education: From Principles 
to Practice published by Harvard Education Press 
shares perspectives of UD leaders nationwide. To 
receive a 20% discount visit the DO-IT website. 

About DO-IT
DO-IT (Disabilities, Opportunities, Internetworking, 
and Technology) serves to increase the success of 
individuals with disabilities in academic programs 
and careers such as those in science, engineering, 
mathematics and technology. Primary funding 
for DO-IT is provided by the National Science 
Foundation, the State of Washington, and the U.S. 
Department of Education. 

For further information, to be placed on the DO-IT 
mailing list, request materials in an alternate format, 
or to make comments or suggestions about DO-IT 
publications or web pages, contact:

DO-IT  
University of Washington 
Box 354842 
Seattle, WA 98195-4842 
doit@uw.edu 
www.uw.edu/doit/
206-685-DOIT (3648) (voice/TTY) 
888-972-DOIT (3648) (toll free voice/TTY)  
509-328-9331 (voice/TTY) Spokane 
206-221-4171 (fax) 
Founder and Director: Sheryl Burgstahler, Ph.D.

Acknowledgment
The content of this publication and accompanying 
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Department of Education, #P333A020044. However, 
these contents do not necessarily represent the 
policy of the U.S. Department of Education, and 
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Communication Hints
 
Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to relating to people with disabilities. However, here are 
some helpful hints. 
General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining— it’s liberating!

• Do not interact with a person’s guide dog or service dog unless you have received permission 
to do so.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• Speak all of the content presented with overhead projections and other visuals.
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer directions or instructions both orally and in writing. If asked, read instructions to 

individuals who have specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• In groups raise hands to be recognized so the person who is deaf knows who is speaking. 

Repeat questions from audience members.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.



Equal Access: Universal Design of Housing and 
Residential Life

College and university housing facilities and 
services, whether for single students or families, 
are important elements of a college education for 
many students. For students with disabilities, 
living on campus can facilitate access to academic 
programs and campus activities. This publication 
is a resource for campus housing and residential 
life staff and identifies key areas of concern, offers 
general guidance, and provides resources regard-
ing disability access issues.

Legal Issues 
Section 504 of the Rehabilitation Act of 1973, the 
Americans with Disabilities Act of 1990, and the 
Americans with Disabilities Act Amendments of 
2008 prohibit discrimination against individu-
als with disabilities. According to these laws, no 
otherwise qualified person with a disability shall, 
solely by reason of his or her disability, be exclud-
ed from the participation in, be denied the benefits 
of, or be subjected to discrimination under any 
program or activity of a public entity. Housing 
programs must also comply with applicable state 
laws and federal laws such as the Fair Housing 
Act and Family Educational Rights and Privacy 
Act (FERPA). This publication does not provide le-
gal advice. To clarify issues, consult your campus 
legal counsel or ADA/504 compliance officer, or 
your regional Office for Civil Rights (OCR).

Facilities and Programs to Consider
Housing facilities owned or managed by the cam-
pus, as well as services they offer, should adopt 
accessibility policies, guidelines, and procedures. 
These facilities and services include but are not 
limited to
• single undergraduate student residence halls 

and apartments;
• graduate student and family housing;
• academic theme houses, special interest 

houses, or sorority and fraternity houses;

• off-campus housing referral service (for ex-
ample, if a referral system is operated by the 
housing office, especially if landlords are solic-
ited for their listings, it is advisable to collect 
and disseminate information about disability 
access);

• cafeterias, restaurants, meeting rooms, com-
mon areas, restrooms, recreational facilities, 
and computer labs operated by housing 
services;

• childcare facilities;
• transportation services operated by the hous-

ing office, such as large passenger buses or 
small shuttle vehicles; and

• housing leased by or from the campus (e.g., 
ensure that leasing agreements address 
disability access issues in facilities, facility 
renovations and maintenance, and individual 
requests for facility adjustments such as add-
ing grab bars in a bathroom).

Whom to Consider
In addition to students who live in campus hous-
ing, other individuals should be ensured access to 
housing facilities and programs. They include the 
following:
• a student’s spouse or partner, children, or 

other family members with disabilities eligible 
to live with them;

• friends and other individuals with disabilities 
who visit students;

• prospective students, parents, and other visi-
tors with disabilities who are touring housing 
facilities as part of a campus tour;

• newly admitted students who are participat-
ing in a “stay-over” program to gain greater 
understanding of campus life; and

• individuals residing in campus housing 
facilities as part of summer conferences, work-
shops, or camps.

A checklist for making housing and residential life welcoming and accessible to 
everyone 
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Coordination with Disabled Student Services
Staff should respect a student’s privacy with 
respect to disability-related information whenever 
possible, sharing information only with those 
who have a need to know and in compliance with 
legal mandates and campus policies. The housing 
and residential life office and the disabled student 
services office should consider developing specific 
housing accommodation policies and procedures 
and making them available to staff and students. 
Some campuses have a small joint housing and 
disability committee that considers policy and 
procedures and reviews exceptional requests on 
an individual basis. On most campuses, a disabled 
student services office is responsible for receiving 
and reviewing disability-related documentation 
and for determining or recommending accom-
modations or appropriate adjustments in campus 
procedures and policies. This office may forward 
disability verification and specific recommenda-
tions to the housing office. Staff should respect 
a student’s privacy with respect to disability-
related information whenever possible, sharing 
information only with those who have a need to 
know and in compliance with legal mandates and 
campus policies.

Guidelines and Examples
The following questions can guide you in making 
housing and residential life welcoming and acces-
sible to everyone. 

Planning, Policies, and Evaluation
Ensure physical access, comfort, and safety within 
an environment that is inclusive of people with a 
variety of abilities, racial and ethnic backgrounds, 
genders, and ages.

 — Are students with disabilities, racial and eth-
nic minorities, men and women, young and 
old students, and other groups represented 
in the housing planning, review process, and 
advisory committees in numbers proportional 
to those of the whole community?

 — Is accessibility considered in the procurement 
process?

 — Are disability-related access issues addressed 
in your evaluation methods? 

 — Do you have a review process that provides 
a case-by-case review of accommodation re-
quests in a timely manner?

 — Do you have an internal housing document 
that details policies and procedures on disabil-
ity-related accommodations for housing and 
residential life? Be prepared for students who 
may request housing for a personal care assis-
tant, first-floor space, accessible bathrooms or 
kitchens, a special diet, a single room, permis-
sion to house a service animal, or accessible 
fire and smoke alarms. 

 — Do you have a policy about whether students 
approved for a single room are charged a 
single- or double-occupancy rate? 

 — Do you make exceptions to full-time enroll-
ment rules for living in campus housing for 
students who must enroll part-time because of 
their disabilities?

 — Is a policy in place regarding accommodations 
for students with disabilities who require per-
sonal care assistants? Personal care assistants 
may need access to the housing facility and 
parking; some may need to room with the 
resident.

 — Are procedures established regarding service 
animals? Service animals may include guide 
dogs for blind individuals, hearing dogs 
for deaf or hard-of-hearing people, seizure 
response dogs to assist people with seizure 
disorders, and assistance animals for people 
with other disabling conditions. 

 — Are there procedures to handle requests for 
modifications in food selections, listings of in-
gredients for students with specific food aller-
gies, and flexibility in policy to allow a student 
to opt out of the meal plan?

 — Is a review procedure in place to ensure that 
disability-related factors are adequately con-
sidered in violations of the campus student 
code of conduct?



3

Physical Environments and Products 
Ensure physical access, comfort, and safety within 
an environment that is inclusive of people with a 
variety of abilities, racial and ethnic backgrounds, 
genders, and ages. State and federal regulations 
address most disability access requirements for 
new housing construction and major renovation 
projects. Some campus housing programs choose 
to exceed the requirements in order to provide 
enhanced maneuvering space in bathrooms and 
kitchens, as well as kitchen features such as side-
by-side refrigerators and stoves with controls 
on the front edge. Some campuses also provide 
a greater number of accessible units than the 
minimum number required by state or federal 
standards. 

 — Are there parking areas, pathways, and en-
trances to the building that are wheelchair-ac-
cessible and clearly identified?

 — Are all levels of facility connected via an acces-
sible route of travel?

 — Are there ample high-contrast, large-print di-
rectional signs to and throughout the facility? 

 — Do elevators have auditory, visual, and tactile 
signals and are elevator controls accessible 
from a seated position? 

 — Are wheelchair-accessible restrooms with 
well-marked signs available?

 — Is at least part of a counter or service desk at a 
height accessible from a seated position?

 — Are adjustable-height tables available for 
study or work areas within the facility?

 — Is adequate light available?
 — Are aisles kept wide and clear of obstructions 

for the safety of users who have mobility or 
visual impairments?

Consult the ADA Checklist for Readily Achievable 
Barrier Removal at www.ada.gov/checkweb.htm for 
more suggestions. 

Staff
Make sure staff are prepared to work with all 
students and visitors. Housing staff (including 
resident directors and assistants, custodial and 
maintenance, food service staff, facility manag-
ers, and programming staff) should know how to 

effectively communicate and work with students 
who have disabilities. Training can be developed 
in collaboration with your disabled student ser-
vices office. 

 — Do housing staff receive training about com-
municating with students who have disabili-
ties including nonvisible disabling conditions? 
(See Communication Hints for content in this 
area.)

 — Do housing staff with more intensive interac-
tions and greater responsibilities (e.g., resident 
assistants, space assignment staff, facility 
managers, hall and apartment managers and 
directors) receive training in disability ac-
commodation procedures and issues and civil 
rights legislation?

 — Do staff members have ready access to a list 
of on- and off-campus resources for students 
with disabilities?

 — Do staff members have knowledge of acces-
sible travel routes around campus?

 — Is the housing Webmaster knowledgeable 
about accessible web page design? 

For more information consult the World Wide 
Access: Accessible Web Design video and publica-
tion at www.uw.edu/doit/Video/www.html. 

Information Resources and Technology
If residential life uses computers as information 
resources, ensure that systems employ accessible 
design, that staff members are aware of acces-
sibility options, and systems are in place to make 
accommodations. 

 — Are videos used in housing and residential life 
captioned and audio described?

 — Is the computer lab wheelchair-accessible?
 — Do you have at least one adjustable-height 

table, software to enlarge screen images, a 
large monitor, and a trackball?

 — Is a system in place for a timely response to 
requests for assistive technology such as alter-
native keyboards and text-to-speech systems?

 — Are staff members aware of accessibility op-
tions (e.g., enlarged text feature included in 
computer operating systems) and of assistive 
technology available in the lab?

http://www.ada.gov/checkweb.htm
http://www.washington.edu/doit/Video/www.html
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 — Do pictures in your publications and website 
include people with diverse characteris-
tics with respect to race, gender, age, and 
disability?

 — In key publications and on your website, 
including the housing application form, do 
you include a statement about your commit-
ment to universal access and procedures for 
requesting disability-related accommoda-
tions? For example, you could include the 
following statement, “Our goal is to make all 
materials and facilities and services accessible. 
Please inform staff of accessibility barriers you 
encounter, and request accommodations that 
will make activities and information resources 
accessible to you.” 

 — Do electronic resources, including web pages, 
adhere to accessibility guidelines or stan-
dards adopted by your institution or your 
specific project or funding source? Section 
508 Standards for Accessible Electronic and 
Information Technology (www.access-board.gov/
sec508/guide/) and World Wide Web Consortium’s 
Web Content Accessibility Guidelines (www.
w3.org/WAI/) are most commonly used. For 
information about making your website acces-
sible to everyone, consult World Wide Access: 
Accessible Web Design video and publication at 
www.uw.edu/doit/Video/www.html. 

 — Are all printed publications available (imme-
diately or in a timely manner) in alternate for-
mats such as Braille, large print, and electronic 
text?

 — Are key documents provided in language(s) 
other than English?

 — Are all printed materials within easy reach 
from a variety of heights and without furni-
ture blocking access?

For more information consult the Equal Access: 
Universal Design of Computer Labs video and publi-
cation at www.uw.edu/doit/Video/equal.html.

Emergency Evacuation
Accessible evacuation procedures are a major con-
cern in housing and residential life. 

 — Do the disabled student services office and 
housing and emergency services units on cam-
pus collaborate to develop strong and effective 
policies and procedures related to emergency 
and safety issues for students with disabilities?

 — Do students with disabilities sign a release 
of information that allows residential staff to 
compile a list of students with disabilities who 
may need assistance during an evacuation?

 — Do you provide clear training to all students 
regarding their responsibility in getting 
themselves safely out of the building in the 
case of an emergency evacuation and the fire 
department’s responsibility to help those stu-
dents who may need more assistance?

 — Do housing services staff consult with resi-
dents who have known disabilities to learn 
about their preferences for assistance in evacu-
ating facilities?

 — Do housing evacuation plans (including 
written procedures and public notices) and 
training include specific procedures for the 
evacuation of residents with disabilities and 
service animals?

 — Do you notify students with disabilities about 
safety and emergency drills? 

Events 
Ensure that everyone can participate in events 
sponsored by your organization.

 — Are events located in wheelchair-accessible 
facilities? Is the accessible entrance and exit 
clearly marked?

 — Is information about how to request disabil-
ity-related accommodations included in all 
publications promoting the event?

 — Is accessible transportation arranged for 
events for which transportation is arranged for 
participants? 

http://www.access-board.gov/sec508/guide/
http://www.access-board.gov/sec508/guide/
http://www.w3.org/WAI/
http://www.w3.org/WAI/
http://www.washington.edu/doit/Video/www.html
http://www.washington.edu/doit/Video/equal.html
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Checklist Updates
This checklist was field-tested at more than 
twenty postsecondary institutions nationwide (see 
www.uw.edu/doit/Brochures/Academics/admin.html). 
The results of a nationwide survey to test face-va-
lidity of checklist items led to further refinement 
of the checklist. To increase the usefulness of this 
working document, send suggestions to  
sherylb@uw.edu.

Additional Resources 
An electronic copy of this publication as well as 
additional useful brochures can be found at www.
uw.edu/doit/Brochures/. A 14-minute video, Equal 
Access: Student Services, demonstrates key points 
summarized in this publication. An online version 
may be freely viewed at www.uw.edu/doit/Video/
ea_student.html or purchased in DVD format. 
Permission is granted to reproduce DO-IT videos 
and publications for educational, noncommercial 
purposes provided the source is acknowledged. 

The Student Services Conference Room at www.
uw.edu/doit/Conf/ includes a collection of 
documents and videos to help you make student 
services accessible to everyone. They include 
checklists for career services, distance learning, 
computer labs, recruitment and admissions, regis-
tration, housing and residential life, financial aid, 
libraries, tutoring and learning centers, and stu-
dent organizations. The Student Services Conference 
Room also includes a searchable Knowledge Base of 
questions and answers, case studies, and promis-
ing practices. 

For more information about applications of 
universal design consult www.uw.edu/doit/
Resources/udesign.html or The Center for Universal 
Design in Education at www.uw.edu/doit/CUDE/. 
The book Universal Design in Higher Education: 
From Principles to Practice published by Harvard 
Education Press shares perspectives of UD leaders 
nationwide. To receive a 20% discount, visit www.
uw.edu/doit/UDHE/coupon.html.

About DO-IT
DO-IT (Disabilities, Opportunities, 
Internetworking, and Technology) serves to 
increase the successful participation of indi-
viduals with disabilities in challenging academic 
programs and careers, such as those in science, en-
gineering, mathematics, and technology. Primary 
funding for DO-IT is provided by the National 
Science Foundation, the State of Washington, and 
the U.S. Department of Education. 

For further information, to be placed on the DO-IT 
mailing list, request materials in an alternate for-
mat, or to make comments or suggestions about 
DO-IT publications or web pages, contact:

DO-IT 
University of Washington 
Box 354842 
Seattle, WA 98195-4842 
doit@uw.edu 
www.uw.edu/doit/
206-685-DOIT (3648) (voice/TTY) 
888-972-DOIT (3648) (toll free voice/TTY) 
509-328-9331 (voice/TTY) Spokane 
206-221-4171 (fax) 
Founder and Director: Sheryl Burgstahler, Ph.D.
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The contents of this publication and accompany-
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U.S. Department of Education, #P333A020044. 
However, these contents do not necessarily 
represent the policy of the U.S. Department of 
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ment by the federal government.
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Communication Hints
 
Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to relating to people with disabilities. However, here are 
some helpful hints. 
General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining— it’s liberating!

• Do not interact with a person’s guide dog or service dog unless you have received permission 
to do so.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• Speak all of the content presented with overhead projections and other visuals.
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer directions or instructions both orally and in writing. If asked, read instructions to 

individuals who have specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• In groups raise hands to be recognized so the person who is deaf knows who is speaking. 

Repeat questions from audience members.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.



Equal Access: Universal Design of Tutoring and 
Learning Centers

As increasing numbers of people with dis-
abilities pursue educational opportunities, the 
accessibility of tutoring and learning centers 
and other student services increases in impor-
tance. The goal is simply equal access; everyone 
who needs to use your services should be able 
to do so comfortably and efficiently. 

Legal Issues
Section 504 of the Rehabilitation Act of 1973, the 
Americans with Disabilities Act of 1990, and the 
Americans with Disabilities Act Amendments of 
2008 prohibit discrimination against individu-
als with disabilities. According to these laws, 
no otherwise qualified person with a disability 
shall, solely by reason of his or her disability, be 
excluded from the participation in, be denied 
the benefits of, or be subjected to discrimination 
under any program or activity of a public entity. 
This means that postsecondary student services 
as well as academic programs must be acces-
sible to qualified students with disabilities.

Universal Design
To make your tutoring and learning center ac-
cessible, employ principles of universal design 
(UD). Universal design means that rather than 
designing your facility and services for the 
average user, you design them for people with 
a broad range of abilities, disabilities, and other 
characteristics. Keep in mind that students, 
employees, and visitors may have disabilities 
such as learning, visual, speech, hearing, or mo-
bility impairments. Designing your program to 
be accessible to all will make it more usable by 
everyone and minimize the need for special ac-
commodations for those who use your services 
and for future employees as well. Make sure 
everyone  feels welcome, and can

• get to the facility and maneuver within it,
• communicate effectively with support staff,
• access printed materials and electronic re-

sources, and
• fully participate in all learning activities. 

Train staff to work with students who have 
disabilities, respond to specific requests for ac-
commodations in a timely manner, and know 
whom to contact if they have disability-related 
questions. Staff who tutor or teach students 
should understand the learning issues faced by 
students with disabilities, especially those that 
affect gaining and demonstrating knowledge. 

Guidelines and Examples
The following questions can guide you in mak-
ing your campus services universally accessible. 
This content does not provide legal advice. To 
help clarify legal issues, consult your campus 
legal counsel or ADA/504 compliance officer or 
call your regional Office for Civil Rights (OCR).

Planning, Policies, and Evaluation
Consider diversity issues as you plan and 
evaluate services.

 — Are people with disabilities, racial and eth-
nic minorities, men and women, young and 
old students, and other groups  represented 
in the center’s service planning and review 
processes and advisory committees in 
numbers proportional to those of the whole 
campus or community? 

 — Do you have policies and procedures that 
ensure access to facilities, printed materi-
als, computers, and electronic resources for 
people with disabilities? 

 — Is accessibility considered in the procure-
ment process? 
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 — Is your staff prepared to respond to requests 
for accommodations in a timely manner? 

 — Do you have a procedure to ensure a timely 
response to requests for disability-related 
accommodations? 

 — Are disability-related access issues ad-
dressed in your evaluation methods? 

Physical Environments and Products 
 — Ensure that facilities, activities, materials, 

and equipment are physically accessible to 
and usable by all students, and that all po-
tential student characteristics are addressed 
in safety considerations.

 — Are there parking areas, pathways, and en-
trances to the building that are wheelchair-
accessible and clearly identified? 

 — Are all levels of the facility connected via an 
accessible route of travel? 

 — Are there ample high-contrast, large print 
directional signs to and throughout the 
office? 

 — Do elevators have auditory, visual, and 
tactile signals and are elevator controls ac-
cessible from a seated position? 

 — Are wheelchair-accessible restrooms with 
well-marked signs available in or near the 
office? 

 — Is at least part of a service counter or desk 
accessible from a seated position?

 — Are aisles kept wide and clear of obstruc-
tions for the safety of users who have mobil-
ity or visual impairments?

 — Are there quiet work or meeting areas where 
noise and other distractions are minimized 
and/or facility rules in place (e.g., no cell 
phone use) that minimize noise?

 — Is adequate light available? 

Consult the ADA Checklist for Readily Achievable 
Barrier Removal at www.ada.gov/checkweb.htm 
for more suggestions. For computing facili-
ties, consult the Equal Access: Universal Design 
of Computer Labs video and publication at www.
uw.edu/doit/Video/equal.html.

Tutors and learning facilitators are encouraged 
to be responsive to the needs of all students. 
However, students with disabilities may have 
some additional instructional needs that they 
should discuss with their tutor or facilitator. 
The student with a disability is the best source 
of information regarding necessary accom-
modations. In postsecondary settings, it is the 
student’s responsibility to request special ac-
commodations if desired (usually to a disabled 
student services office), but a tutor or facilitator 
can make a student comfortable by inquiring 
about special needs or challenges. Following are 
examples of typical academic accommodations 
for students with different types of disabilities. 

Instructional Needs
All students benefit from working with in-
formation and handouts made available in 
accessible, electronic format. In addition, the fol-
lowing accommodations should be considered.

Low Vision
• Large-print handouts
• Computers equipped to enlarge screen 

characters and images 

Blindness
• Audiotaped, Brailled, or electronic-for-

matted notes and handouts
• Verbal descriptions of visual aids
• Raised-line drawings and tactile models 

of graphic materials
• Computers with large monitors and with 

optical character readers, speech output, 
Braille screen displays, and printer output 

Hearing Impairments
• Interpreters, FM systems, captioned 

videotapes
• Use of visual aids
• Written instructions and demonstration 

summaries
• Visual warning system for emergencies
• Use of email for communication and pri-

vate discussions 
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Learning Disabilities
• Note takers and  audiotaped sessions
• Extra time for sessions
• Visual, aural, and tactile instructional 

demonstrations
• Computers with speech output, spelling 

checker, and grammar checker 

Mobility Impairments 
• Note takers
• Tutoring sessions in accessible locations
• Adjustable tables; materials located 

within reach
• Computers equipped with special input 

device (e.g., speech input, Morse code, 
alternative keyboards) 

Health Impairments
• Note takers
• Flexible scheduling or attendance 

requirements
• Extra time for sessions
• Use of email for communication and 

discussion 

Keep in mind that it will take the disabled 
student services office time to convert learning 
materials to alternate formats (e.g., audiotape, 
Braille, large print). Consult this office for 
further information regarding accessibility for 
students with disabilities and a fuller under-
standing about campus services. 

Staff
Make sure all staff are prepared to work with all 
program participants.

 — Are all staff members familiar 
with the availability and use of the 
Telecommunications Relay Service, assis-
tive technology, and alternate document 
formats? 

 — Do all staff members know how to respond 
to requests for disability-related accommo-
dations, such as sign language interpreters? 

 — Are all staff members aware of issues 
related to communicating with students 
who have disabilities? (See Communication 
Hints at the end of this publication.)

 — Are staff members aware of the benefits of 
universal design of instruction and accom-
modations for students with different types 
of disabilities?   

 — Do staff members have ready access to a 
list of on- and off-campus resources for stu-
dents with disabilities? 

Information Resources and Technology
If your learning center uses computers as infor-
mation resources, ensure these systems employ 
accessible design, that staff members are aware 
of accessibility options, and systems are in 
place to make accommodations.

 — Do pictures in your publications and web-
site include people with diverse character-
istics with respect to race, gender, age, and 
disability?

 — In key publications and on your website, do 
you include a statement about your com-
mitment to universal access and procedures 
for requesting disability-related accommo-
dations? For example, “Our goal is to make 
all of our materials and services accessible. 
Please inform staff of accessibility barriers 
you encounter, and request accommoda-
tions that will make activities and informa-
tion resources accessible to you.” 

 — Are all printed publications available (im-
mediately or in a timely manner) in alter-
nate formats such as Braille, large print, and 
electronic text? 

 — Are key documents provided in language(s) 
other than English?

 — Are printed materials within easy reach 
from a variety of heights and without furni-
ture blocking access? 

 — Do electronic resources, including web pag-
es, adhere to accessibility guidelines or stan-
dards adopted by your institution or your 
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center? Section 508 Standards for Accessible 
Electronic and Information Technology (www.
access-board.gov/508.htm) and World Wide 
Web Consortium’s Web Content Accessibility 
Guidelines (www.w3.org/WAI/) are most com-
monly used. For information about making 
your website accessible to everyone, consult 
the World Wide Access: Accessible Web Design 
video and publication at www.uw.edu/doit/
Video/www.html. 

 — Is an adjustable-height table available for 
each type of workstation to assist students 
who use wheelchairs or are small or large in 
stature? 

 — Is adequate light available?
 — Do you provide adequate work space for 

both left- and right-handed users?
 — Is software to enlarge screen images and a 

large monitor available to assist students 
with low vision and learning disabilities?

 — Do you provide a trackball to be used by 
someone who has difficulty controlling a 
mouse? 

 — Are staff members aware of accessibility op-
tions (e.g., enlarged text feature) included in 
computer operating systems and of assistive 
technology available in the facility?

 — Are procedures in place for a timely re-
sponse to requests for assistive technology? 

For more information about assistive technol-
ogy, consult the Adaptive Technology videos 
and publications at www.uw.edu/doit/Resources/
at.html. 

Events
Ensure that everyone can participate in events 
sponsored by your learning center.

 — Are events such as group meetings and pre-
sentations located in wheelchair-accessible 
facilities? Is the accessible entrance is clearly 
marked? 

 — Is information about how to request dis-
ability-related accommodations included in 
publications promoting activities? 

 — Is accessible transportation available if trans-
portation is arranged for other participants? 

Checklist Updates
This checklist was field-tested at more than 
twenty postsecondary institutions nationwide 
(see www.uw.edu/doit/Brochures/Academics/admin.
html). The results of a nationwide survey to test 
face-validity of checklist items led to further 
refinement of the checklist. To increase the 
usefulness of this working document, send sug-
gestions to sherylb@uw.edu.

Additional Resources
An electronic copy of the most current version 
of this publication as well as additional useful 
brochures can be found at www.uw.edu/doit/
Brochures/. A 14-minute video, Equal Access: 
Student Services, demonstrates key points 
summarized in this publication. It may be 
freely viewed online at www.uw.edu/doit/Video/
ea_student.html and purchased in DVD format 
from DO-IT. Consult www.uw.edu/doit/Video/ 
for access to this and other videos that may 
be of interest. The Equal Access: Computer Labs 
and Real Connections: Making Distance Learning 
Accessible to Everyone videos and publications 
are particularly relevant to tutoring and learn-
ing centers. Permission is granted to reproduce 
DO-IT videos and publications for educational, 
noncommercial purposes provided the source is 
acknowledged. 

The Student Services Conference Room at www.
uw.edu/doit/Conf/ includes a collection of docu-
ments and videos to help you make student 
services accessible to everyone. They include 
checklists for career services, distance learning, 
computer labs, recruitment and admissions, 
registration, housing and residential life, finan-
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Communication Hints
 
Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to relating to people with disabilities. However, here are 
some helpful hints. 
General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining—it’s liberating!

• Do not interact with a person’s guide dog or service dog unless you have received permission 
to do so.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• Speak all of the content presented with overhead projections and other visuals.
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer directions or instructions both orally and in writing. If asked, read instructions to 

individuals who have specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• In groups raise hands to be recognized so the person who is deaf knows who is speaking. 

Repeat questions from audience members.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.



As increasing numbers of people with disabilities 
pursue educational opportunities at all levels, the 
accessibility of campus services and student organi-
zations increases in importance. The goal is simply 
equal access. Everyone should be able to access ser-
vices and programs comfortably and efficiently. 

Legal Issues
Section 504 of the Rehabilitation Act of 1973, the 
Americans with Disabilities Act of 1990, and the 
Americans with Disabilities Act Amendments of 
2008 prohibit discrimination against individuals 
with disabilities. According to these laws, no other-
wise qualified person with a disability shall, solely 
by reason of his or her disability, be excluded from 
the participation in, be denied the benefits of, or be 
subjected to discrimination under any program or 
activity of a public entity. 

Universal Design
To make student organizations accessible to ev-
eryone, employ principles of universal design. 
Universal design means that rather than designing a 
facility and services for the average user, you design 
them for people with a broad range of abilities, dis-
abilities, ages, reading levels, learning styles, native 
languages, cultures, and other characteristics. Keep 
in mind that students may have learning disabilities 
or visual, speech, hearing, and mobility impair-
ments. Preparing your program to be accessible to 
them will minimize the need for last-minute, unex-
pected changes. Make sure everyone can get to the 
facility and maneuver within it, access materials and 
electronic resources, and participate in events and 
other activities. 

Train staff to respond to specific requests for accom-
modations in a timely manner and know whom they 
can contact on campus if they have disability-related 
questions. Having a knowledgeable staff can make 
your resources more accessible. Consider hosting a 
training at the start of each semester, hosted by the 
disabled student services office. 

Equal Access: Universal Design of Student 
Organizations

Guidelines and Examples
The following questions can guide you in making 
your student organization universally accessible. 
Consider those that apply to your situation. This 
content does not provide legal advice. To help clarify 
issues, consult your institution’s legal counsel or 
ADA/504 compliance officer or call the regional 
Office for Civil Rights (OCR) can also help clarify 
issues.

Planning, Policies, and Evaluation 
Consider diversity issues as you plan and evaluate 
student organization activities.

 — Are people with disabilities, racial and ethnic 
minorities, men and women, young and old stu-
dents, and other groups represented in  planning 
and review processes and advisory committees 
in numbers proportional to those of the whole 
campus or community?

 — Do you have policies and procedures that ensure 
access to facilities, printed materials, computers, 
electronic resources, and activities for people 
with disabilities?

 — Do you have a procedure to ensure a timely 
response to requests for disability-related 
accommodations?

 — Are disability-related access issues addressed in 
your evaluation methods?

 — Are you planning a variety of activities that 
appeal to an audience with a range of abilities, 
interests, and perspectives?

Physical Environments and Products 
Ensure physical access, comfort, and safety within 
an environment that is inclusive of people with a 
variety of abilities, racial and ethnic backgrounds, 
genders, and ages.

 — Are there parking areas, pathways, and entranc-
es to the building that are wheelchair-accessible 
and clearly identified? 

 — Are all levels of the facility connected via an ac-
cessible route of travel? 

 — Are there ample high-contrast, large-print direc-
tional signs to and throughout the office? 
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 — Do elevators have auditory, visual, and tactile 
signals and are elevator controls accessible from 
a seated position? 

 — Are wheelchair-accessible restrooms with well-
marked signs available in or near the office? 

 — Is at least part of a service desk or counter at a 
height accessible from a seated position? 

 — Are aisles kept wide and clear of obstructions for 
the safety of users who have mobility or visual 
impairments?

 — Is adequate light available? 
 — Are there quiet work and meeting areas where 

noise and other distractions are minimized?  

Consult the ADA Checklist for Readily Achievable 
Barrier Removal at www.ada.gov/checkweb.htm for more 
suggestions. For computing facilities, consult the 
Equal Access: Universal Design of Computer Labs video 
and publication at www.uw.edu/doit/Video/equal.html. 

Paid or Volunteer Staff
Make sure staff and volunteers are prepared to work 
with all students.

 — Are all staff members familiar with the availabil-
ity and the use of the Telecommunications Relay 
Service and alternate document formats? 

 — Do staff members know how to respond to 
requests for disability-related accommodations, 
such as sign language interpreters? 

 — Are all staff members aware of issues related 
to communicating with students with different 
characteristics regarding race and ethnicity, age, 
and disability? (See Communication Hints at the 
end of this publication for content in this area.) 

 — Is the student organization Webmaster knowl-
edgeable about accessible web page design? 
Consult the video and publication World Wide 
Access: Accessible Web Design for further informa-
tion (www.uw.edu/doit/Video/www.html). 

Information Resources and Technology
Ensure that publications and websites welcome 
a diverse group, are accessible to all visitors, and 
technology within the service area is accessible to 
everyone.

 — Do pictures in your publications and websites 
include people with diverse characteristics with 
respect to race, gender, age, and disability? 

 — In key publications and on your website, is there 
a statement included about your commitment to 
universal access and procedures for requesting 
disability-related accommodations? For example: 
“Our goal is to make all materials and services 
accessible. Please inform staff of accessibility 
barriers you encounter, and request accommoda-
tions that will make activities and information 
resources accessible to you.” 

 — Are all printed materials within easy reach from 
a variety of heights and without furniture block-
ing access? 

 — Do electronic resources, including webpages, 
adhere to accessibility guidelines or standards 
adopted by your institution or your organiza-
tion? Section 508 Standards for Accessible Electronic 
and Information Technology (www.access-board.
gov/508.htm) and World Wide Web Consortium’s 
Web Content Accessibility Guidelines (www.w3.org/
WAI/) are most commonly used. For information 
about making your website accessible to every-
one, consult the World Wide Access: Accessible Web 
Design video and publication at www.uw.edu/doit/
Video/www.html. 

 — Are videos used by your organization cap-
tioned? Audio described? 

Events 
Ensure that everyone can participate in events spon-
sored by your student organization.

 — Are events located in wheelchair-accessible facil-
ities? Is the accessible entrance clearly marked? 

 — Is information about how to request disability-
related accommodations included in publica-
tions promoting events sponsored by your 
organization? 

 — Is accessible transportation available for events 
where transportation is arranged for others?

Checklist Updates
This checklist was field-tested at more than twenty 
postsecondary institutions nationwide (see www.
uw.edu/doit/Brochures/Academics/admin.html). The 
results of a nationwide survey to test face-validity 
of checklist items led to further refinement of the 
checklist. To increase the usefulness of this working 
document, send suggestions to sherylb@uw.edu.
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Additional Resources
An electronic copy of the most current version of 
this publication as well as additional useful bro-
chures can be found at www.uw.edu/doit/Brochures/. A 
14-minute video, Equal Access: Student Services, dem-
onstrates key points summarized in this publication. 
It may be freely viewed online at www.uw.edu/
doit/Video/ea_student.html and purchased in DVD 
format from DO-IT. Consult www.uw.edu/doit/Video/ 
for access to other videos that may be of interest. 
Permission is granted to reproduce DO-IT videos 
and publications for educational, noncommercial 
purposes provided the source is acknowledged. 

The Student Services Conference Room at www.uw.edu/
doit/Conf/ includes a collection of documents and 
videos to help make student services accessible to 
everyone. They include checklists for career services, 
distance learning, computer labs, recruitment and 
admissions, registration, housing and residential 
life, financial aid, libraries, tutoring and learning 
centers, and student organizations. The Student 
Services Conference Room also includes a searchable 
Knowledge Base of questions and answers, case 
studies, and promising practices. 

For more information about applications of univer-
sal design consult www.uw.edu/doit/Resources/udesign.
html or The Center for Universal Design in Education 
at www.uw.edu/doit/CUDE/. The book Universal 
Design in Higher Education: From Principles to Practice 
published by Harvard Education Press shares per-
spectives of UD leaders nationwide. To receive a 20% 
discount visit www.uw.edu/doit/UDHE/coupon.html. 

About DO-IT
DO-IT (Disabilities, Opportunities, Internetworking, 
and Technology) serves to increase the success of 
individuals with disabilities in challenging academic 
programs and careers such as those in science, 
engineering, mathematics, and technology. Primary 
funding for DO-IT is provided by the National 
Science Foundation, the State of Washington and the 
U.S. Department of Education. 

For more information, to be placed on the DO-IT 
mailing list, request materials in an alternate format, 
or to make comments or suggestions about DO-IT 
publications or web pages, contact:

DO-IT 
University of Washington 
Box 354842 
Seattle, WA 98195-4842 
doit@uw.edu 
www.uw.edu/doit/
206-685-DOIT (3648) (voice/TTY) 
888-972-DOIT (3648) (toll freevoice/TTY) 
509-328-9331 (voice/TTY) Spokane 
206-221-4171 (fax) 
Founder and Director: Sheryl Burgstahler, Ph.D.
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Communication Hints
 
Treat people with disabilities with the same respect and consideration with which you treat others. 
There are no strict rules when it comes to relating to people with disabilities. However, here are 
some helpful hints. 
General
• Ask a person with a disability if he or she needs help before providing assistance.
• Talk directly to the person with a disability, not through the person’s companion or interpreter. 
• Refer to a person’s disability only if it is relevant to the conversation. If so, mention the person 

first and then the disability. “A man who is blind” is better than “a blind man” because it puts 
the person first.

• Avoid negative descriptions of a person’s disability. For example, “a person who uses a 
wheelchair” is more appropriate than “a person confined to a wheelchair.” A wheelchair is not 
confining—it’s liberating!

• Do not interact with a person’s guide dog or service dog unless you have received permission 
to do so.

Blind or Low Vision
• Be descriptive. Say, “The computer is about three feet to your left,” rather than “The computer 

is over there.”
• Speak all of the content presented with overhead projections and other visuals.
• When guiding people with visual impairments, offer them your arm rather than grabbing or 

pushing them.

Learning Disabilities
• Offer directions or instructions both orally and in writing. If asked, read instructions to 

individuals who have specific learning disabilities.

Mobility Impairments
• Sit or otherwise position yourself at the approximate height of people sitting in wheelchairs 

when you interact.

Speech Impairments
• Listen carefully. Repeat what you think you understand and then ask the person with a speech 

impairment to clarify or repeat the portion that you did not understand.

Deaf or Hard of Hearing
• Face people with hearing impairments so they can see your lips. Avoid talking while chewing 

gum or eating.
• Speak clearly at a normal volume. Speak louder only if requested.
• Use paper and pencil if the person who is deaf does not read lips or if more accurate 

communication is needed.
• In groups raise hands to be recognized so the person who is deaf knows who is speaking. 

Repeat questions from audience members.
• When using an interpreter, speak directly to the person who is deaf; when an interpreter voices 

what a person who is deaf signs, look at the person who is deaf, not the interpreter.

Psychiatric Impairments
• Provide information in clear, calm, respectful tones.
• Allow opportunities for addressing specific questions.
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UID INCLUSION CHECKLIST Accomplished 
1.  Creating a welcoming, respectful learning environment Now Future 

 Send welcome email to students prior   
 Create introductory exercises that are personable, friendly and encourage 

humor 
  

 Learn students’ names   
 Be open to meeting with students   
 Let students know from the outset that the environment is inclusive and that all 

“voices” are heard 
  

 Encourage questions   
 Compliment student participation   
 Develop materials with student input   

 
2. Addressing essential department/program components Now Future 

 Provide programs and services that meet the department’s intended learning 
outcomes 

  

 Discuss with students the components of the program/services and how they 
relate to their educational experience 

  

 
3. Communicating clear expectations & providing constructive feedback Now Future 

 Post comprehensive user-friendly materials online   
 Post online video of department/program director explaining policies and 

procedures 
  

 Provide clear written and audio explanations of policies and procedures online   
 Request feedback from students on the programs and services throughout the 

semester rather than only at the end of the semester 
  

 
DOES YOUR DEPARTMENT/PROGRAM PROVIDE AN 

INCLUSIVE ENVIRONMENT? 
 

IS IT UID FRIENDLY? 
 

Complete this checklist to find out. 
 

Universal Instructional Design (UID) ensures an inclusive environment for all students. 
“The basic premise of Universal Instructional Design is that curriculum should include 
alternatives to make it accessible and applicable to students with different backgrounds, 
learning styles, abilities and disabilities.” (Center for Applied Special Technology, n.d.) 

 
By following the 7 principles* below, you can make your curricula accessible to all. 

*Adapted from Chickering & Gamson (1987) 7 Principles for Good Practice in Undergraduate Education 
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UID INCLUSION CHECKLIST Accomplished 
4. Providing natural supports (including technology) for learning to enhance 
opportunities for all learners 

Now Future 

 Post all reading materials and website links online   
 Provide all handouts and evaluations in 12-14 pt. san serif font   
 Provide all PowerPoint slides & handouts in UID format (i.e., few words per 

slide, san serif font, large bold print) with no more than two slides per page for 
handouts 

  

 Be available to students via email, phone, website, and in person for 
assistance 

  

 Ensure that all programs, events, and educational opportunities are 
accessible to all students 

  

 Allow for ample time for written work (forms to be completed, etc.)   
 

5. Using presenting methods that consider diverse learning styles, abilities, 
ways of knowing, and previous experience and background knowledge 

Now Future 

 Utilize a constructivist approach to teaching by providing information and 
having students construct meaning from new information based on prior 
knowledge and experiences 

  

 Utilize multi-modal teaching techniques including, lecture, large group 
discussion, small group discussion, pair and share, role playing, case studies, 
games, exercises, guest speakers, panels, movies, videos, podcasts, 
vodcasts. 

  

 Use open captioned videos, DVDs, and video streams   
 Consider the learning styles of your current students and use appropriate 

teaching strategies 
  

 
6.  Offering multiple ways for students to demonstrate their knowledge Now Future 

 Offer students the option of papers, presentations, PowerPoint’s, online 
presentations, teams, poster sessions, role playing, websites, games, 
exercises, case studies, online discussions, individual and group projects 

  

 
7. Promoting interaction among students and between you and the students Now Future 

 Be available and encourage conversation and assistance via email, 
phone, discussion board, chatrooms, and in person. 

  

 Encourage students to develop peer learning communities   
    

 

List other ways you might ensure inclusion . . . 
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UID INCLUSION CHECKLIST Accomplished 
1.  Creating a welcoming, respectful learning environment Now Future 

 Send welcome email to students prior to start of class   
 Create introductory exercises that are personable, friendly and encourage 

humor 
  

 Include a syllabus statement that fosters an inclusive learning environment. 
(Refer to attached examples.) 

  

 Learn students’ names   
 Be open to meeting with students   
 During the first week of class lay the foundation to establish learning 

communities 
  

 Let students know from the outset that the environment is inclusive and that all 
“voices” are heard 

  

 Encourage questions   
 Compliment student participation   
 Develop course objectives with student input   
 Collect information on "Student Information Sheet"   
    
2. Addressing essential course components Now Future 

 Provide class sessions and assignments that meet intended learning 
outcomes 

  

 Discuss with students the components of the course that build toward 
subsequent courses 

  

    

 
DOES YOUR CURRICULUM PROVIDE AN INCLUSIVE ENVIRONMENT? 

 
IS IT UID FRIENDLY? 

 
Complete this checklist to find out. 

 
Universal Instructional Design (UID) ensures an inclusive environment for all students. 

“The basic premise of Universal Instructional Design is that curriculum should include 
alternatives to make it accessible and applicable to students with different backgrounds, 
learning styles, abilities and disabilities.” (Center for Applied Special Technology, n.d.) 

 
By following the 7 principles* below, you can make your curricula accessible to all. 

*Adapted from Chickering & Gamson (1987) 7 Principles for Good Practice in Undergraduate Education 
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UID INCLUSION CHECKLIST Accomplished 
3. Communicating clear expectations & providing constructive feedback Now Future 

 Post comprehensive user-friendly syllabus online prior to beginning of course   
 Post online video of instructor explaining teaching style and philosophy   
 Provide clear written and audio explanations of course assignments online   
 Post grading rubrics of all assignments online at the beginning of class   
 Start each day with an overview of the day's objectives   
 Ask students to match course objectives with course content, lectures, and 

assignments 
  

 Provide students with completed grading rubrics including written comments in 
a timely manner (i.e., preferably at least one week prior to due date of next 
assignment) 

  

 Discuss in class general overall strengths and weaknesses of completed 
assignments 

  

 Ask students to complete peer evaluations for team members   
 Encourage students to submit assignments at least one week prior to due date 

for teacher and peer review before resubmitting revised assignment 
  

 Provide students with information regarding how to access support structures 
such as tutoring, writing center, and other out-of-class assistance 

  

 Ask students to do a one-minute paper at the end of class to outline what they 
learned, indicate when they were the most/least engaged, and provide 
comments about the day's class. 

  

 Request feedback from students on the course/instruction throughout the 
semester rather than only at the end of the semester 

  

    

4. Providing natural supports (including technology) for learning to enhance 
opportunities for all learners 

Now Future 

 Post all reading materials (except text books) and website links online   
 Post some student assignments (e.g., book reviews, movie reviews, etc.) on 

course site so that other students may review 
  

 Provide all handouts and evaluations in 12-14 pt. san serif font   
 Provide all PowerPoint slides & handouts in UID format (i.e., few words per 

slide, san serif font, large bold print) with no more than two slides per page for 
handouts 

  

 Be available to students via email, phone, online course site, and in person for 
assistance 

  

 Consider the cost of textbooks; if possible, use original sources that can be 
bought at second-hand book stores, create your own packet of readings, or 
mention if books are available in library 

  

 Establish learning communities in the course to provide students with 
classmate resources 

  

 Ensure that all field trips, labs, and educational opportunities outside of the 
classroom are accessible to all students 

  

 Allow for ample time for exams and assignments   
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UID INCLUSION CHECKLIST Accomplished 
5. Using teaching methods that consider diverse learning styles, abilities, 
ways of knowing, and previous experience and background knowledge 

Now Future 

 Utilize a constructivist approach to teaching by providing information and 
having students construct meaning from new information based on prior 
knowledge and experiences 

  

 Utilize multi-modal teaching techniques including, lecture, large group 
discussion, small group discussion, pair and share, role playing, case studies, 
games, exercises, guest speakers, panels, movies, videos, podcasts, 
vodcasts. 

  

 Use open captioned videos, DVDs, and video streams   
 Consider the learning styles of your current students and use appropriate 

teaching strategies 
  

    
6.  Offering multiple ways for students to demonstrate their knowledge Now Future 

 Offer students the option of papers, presentations, PowerPoint’s, online 
presentations, team assignments, poster sessions, role playing, websites, 
games, exercises, case studies, online discussions, individual and group 
projects 

  

    
7. Promoting interaction among students and between you and the students Now Future 

 Be available and encourage conversation and assistance via email, 
phone, discussion board, chatrooms, and in person. 

  

 Encourage students to develop peer learning communities   
    

 

List other ways you might ensure inclusion . . . 
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UID INCLUSION CHECKLIST Accomplished 
1.  Create a welcoming, respectful learning environment. Now Future 

 For example: send welcome e-mails to students prior, learn 
students’ names, be open to meeting with students, 
encourage participation, develop materials with student 
input. 

  

2.  Addressing essential department/program components. Now Future 
 For example: provide programs and services that meet the 

department’s intended learning outcomes, discuss with 
students the components of the programs/services and how 
they relate to their educational experience. 

  

3. Communicating clear expectations & providing 
constructive feedback. 

Now Future 

 For example: post comprehensive user-friendly materials 
online, provide clear written and audio explanations of 
policies and procedures online, request continual feedback 
from students. 

  

4. Provide natural supports (including technology) for 
learning to enhance opportunities for all learners 

Now Future 

 For example: provide all handouts in 12-14 point san serif 
font, allow for ample time for written work, ensure that all 
programs, events, and educational opportunities are 
accessible to all students. 

  

5. Using presenting methods that consider diverse learning 
styles, abilities, ways of knowing, and previous experience 
and background knowledge. 

Now Future 

 For example: use open captioned videos, DVDs, and video 
streams, utilize multi-modal teaching techniques including 
lecture, large group discussion, small group discussion, pair 
and share, role playing, case studies, games, exercises, 
guest speakers, panels, movies, podcasts, and vodcasts. 

  

6. Offering multiple ways for students to demonstrate their 
knowledge. 

Now Future 

 For example: offer students the option of papers, 
presentations, PowerPoints, online presentations, teams, 
poster sessions, role playing, websites, games, exercises, 
case studies, online discussions, individual and group 
projects. 

  

7. Promoting interaction among students and between you 
and the students. 

Now Future 

 For example: encourage students to develop peer learning 
communities, be available to encourage conversation and 
assistance via e-mail, phone, discussion board, chatrooms, 
and in person. 

  

 

Karen A. Myers, PhD 2010 
 



Student Community Awareness for Universal Instructional Design 
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Student Checklist 
 
Universal Instructional Design (UID) ensures an inclusive environment. By following the 
principles below, students can make a difference in the university community with regard to 
accessibility for all individuals regardless of learning style, background, culture, age, 
language, and ability. 

 
1. Promote an inclusive community grounded in the concepts of Universal Instructional 

Design and Social Justice. 
• Advocate social justice through discussion, conversation, and action 

• Offer friendship with all students regardless of background or ability 

• Share cultural experiences and seek out opportunities to learn about diversity through the 
perceptions of other students 

• Question events and programs that do not promote inclusion in a professional and appropriate 
manner 

 
2. Plan and develop student accessible programs and events that welcome all students. 

• Insure that event, program, and meeting locations allow all students to engage and socialize 
equally 

• All print materials: Posters, invitations, letters, announcements are in written in accessible 
formats (Large arial font, high contrast between lettering and background) 

• Support written announcements and posters with audio versions (podcasts, audio blogs and 
other) 

 
3. Promote websites, online registration and surveys and other web based student 

information sites that are accessible for all students. 
• Images and animation: Use the [alt] attribute to describe the function of each visual. 

• Multi-media: Provide captioning and transcripts of audio and descriptions of video 

• Hypertext links: Use text that makes sense when read out of context. For example, avoid "click 
here." 

• Page organization: Use headings, lists, and consistent structure. Use CSS for layout and style 
where possible. 

• Graphs and Charts: Summarize or use the [longdesc] (long description) attribute 

• Tables: Make line-by-line reading sensible. Summarize. 

• Frames: Use the [noframes] element and meaningful titles 

• Scripts, applets, & plug-ins: Provide alternate content in case active features are inaccessible 
or unsupported. 

• Check your work: Validate. Use tools, checklist, and guidelines at 
http://www.w3.org/TR/WCAG 

Saint Louis University  2/08 
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Q & A  for Educators

About UDL 

What is Universal Design for Learning?

Universal Design for Learning (UDL) is a framework that provides ALL students equal opportunities to learn.
It encourages teachers to design flexible curricula that meet the needs of all learners. 
Using UDL principles in general education classrooms makes curriculum and instruction accessible and engaging. 
Curriculum barriers are reduced; learning is supported; students gain knowledge, skills, and enthusiasm for learning; 
and their learning is validly assessed.

What are the benefits of UDL?

Students come to the classroom with a variety of needs, skills, talents, interests and experiences. For many learners, 
typical curricula are littered with barriers and roadblocks, while offering little support. UDL turns this scenario around 
by encouraging the design of flexible, supportive curricula that are responsive to individual student variability.

UDL improves educational outcomes for ALL students by ensuring meaningful access to the curriculum within an 
inclusive learning environment. In addition, UDL complements existing school reform initiatives, such as Response to 
Intervention (RTI) and Understanding by Design (UbD). 

What are the principles of UDL?

• Provide multiple means of representation to give students various ways of acquiring, 
processing, and integrating information and knowledge.

• Provide multiple means of action and expression to provide students with options for 
navigating and demonstrating learning.

• Provide multiple means of engagement to tap individual learners’ interests, challenge them 
appropriately, and motivate them to learn.

Using the three principles of UDL, teachers can create goals that promote high expectations for all learners, use 
flexible methods and materials, and accurately assess student progress.

What is being done to promote the implementation of UDL?

The National UDL Task Force works to incorporate the principles of UDL into federal policy and practice initiatives. 
Recommendations of the Task Force on teacher and faculty preparation to use UDL strategies were incorporated into 
the recently passed Higher Education Opportunity Act. Recommendations have been made for the reauthorization 
of ESEA (NCLB) and will also be made for IDEA. In addition, the Task Force seeks increased dissemination of 
information about UDL by the U.S. Department of Education and other federal agencies. See the UDL Toolkit at                          
www.osepideasthatwork.org/udl/.

The National UDL Task Force is comprised of more than forty education and disability organizations. A complete list 
can be found at www.udlcenter.org/aboutudlcenter/partnerships/taskforce.



Q & A  for Educators

Isn’t UDL just for students with disabilities?

Absolutely not. UDL certainly benefits students with 
disabilities. However, all students can benefit from the 
types of supports that curricula designed using UDL 
provide. For example, video captioning is of great help to 
students with hearing impairments, because it provides 
them with a visual representation of speech. This support 
is also beneficial to English Language Learners, struggling 
readers, and even students working in a noisy classroom.

In what ways does UDL provide access to grade level 
curriculum?

Many people think of access in the purely physical sense. 
For example, a student in a wheel chair might use an 
elevator to access higher floors in a building. Although, 
this type of access is very important, access to learning 
is far more complex. The UDL framework addresses this 
complexity by encouraging thoughtful planning of flexible 
curricula (goals, methods, materials, and assessments) from 
the start, which meet the needs of all learners. 

For example, only providing students with paper text 
could be problematic, but providing students with 
flexible digital text is one way to make instructional 
materials more accessible to all students. A student 
who has difficulty accessing printed text due to a visual 
impairment or dyslexia could still ‘access’ the same 
text by using text-to-speech feature. While a student 
who needs cognitive access could use comprehension 
supports, such as vocabulary definitions, highlighted 
abstract literary concepts, foreign language translations,                                 
or animated coaches that assist with answering 
comprehension questions. 

An important part of UDL is realizing that these supports 
are also important for students who might be facile with 
text. For example, a proficient reader might prefer to listen 
to the text by using the Text-to-Speech function. In short, 
lots of students benefit from the flexibility and accessibility 
built into curricula designed using the UDL framework.

What is the role of educators in UDL implementation? 

Educators are key to UDL implementation. They can 
promote the use of UDL by:

• Serving on curriculum selection committees and 
encouraging school districts to purchase curriculum 
materials that incorporate UDL principles; 

• Adopting UDL principles in designing and planning 
curricula for their classrooms;

• Demonstrating and sharing how to use UDL principles 
with their teaching colleagues;

• Requesting professional development on UDL for all 
educators in their school or district; 

• Collaborating with colleagues on experiences with UDL 
and how to better implement UDL in the future.

What legislation calls for the use of UDL? 

The Individuals with Disabilities Education Act of 2004 
and the Higher Education Opportunity Act of 2008 have 
provisions for Universal Design and Universal Design for 
Learning. There have also been considerable efforts to 
include UDL in the reauthorization of the Elementary and 
Secondary Education Act (ESEA), commonly referred to as 
No Child Left Behind (NCLB). 

Where can I find more information? 

Please visit our website at www.udl4allstudents.com         
or contact Ricki Sabia at rsabia@ndss.org.

The National Center for Universal Design for Learning 
also contains information  about UDL, resources for 
UDL implementation, and research. It also includes a 
community section. 



Q & A  for Higher Education

About UDL 

What is Universal Design for Learning?

Universal Design for Learning (UDL) is a framework that provides ALL students equal opportunities to learn.
It encourages teachers to design flexible curricula that meet the needs of all learners. 
Using UDL principles in general education classrooms makes curriculum and instruction accessible and engaging. 
Curriculum barriers are reduced; learning is supported; students gain knowledge, skills, and enthusiasm for learning; 
and their learning is validly assessed.

What are the benefits of UDL?

Students come to the classroom with a variety of needs, skills, talents, interests and experiences. For many learners, 
typical curricula are littered with barriers and roadblocks, while offering little support. UDL turns this scenario around 
by encouraging the design of flexible, supportive curricula that are responsive to individual student variability.

UDL improves educational outcomes for ALL students by ensuring meaningful access to the curriculum within an 
inclusive learning environment. In addition, UDL complements existing school reform initiatives, such as Response to 
Intervention (RTI) and Understanding by Design (UbD). 

What are the principles of UDL?

• Provide multiple means of representation to give students various ways of acquiring, 
processing, and integrating information and knowledge.

• Provide multiple means of action and expression to provide students with options for 
navigating and demonstrating learning.

• Provide multiple means of engagement to tap individual learners’ interests, challenge them 
appropriately, and motivate them to learn.

Using the three principles of UDL, teachers can create goals that promote high expectations for all learners, use 
flexible methods and materials, and accurately assess student progress.

What is being done to promote the implementation of UDL?

The National UDL Task Force works to incorporate the principles of UDL into federal policy and practice initiatives. 
Recommendations of the Task Force on teacher and faculty preparation to use UDL strategies were incorporated into 
the recently passed Higher Education Opportunity Act. Recommendations have been made for the reauthorization 
of ESEA (NCLB) and will also be made for IDEA. In addition, the Task Force seeks increased dissemination of 
information about UDL by the U.S. Department of Education and other federal agencies. See the UDL Toolkit at                          
www.osepideasthatwork.org/udl/.

The National UDL Task Force is comprised of more than forty education and disability organizations. A complete list 
can be found at www.udlcenter.org/aboutudlcenter/partnerships/taskforce.



Q & A  for Higher Education

Isn’t UDL just for students with disabilities?

Absolutely not. UDL certainly benefits students with 
disabilities. However, all students can benefit from the 
types of supports that curricula designed using UDL 
provide. For example, video captioning is of great help to 
students with hearing impairments, because it provides 
them with a visual representation of speech. This support 
is also beneficial to English Language Learners, struggling 
readers, and even students working in a noisy classroom.

In what ways does UDL promote access in higher        
education?

Increasing physical access and eliminating physical barriers 
to educational sites or materials, (e.g., providing accessible 
textbooks) is an essential step in universal design but 
genuine learning requires much more than physical 
access—it requires cognitive (or intellectual) access, too. 
For example, providing digital text of a novel with built-in 
comprehension supports is one way to apply the principle of 
multiple means of representation to instructional materials. 
A student who has difficulty accessing printed text due to 
a visual impairment or dyslexia could use the text reader 
feature, while a student who needs cognitive access could 
use comprehension supports. These supports could 
include vocabulary definitions, highlighted abstract literary 
concepts, foreign language translations, or animated 
mentors that assist with answering comprehension 
questions.  Using UDL as a framework, faculty, specialized 
and technology instructional support personnel can ensure 
that all students have meaningful access to content, valid, 
accurate assessments and opportunities for meaningful 
participation. For examples of UDL applications in college 
classrooms consider additional exploration at www.elixr.
merlot.org/case-stories/understanding--meeting-students-
needs/universal-design-for-learning-udl "or" www.udlonline.
cast.org/home.

UDL is a natural complement to teaching and learning 
initiatives in higher education that promote the use of 
technology in learning , research on how people learn, 
and good teaching practices (Bransford, Brown & Cocking, 
2000 &  Chickering & Gamson, 1986). Instructional materials 
can include textbooks, digital texts and media resources, 
and web-based tools that encourage student learning and 

participation. Eliminating time-consuming adaptations 
and retro-fitting of instructional materials, UDL allows for 
efficient use of time and resources and the ability to infuse 
instructional approaches that can reach more learners.

How is UDL articulated in the Higher Education 
Opportunity Act of 2008 (HEOA)? 

The Higher Education Opportunity Act of 2008 (HEOA) 
provided both a formal definition of UDL and guidelines 
for providing UDL training to future teacher educators. The 
HEOA defined UDL as, 

Universal Design for Learning (UDL) means a scientifically 
valid framework for guiding educational practice that — (A) 
provides flexibility in the ways information is presented, 
in the ways students respond or demonstrate knowledge 
and skills, and in the ways students are engaged; and 
(B) reduces barriers in instruction, provides appropriate 
accommodations, supports, and challenges, and maintains 
high achievement expectations for all students, including 
students with disabilities and students who are limited 
English proficient. [HEOA, P.L. 110-315, §103(a)(24)].

Teacher preparation that includes UDL better assures that 
opportunities are provided to strengthen the course with 
effective instruction and technology activities. Student 
performance increases as all students acquire greater 
knowledge and demonstrate progress when UDL is fully 
embraced and implemented.

Where can I find more information? 

Please visit our website at www.udl4allstudents.com         
or contact Ricki Sabia at rsabia@ndss.org. 

The National Center for Universal Design for Learning 
also contains information  about UDL, resources for                
UDL implementation, and research. It also includes a 
community section. 
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Resources 
 

Journal Articles 
Burgstahler, S. (2012). Equal access: Universal design of  

instruction. Seattle: DO-IT, University of Washington. 

www.uw.edu/doit/ equal-access-universal-design-instruction  

Connell, B. R., Jones, M., Mace, R., Mueller, J., Mullick, A.,  

Ostroff, E., et al. (1997). The principles of universal design. 

www.ncsu.edu/ncsu/design/cud/ 

about_ud/udprinciplestext.htm  

Orkwis, R., & McLane, K. (1998). A curriculum every student can  

use: Design principles for student access. 

eric.ed.gov/?id=ED423654  

Pisha, B., & Coyne, P. (2001). Smart from the start: The promise  

of universal design for learning. Remedial and Special 

Education, 22(4), 197-203.  

Pliner, S., & Johnson, J. (2004). Historical, theoretical, and  

foundational principles of universal design in higher 

education. Equity of Excellence in Education, 37, 105-113.  

Scott, S., McGuire, J., & Shaw, S. (2003). Universal design for  

instruction: A new paradigm for adult instruction in 

postsecondary education. Remedial and Special Education, 

24(6), 369-379.  



Silver, P., Bourke, A., & Strehorn, K. C. (1998). Universal  

instructional design in higher education: An approach for  

inclusion. Equity & Excellence in Education, 31(2), 47-51. 

 

Books 
Bar, L., Galluzzo, J., & Sinfit, S.D. (1999). The accessible school:  

Universal design for educational settings. Berkeley, CA: MIG  

Communications. 

Burgstahler, S., & Coy, R. (Eds.). (2015). Universal Design in  

Higher Education: From Principles to Practice (2nd ed.). 

Boston: Harvard Education Press.  

Edyburn, D., & Higgins, K. (Eds.). (2005). Handbook of special  

education technology research and practice. Whitefish Bay, 

WI: Knowledge by Design.  

Rose, D.H., and Meyer, A. (2002). Teaching every student in the  

digital age: Universal Design for Learning. Alexandria, 

VA:Association for Supervision and Curriculum Development 

 

State Agencies 
State Department of Education 

Arkansas Department of Education 

Four State Capitol Mall 

Little Rock, AR 72201-1071 



Phone: (501) 682-4475 

Fax: (501) 682-1079 

Website: http://www.arkansased.org/ 

 

State Higher Education Agency 

Arkansas Department of Higher Education 

423 Main Street, Suite 400 

Little Rock, AR 72201-3818 

Phone: (501) 371-2000 

Fax: (501) 371-2001 

Website: http://www.adhe.edu 

 

Special Education Agency 

Special Education Services 

Arkansas State Department of Education 

Victory Building, Suite 450 

1401 West Capitol Avenue 

Little Rock, AR 72201-2936 

Phone: (501) 682-4221 

Fax: (501) 682-5159 

Website: http://arksped.k12.ar.us/ 

 

 

http://www.arkansased.org/
http://www.adhe.edu/
http://arksped.k12.ar.us/


State Adult Education Agency 

Arkansas Department of Career Education  

Luther Hardin Building  

Three Capitol Mall  

Little Rock, AR 72201-1083  

Phone: (501) 682-1970  

Fax: (501) 682-1706  

Website: http://ace.arkansas.gov/adultEducation/Pages/default.

aspx 

 

Web Sites 
Universal Design for Learning in a Digital Multimedia 

Environment: 

 http://www.cited.org/index.aspx?page_id=147#shows 

Learning with Multimedia Agents: 

 http://www.cited.org/index.aspx?page_id=142 

Learning with Multimedia Materials: 

 http://www.cited.org/index.aspx?page_id=145 

Learning Mathematics with Virtual Manipulatives: 

 http://www.cited.org/index.aspx?page_id=151 

Learning with Computer Games and Simulations: 

 http://www.cited.org/index.aspx?page_id=143 

Learning to Read with Multimedia Materials: 

http://ace.arkansas.gov/adultEducation/Pages/default.aspx
http://ace.arkansas.gov/adultEducation/Pages/default.aspx
http://www.cited.org/index.aspx?page_id=147#shows
http://www.cited.org/index.aspx?page_id=142
http://www.cited.org/index.aspx?page_id=145
http://www.cited.org/index.aspx?page_id=151
http://www.cited.org/index.aspx?page_id=143


 http://www.cited.org/index.aspx?page_id=144 

Learning a Second Language with Multimedia Materials: 

 http://www.cited.org/index.aspx?page_id=146 

Using Multimedia Tools to Help Students Learn Science: 

 http://www.cited.org/index.aspx?page_id=148 

Multimedia Instruction for Students Who Are Deaf: 

 http://www.cited.org/index.aspx?page_id=153 

Georgia Tech - College of Architecture: Center for Assistive 

Technology and Environmental Access: 

 http://www.accesselearning.net/ 

Accessify: 

 http://accessify.com/ 

Tech & Learning: 

 http://www.techlearning.com/ 

National Center on Accessible Educational Materials: 

 http://aem.cast.org/ 

American Sign Language Browser: 

 http://commtechlab.msu.edu/sites/aslweb/browser.htm 

The National Center on Disability and Access to Education: 

 http://www.ncdae.org/ 

National Center on Accessible Educational Materials: 

 http://aem.cast.org 

Best Practices for Institution-Wide Wed Accessibility: 

http://www.cited.org/index.aspx?page_id=144
http://www.cited.org/index.aspx?page_id=146
http://www.cited.org/index.aspx?page_id=148
http://www.cited.org/index.aspx?page_id=153
http://www.accesselearning.net/
http://accessify.com/
http://www.techlearning.com/
http://aem.cast.org/
http://commtechlab.msu.edu/sites/aslweb/browser.htm
http://www.ncdae.org/
http://aem.cast.org/


 http://ncdae.org/goals/accreditation/bestpractices.php 

Universal Design for Learning 

 https://www.ebscohost.com/uploads/imported/thisTopic-

dbTopic-1073.pdf 

Technologies Supporting Curriculum Access for Students with 

Disabilities: 

 http://www.cited.org/library/site/docs/Technologies%20Supp

orting%20Curriculum.pdf 

Kurzweil 3000 Supports Universal Design for Learning: 

 http://simmonsatshowcase.wikispaces.com/file/view/Kurzweil

%203000%20and%20UDLpdf.pdf/33646079/Kurzweil%203000%

20and%20UDLpdf.pdf 

Multi-User Virtual Environments for Education: 

 http://www.cited.org/index.aspx?page_id=159 

Multimedia Geography Instruction: 

 http://www.cited.org/index.aspx?page_id=158 

Multimedia Instruction of Social Skills: 

 http://www.cited.org/index.aspx?page_id=154 

Word2Word Language Resources: 

 http://www.word2word.com 

Backpack: 

 http://www.backpackit.com 

TechMatrix: 

http://ncdae.org/goals/accreditation/bestpractices.php
https://www.ebscohost.com/uploads/imported/thisTopic-dbTopic-1073.pdf
https://www.ebscohost.com/uploads/imported/thisTopic-dbTopic-1073.pdf
http://www.cited.org/library/site/docs/Technologies%20Supporting%20Curriculum.pdf
http://www.cited.org/library/site/docs/Technologies%20Supporting%20Curriculum.pdf
http://simmonsatshowcase.wikispaces.com/file/view/Kurzweil%203000%20and%20UDLpdf.pdf/33646079/Kurzweil%203000%20and%20UDLpdf.pdf
http://simmonsatshowcase.wikispaces.com/file/view/Kurzweil%203000%20and%20UDLpdf.pdf/33646079/Kurzweil%203000%20and%20UDLpdf.pdf
http://simmonsatshowcase.wikispaces.com/file/view/Kurzweil%203000%20and%20UDLpdf.pdf/33646079/Kurzweil%203000%20and%20UDLpdf.pdf
http://www.cited.org/index.aspx?page_id=159
http://www.cited.org/index.aspx?page_id=158
http://www.cited.org/index.aspx?page_id=154
http://www.word2word.com/
http://www.backpackit.com/


 http://www.techmatrix.org 

Discovery Education – United Streaming: 

 http://www.unitedstreaming.com/index.cfm 

LearningInHand: 

 http://www.learninginhand.com 

Blogger: 

 http://www.blogger.com 

PB Wiki: 

 http://pbwiki.com 

Voice Thread: 

 http://www.voicethread.com 

Center for Digital Story Telling: 

 http://www.storycenter.org 

TechAdapt – The Accessible Media Center Company: 

 http://www.techadapt.com 

Accessible Media Producers Directory (AMP): 

 http://louis.aph.org/catalog/CategoryInfo.aspx?cid=152&mas

ter=AMP 

National Instructional Materials Access Center (NiMAC): 

 http://www.nimac.us/ 

Accessibility Standards, Specifications & Guidelines: 

 http://aem.cast.org/creating/accessibility-standards-

specifications-guidelines.html#.VyZQIfkrLrc 

http://www.techmatrix.org/
http://www.unitedstreaming.com/index.cfm
http://www.learninginhand.com/
http://www.blogger.com/
http://pbwiki.com/
http://www.voicethread.com/
http://www.storycenter.org/
http://www.techadapt.com/
http://louis.aph.org/catalog/CategoryInfo.aspx?cid=152&master=AMP
http://louis.aph.org/catalog/CategoryInfo.aspx?cid=152&master=AMP
http://www.nimac.us/
http://aem.cast.org/creating/accessibility-standards-specifications-guidelines.html#.VyZQIfkrLrc
http://aem.cast.org/creating/accessibility-standards-specifications-guidelines.html#.VyZQIfkrLrc


Best Practices for Educators & Instructors: 

 http://aem.cast.org/creating/best-practices-educators-

instructors.html#.VyZQSvkrLrc 

Creative Captioning for Increased Web Accessibility: Win, Win 

with Strategies Designed to Decrease Costs and Improve 

Outcomes: 

 http://www.ncdae.org/resources/articles/2012captioning.php 

Leading the Charge: Ensuring Your Institution’s Web Presence 

Works for Everyone 

 http://ncdae.org/goals/actionpaper.php 

National Universal Design for Learning Task Force: 

 http://www.udlcenter.org/advocacy/taskforce 

National Center on Accessing the General Curriculum – 

Technologies Supporting Access for Students with Disabilities: 

 http://www.cited.org/library/site/docs/Technologies%20Supp

orting%20Curriculum.pdf 

Access to Electronically-Mediated Education for Students with 

Disabilities: Policy Issues: 

 http://www.ncdae.org/resources/articles/policy.php 

Indicators for Institutional Web Accessibility: 

 http://ncdae.org/goals/indicators.php 

Leading the Charge – Ensuring Your Institution’s Web Presence 

Works for Everyone: 

http://aem.cast.org/creating/best-practices-educators-instructors.html#.VyZQSvkrLrc
http://aem.cast.org/creating/best-practices-educators-instructors.html#.VyZQSvkrLrc
http://www.ncdae.org/resources/articles/2012captioning.php
http://ncdae.org/goals/actionpaper.php
http://www.udlcenter.org/advocacy/taskforce
http://www.cited.org/library/site/docs/Technologies%20Supporting%20Curriculum.pdf
http://www.cited.org/library/site/docs/Technologies%20Supporting%20Curriculum.pdf
http://www.ncdae.org/resources/articles/policy.php
http://ncdae.org/goals/indicators.php


 http://ncdae.org/goals/actionpaper.php 

Gaining Online Accessible Learning through Self-Study (GOALS) 

Benchmarking and Planning Tool: 

 http://ncdae.org/goals/planningtool.php 

Assistive Technology Industry Association: 

 http://www.atia.org 

Association of Assistive Technology Act Programs (ATAP): 

 http://www.ataporg.org 

Rehabilitation Engineering and Assistive Technology Society of 

North America (RESNA): 

 http://www.resna.org 

Closing The Gap – Changing Lives With Assistive Technology: 

 http://www.closingthegap.com 

Microsoft Accessibility: 

 https://www.microsoft.com/enable/products/default.aspx 

Assistive Technology Products for Windows: 

 https://www.microsoft.com/enable/at/matvplist.aspx 

4 Center for Applied Special Technology (CAST):  

www.cast.org/our-work/about-udl.html  

The Center for Universal Design:  

www.ncsu.edu/ncsu/design/cud/  

The Center for Universal Design in Education:  

http://ncdae.org/goals/actionpaper.php
http://ncdae.org/goals/planningtool.php
http://www.atia.org/
http://www.ataporg.org/
http://www.resna.org/
http://www.closingthegap.com/
https://www.microsoft.com/enable/products/default.aspx
https://www.microsoft.com/enable/at/matvplist.aspx
http://www.cast.org/our-work/about-udl.html
http://www.ncsu.edu/ncsu/design/cud/


www.uw.edu/doit/programs/ center-universal-design-

education/overview 

Applications of Universal Design:  

www.uw.edu/doit/resources/ popular-resource-collections/ 

applications-universal-design  

National Center for Accessible Media (NCAM):  

http://www.ncam.wgbh.org 

 

www.uw.edu/doit/programs/%20center-universal-design-education/overview
www.uw.edu/doit/programs/%20center-universal-design-education/overview
www.uw.edu/doit/resources/%20popular-resource-collections/%20applications-universal-design
www.uw.edu/doit/resources/%20popular-resource-collections/%20applications-universal-design
http://www.ncam.wgbh.org/


 

CITEd is pleased to announce a new set of Research in Brief 
articles on the use of multimedia materials for instruction, 
particularly for students with special needs.  Please visit 
www.cited.org to read the full articles. 

 
 
Multimedia Materials: Their Instructional Potential for Students 
with Special Needs 
(http://www.cited.org/index.aspx?page_id=141) 
This suite of Research in Brief articles takes a look at the research on 
multimedia materials and offers practical lessons along with guidance on 
choosing and implementing the materials in classroom instruction. Each 
article also includes an extensive list of linked resources. 

 
Universal Design for Learning in a Digital Multimedia 
Environment 
(http://www.cited.org/index.aspx?page_id=147) 
This overview article posits that Universal Design for Learning 
(UDL) can provide a helpful framework for summarizing the 
research on the use of multimedia materials and demonstrating 
how a digital multimedia environment can increase the accessibility 
of materials, scaffold students’ exploration of content, and facilitate 
their engagement. 

 
Learning with Agents 
(http://www.cited.org/index.aspx?page_id=142) Agents are the 
lifelike characters in multimedia software and online applications that 
pop up on the screen to explain rules, provide hints, or prompt the 
user to use the program’s features. They can be human or 
nonhuman, animated or static. What is their role in learning? This 
article presents the research behind the use of pedagogical agents 
and strategies to make the most of their learning potential. 

 
Learning History with Multimedia Materials 
(http://www.cited.org/index.aspx?page_id=145) 
Inquiry-based instruction emphasizes learning how to be a historian, 
learning to evaluate, corroborate, and synthesize multiple conflicting 
sources. Digital multimedia materials make the exploration of multiple 
sources more accessible to students with special needs. In this 
article, find practical resources and strategies for incorporating digital 
materials into inquiry-based history instruction. 

 

http://www.cited.org/
http://www.cited.org/index.aspx?page_id=141)
http://www.cited.org/index.aspx?page_id=147)
http://www.cited.org/index.aspx?page_id=142)
http://www.cited.org/index.aspx?page_id=145)


 

Learning Mathematics with Virtual 
Manipulatives 
(http://www.cited.org/index.aspx?page_id
=151) 
Abstract concepts are essential to understanding and performing 
mathematics. Manipulatives represent concretely the abstract 
concepts and link these concepts to prior knowledge. Virtual 
manipulatives are basically digital “objects” that can be 
manipulated, usually with a computer mouse, much like the more 
familiar physical manipulatives. In this article, discover the research 
support and practical suggestions for incorporating these powerful 
learning tools into mathematics instruction and find an extensive list 
of resources. 

 
Learning with Computer Games and 
Simulations 
(http://www.cited.org/index.aspx?page_id
=143) 
Games and simulations are highly interactive and engaging, with 
many user-controlled features. But how do educators harness their 
power to support learning? This article presents an overview of the 
research as well as guidance on choosing an educational game and 
helpful resources. 
 
Learning to Read with Multimedia Materials 
(http://www.cited.org/index.aspx?page_id=144) 
There is a steadily growing body of research showing that digital 
text and multimedia environments can play a significant supporting 
role in reading instruction. This article explores the literature base 
and cutting-edge innovations while identifying implementation 
strategies, guidance on choosing programs, and resources to 
power up reading instruction. 

 
Learning a Second Language with Multimedia 
Materials 
(http://www.cited.org/index.aspx?page_id=146) 
Multimedia materials and experiences can boost students’ 
language learning, whether it is English or a foreign language. 
Consider how multimedia can support students’ access to 
comprehensible input, output and interaction. This article presents 
resources and guidance on choosing an appropriate program or 
experience. 

http://www.cited.org/index.aspx?page_id=151)
http://www.cited.org/index.aspx?page_id=151)
http://www.cited.org/index.aspx?page_id=143)
http://www.cited.org/index.aspx?page_id=143)
http://www.cited.org/index.aspx?page_id=144)
http://www.cited.org/index.aspx?page_id=146)


 

 
Using Multimedia Tools to Help Students Learn 
Science 
(http://www.cited.org/index.aspx?page_id=148) 
Scientists routinely use a number of technology tools in their daily 
practice. Students can use similar technologies and multimedia 
tools to work like scientists and build their reasoning and scientific 
inquiry skills. This article provides an overview of the research on 
and strategies to implement these powerful technology tools in the 
science classroom as well as an extensive list of resources. 

Modeling Tools and Multiple Representations 
(http://www.cited.org/index.aspx?page_id=148#mo
del) Tools that Facilitate Collaboration and 
Discourse 
(http://www.cited.org/index.aspx?page_id=148#t
ools) Simulations and Virtual Labs 
(http://www.cited.org/index.aspx?page_id=148#s
im) 

 
Supporting Deaf Students with Multimedia 
Materials 
(http://www.cited.org/index.aspx?page_id=1
53) 
A wide range of emerging multimedia materials and tools can 
support the learning and communication needs of students who are 
deaf or hard of hearing. This article includes implementation 
strategies and resources that support deaf students and their 
teachers in regular classrooms. 

 
Learning Geography with Multimedia Materials 
(http://www.cited.org/index.aspx?page_id=158) 
This article covers the many uses of multimedia materials to address 
the five themes of geography learning as endorsed by the National 
Geographic Society: location, place, human- environment 
interactions, movement, and regions. This article includes 
implementation strategies and resources to make learning geography 
more accessible to all students. 

 
Supporting Social Skills for Students with Special Needs 
through Multimedia Experiences 
(http://www.cited.org/index.aspx?page_id=154) Many students 
with disabilities struggle with interpersonal and functional social skills. 

http://www.cited.org/index.aspx?page_id=148)
http://www.cited.org/index.aspx?page_id=148&amp;model)
http://www.cited.org/index.aspx?page_id=148&amp;model)
http://www.cited.org/index.aspx?page_id=148&amp;tools)
http://www.cited.org/index.aspx?page_id=148&amp;tools)
http://www.cited.org/index.aspx?page_id=148&amp;sim)
http://www.cited.org/index.aspx?page_id=148&amp;sim)
http://www.cited.org/index.aspx?page_id=153)
http://www.cited.org/index.aspx?page_id=153)
http://www.cited.org/index.aspx?page_id=158)
http://www.cited.org/index.aspx?page_id=154)


 

Multimedia environments offer students and their teachers an 
opportunity to practice new behaviors and reflect on interactions. This 
article includes implementation strategies and resources. 



 

Role Playing and Identity Games – What are Students 
Learning? 
(http://www.cited.org/index.aspx?page_id=159) 
Researchers and developers are bringing cognitive science to bear 
on developing online multi- user virtual environments and computer 
software games for educational purposes. This article includes 
research directions, implementation strategies, and resources to 
inform teachers and caregivers about the new generation of 
educational games. 

http://www.cited.org/index.aspx?page_id=159)


Performance Indicator Categories 
Universally designed curriculum provides students with a wide 

range of abilities, disabilities, ethnic backgrounds, language skills, and 

learning styles multiple means of representation, action and expression, 

and engagement (called Universal Design for Learning by the Center for 

Applied Special Technology (CAST), www.cast.org/). Listed below are 

examples of instruction that employ principles of UD. They are organized 

under eight performance indicator categories, with a general guideline for 

each (Burgstahler, 2007). 
 

1. Class climate. Adopt practices that reflect high values with respect to 

both diversity and inclusiveness. Example: Put a statement on your 

syllabus inviting students to meet with you to discuss disability-related 

accommodations and other special learning needs. 

 

2. Interaction. Encourage regular and effective interactions between 

students and the instructor and ensure that communication methods 

are accessible to all participants. Example: Assign group work for 

which learners must support each other and that places a high value 

on different skills and roles. 

 

3. Physical environments and products. Ensure that facilities, activities, 

materials, and equipment are physically accessible to and usable by all 

students, and that all potential student characteristics are addressed in 

safety considerations. Example: Develop safety procedures for all 

students, including those who are blind, deaf, or wheelchair users. 

 

http://www.cast.org/


4. Delivery methods. Use multiple, accessible instructional methods that 

are accessible to all learners. Example: Use multiple modes to deliver 

content; when possible allow students to choose from multiple options for 

learning; and motivate and engage students—consider lectures, 

collaborative learning options, hands-on activities, Internet-based 

communications, educational software, field work, and so forth. 

 

5. Information resources and technology. Ensure that course materials, 

notes, and other information resources are engaging, flexible, and 

accessible for all students. Example: Choose printed materials and prepare 

a syllabus early to allow students the option of beginning to read materials 

and work on assignments before the course begins. Allow adequate time to 

arrange for alternate formats, such as books in audio format. 

 

6. Feedback. Provide specific feedback on a regular basis. Example: 

Allow students to turn in parts of large projects for feedback before the final 

project is due. 

 

7. Assessment. Regularly assess student progress using multiple 

accessible methods and tools, and adjust instruction accordingly. Example: 

Assess group and cooperative performance, as well as individual 

achievement. 

 

8. Accommodation. Plan for accommodations for students whose needs 

are not met by the instructional design. Example: Know campus protocols 

for getting materials in alternate formats, rescheduling classroom 

locations, and arranging for other accommodations for students with 

disabilities. 
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